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Введение 

 
   Задачи, возникающие при проектировании современных радиосистем, 
требуют для своего решения применения новых методов анализа и синтеза как 
всей системы в целом, так и отдельных её узлов. 
      Программы точного моделирования трехмерных структур - это новый, 
активно внедряемый в последние 30 лет подход, который становится 
основным инструментом проектирования, существенно увеличивая скорость 
разработки новых антенн и СВЧ устройств. 
     В предлагаемом сборнике, посвященном расчету и моделированию  СВЧ 
устройств, приводятся примеры решения задач, имеющих самостоятельное 
практическое значение. Решая приведенные задачи и анализируя результаты 
моделирования, студент или научный работник, получит практические навыки 
работы с популярными программами HFSS компании Ansoft. 
      Следует отметить, что знание современного программного обеспечения, 
применяемого для моделирования радиотехнических устройств, не 
подкрепленное знанием теории, не позволит подготовить хорошего 
специалиста в области проектирования СВЧ устройств. Знание основ теории 
СВЧ цепей (длинные линии, многомодовые матрицы рассеяния), теории 
волноводов и теории антенн позволит в полной мере использовать широкие 
возможности, которые предоставляет разработчику программа HFSS.  
       Решение приведенных в книге задач, приводится в виде пошаговых 
инструкций. Читатель может повторить решение этих задач и сверить 
полученные им результаты с данными, приведенными  в соответствующих 
разделах. Часть разделов дополнена теоретическим введением, поясняющим   
сущность задачи, и анализом полученных результатов. 
    В первых разделах сборника графическое построение моделей и их анализ 
выполнен более подробно. В качестве первого примера рассматривается  Т – 
образное коаксиальное  разветвление. Во второй главе представлен анализ 
планарного фильтра на диэлектрической подложке, а в третьей главе – 
рупорной антенны.   

Для рупорной антенны проведен расширенный анализ. После решения 
задачи об излучении электромагнитных волн рупорной антенной и расчета её 
характеристик, в исследуемую модель введен диэлектрический слой с 
потерями. Проведен анализ рассеяния электромагнитных волн таким слоем и 
его влияние на параметры  антенны. 

 В четвертой главе выполняется анализ волноводного Т-разветвления с 
металлической перегородкой, положение и размеры которой можно изменять. 
На данном примере показаны возможности оптимизатора HFSS.  

В последующих разделах проведен анализ щелевой антенны «Бабочка», 
планарной антенны GPS, антенн, используемых в системах радио-
идентификации.  Главное, чему старались следовать авторы – рассматривать 
примеры, имеющие практическую ценность. 
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     В настоящее время в России появляется всё большее количество 
лицензионных пользователей HFSS, как в научных фирмах, так и в 
университетах. Чтобы установить HFSS Ansoft на компьютер или в локальную 
сеть, нужен лицензионный файл, который получается по электронной почте. 
Установка лицензионной HFSS также связана с получением ключа, 
подключаемого к USB порту. 
     Авторы приносят благодарность кафедре антенных устройств Московского 
авиационного института, д.т.н., проф. Гриневу А.Ю., д.т.н., проф. Е.И. Нефе-
дову, Пластикову А.Н., коллективу кафедры антенн Таганрогского 
университета (зав. каф. АиРПУ д.т.н., проф. Юханов Ю.В.) за большую 
помощь и плодотворные дискуссии при подготовке книги. Особая 
благодарность – старшему научному сотруднику компании «Кросна» 
А.Крюкову, который написал 1 главу, и к.т.н. Подковырину С.И, который 
написал раздел 8.7. 
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1. Коаксиальное T-разветвление 

 
HFSS - это пакет программ, предназначенный для  моделирования  СВЧ 

устройств и расчета их характеристик.  Конструктивный модуль HFSS 
позволяет, используя набор графических примитивов, начертить виртуальную 
модель исследуемого устройства, расчетный модуль, использующий метод 
конечных элементов, проводит расчет электромагнитного поля для 
построенной модели, а пост-процессор дает возможность провести обработку 
и детальный анализ полученных результатов. 

В процессе конструирования виртуальной модели необходимо начертить 
анализируемое устройство, указать материалы для каждого объекта, 
определить порты и задать граничные условия на поверхностях.  

Кроме того, постановка задачи включает установку частотного диапазона 
для анализа и определение условий сходимости решения. 

Работу с HFSS начнем с моделирования и анализа достаточно простого 
устройства - коаксиального Т-разветвления. 

После запуска исполнительного модуля на экране монитора появится 
рабочий стол HFSS (рис. 1.1). 
 

 
Рис. 1.1.  Интерфейс рабочего стола HFSS  
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Интерфейс рабочего стола HFSS состоит из линейки меню, панелей 
инструментов  и нескольких окон. 

 
Пункты меню содержат полный набор команд, которые позволяют решать 

все задачи возникающие в процессе моделирования. Панели инструментов 
позволяют осуществлять быстрый доступ к наиболее часто используемым 
командам. 

В окне менеджера проекта (Project Manager) отображается структура 
проекта, которая представлена в виде дерева проекта.  

Верхним узлом в дереве проекта является имя проекта. По умолчанию 
проекту присваивается имя Projectn, где n – порядковый номер проекта, 
открытого в текущей сессии работы с HFSS. 

Для того чтобы начать работать с проектом, в него необходимо включить 
хотя бы одну модель. Чтобы добавить в текущий проект новую модель 
необходимо, используя меню, дать команду Project → Insert HFSS Design, 

либо на панели инструментов нажать кнопку . В результате выполнения 
этой команды в дерево проекта будет добавлен второй узел, которому по 
умолчанию присваивается имя HFSSModeln, где n – порядковый номер модели, 
добавленной в текущий проект. В этом узле содержится вся информация о 
модели, включая граничные условия, рассчитанную структуру поля и 
результаты пост-процессорной обработки. 

Нижний узел дерева проекта будет содержать перечень материалов, 
использованных при построении модели. 

Включение в проект новой модели приведет к открытию окна 3D-конструктора 
(3D Modeler), которое появится справа от окна менеджера проекта (Project 
Manager). При помощи 3D-конструктора создается геометрия модели. Окно 
3D-конструктора разбито на две области – окно модели и окно конструкции. 

Окно модели содержит  дерево модели, в котором отражаются все 
действия пользователя в процессе построения модели. 

Окно конструкции содержит графическое изображение модели. 
Для работы с 3D-конструктором необходимо задать единицу измерения 

размеров модели. Этой цели служит команда меню 3D Modeler → Units. В 
открывшимся диалоговом окне из списка выберем в качестве единицы 
измерения  mm (миллиметр) и нажмем кнопку OK. 

Интерфейс стола HFSS содержит еще три дополнительных окна.  
Окно переменных отображает либо параметры выделенного элемента в 

модели, либо данные выделенного пункта дерева проекта. 
В окне сообщений выводятся сообщения, связанные с развитием проекта, 

такие как сообщения об ошибках, возникающих в ходе конструирования 
модели, или информационные сообщения о ходе выполнения анализа модели. 

Окно состояния отображает процесс решения задачи анализа построенной 
модели. 
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Рис. 1.2.  Окно 3-D конструктора с коаксиальным Т-разветвителем 
 

 
Создав новый проект и загрузив в него модель, приступим к черчению 

конструкции коаксиального Т-разветвителя. 
Коаксиальный Т-разветвитель показан на рис. 1.2. Он состоит из отрезков 

коаксиальных линий. Отрезки коаксиальных линии представляют из себя 
области пространства, образованные в результате вычитания внутреннего 
цилиндра из внешнего. Начнем с черчения внешнего цилиндра вертикального 
отрезка коаксиальной линии. 

 
1.1. Черчение внешнего цилиндра 

 
1. Задайте команду  Draw → Cylinder, после чего в окне конструкции 

появится ромбик.  
2. Перемещая курсор с помощью мыши, поместите ромбик в начало 

координат и щелкните левой кнопкой, зафиксировав положения центра 
окружности. Передвиньте курсор мышью и создайте окружность в 
плоскости XY. Щелчок левой кнопкой мыши завершит черчение 
окружности. 

3. Переместив курсор вверх, создайте цилиндр, вытянутый вдоль оси Z. 
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Рис. 1.3.  Параметры внешнего вертикального 

цилиндра 

Рис. 1.4.  Внешний 
вертикальный  цилиндр 

 
 

4. Для завершения черчения цилиндра щелкните левой кнопкой мыши. 
Появится диалоговое окно (рис. 1.3). Введите размеры цилиндра (Radius и 
Height) и координаты точки, в которой будет расположено его основание 
(Center Position). Нажмите кнопку OK. 
В окне 3D-конструктора появится изображение внешнего вертикального 

цилиндра (рис. 1.4), а в дерево модели будет добавлен новый узел, которому 
по умолчанию будет присвоено имя Cylinder1.     

На этом черчение внешнего вертикального цилиндра заканчивается. 
Приступим к черчению внутреннего вертикального цилиндра. 

 
 

 
1.2. Черчение внутреннего цилиндра 

 
Чтобы начертить внутренний вертикальный цилиндр, повторите те же 

действия, которые вы выполняли в предыдущем параграфе, когда чертили 
внешний цилиндр. В открывшемся окне на вкладке Command введите размеры 
и координаты расположения цилиндра (рис. 1.5). На вкладке Attribute можно 
изменить такие параметры, как имя создаваемого цилиндра, его цвет и 
прозрачность, а также материал (по умолчанию - вакуум). Нажмите ОК. 
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Рис. 1.5. Параметры внутреннего 
вертикального цилиндра 

Рис. 1.6. Чертеж внешнего и 
внутреннего цилиндра 

 
В окне 3D-конструктора вы увидите изображение двух цилиндров, 

вложенных один в другой (рис. 1.6). В дерево модели будет добавлен узел, 
имя которого по умолчанию – Cylinder2. 

 
    

 
 

1.3. Черчение цилиндров протяженных вдоль оси Y  
 

В двух предыдущих параграфах мы начертили два цилиндра, оси которых 
совпадают с осью Z. Теперь приступим к черчению цилиндров, оси которых 
совпадают с осью Y. В этом случае в качестве плоскости, в который чертится 
основание цилиндра, надо выбрать плоскость XZ. Проще всего это сделать,  
выбрав ее из списка, на панели инструментов (рис. 1.7). 

 

 
 

Рис. 1.7. Фрагмент панели инструментов 
 

Начертите внешний  цилиндр, как вы делали в параграфе 1.1. В 
диалоговом окне введите размеры и координаты расположения цилиндра (рис. 
1.8). Обратите внимание, что в строке диалогового окна Axis указано значение 
Y. Это означает, что ось создаваемого цилиндра будет направлена вдоль оси Y. 
Если вы ошиблись с выбором оси, то в данный момент его можно изменить. 
Для этого необходимо щелкнуть мышью по имени оси в столбце Value и из 
раскрывшегося списка выбрать нужную ось. 

Нажмите кнопку ОК. В дерево модели будет добавлен узел, имя которого 
– Cylinder3. 
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Рис. 1.8. Параметры внешнего цилиндра, ось которого направлена вдоль оси Y  
 

Аналогичным образом начертите внутренний  цилиндр. Размеры и 
координаты расположения цилиндра введите в диалоговом окне (рис. 1.8).  

В дереве модели появится новый узел, имя которого – Cylinder4. В окне 3D-
конструктора вы увидите изображение четырех цилиндров (рис. 1.10). 

  

 
 

Рис. 1.9. Параметры внутреннего цилиндра, ось которого направлена вдоль оси Y  
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Рис. 1.10. Изображение в окне 3D-конструктора после завершения операций 
по вычерчиванию цилиндров 

 
1.4. Формирование модели коаксиального Т-разветвления 

 
На данный момент, используя 3D-конструктор, мы создали четыре 

цилиндра: два внешних (Cylinder1 и Cylinder3), имеющих диаметр 7 мм, и два 
внутренних (Cylinder2 и Cylinder4), имеющих диаметр 3 мм. 

Из этого набора цилиндров при помощи команд 3D-конструктора, 
позволяющих работать с трехмерными объектами, необходимо сформировать 
модель коаксиального Т-разветвления. 

1. Объедините два внешних цилиндра в единую Т-образную конструкцию. 
Создайте список объединения, выделив внешние цилиндры. Для этого 
нажмите клавишу Ctrl и ,удерживая ее, щелкните мышью в окне 3D-
конструктора по узлам дерева модели Cylinder1 и Cylinder3. 

Объедините выделенные цилиндры в единую конструкцию, используя 
команду Edit → Boolean → Unite (рис. 1.11). 
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Рис. 1.11. Объединение внешних цилиндров 
 

В дереве модели узлы Cylinder1 и Cylinder3 объединяться в один узел, 
которому будет присвоено имя узла, первым занесенным в список 
объединения. Например, если при выделении внешних цилиндров первым вы 
выделили узел Cylinder3 , то и имя объединенного узла будет Cylinder3. Для 
команды Unite порядок выделения цилиндров не имеет значения. Он влияет 
только на имя, которое дается по умолчанию единой конструкции. 

2. Объедините два внутренних цилиндра в единую конструкцию. Создайте 
список объединения, выделив внутренние цилиндры. Для этого нажмите 
клавишу Ctrl и ,удерживая ее, щелкните мышью в окне 3D-конструктора по 
узлам дерева модели Cylinder2 и Cylinder4. 

Объедините выделенные цилиндры в единую конструкцию, используя 
команду Edit → Boolean → Unite. 

Объединенный узел конструкции из внутренних цилиндров будет иметь 
имя Cylinder2. 

3. Сформируйте модель коаксиального Т-разветвления.  
Чтобы сформировать модель коаксиального Т-разветвления необходимо из 

Т-образной конструкции, состоящей из цилиндров большего диаметра 
(Cylinder3), вырезать Т-образную конструкцию, состоящую из цилиндров 
меньшего диаметра (Cylinder2). Этой цели служит команда Subtract. 

В дереве модели выделите узлы Cylinder3 и Cylinder2. Выделение начинайте 
с узла Cylinder3, так как для команды Subtract порядок выделения имеет 
значение. Дайте команду Edit → Boolean → Subtract… .  Появится диалоговое 
окно команды Subtract, которое содержит два списка Blank Parts и Tool Parts 
(рис. 1.12). 
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Рис. 1.12. Диалоговое окно команды Subtract 
 

В списке Blank Parts перечислены объекты из которых будут вырезаны 
объекты,  содержащиеся в списке  Tool Parts. По умолчанию в список Blank 
Parts попадает объект, который был выделен первым. В нашем случае – это 
Cylinder3. В список Tool Parts попадают остальные выделенные объекты. В 
нашем случае – это Cylinder2. Теперь понятно, почему порядок выделения 
объектов имеет значение для выполнения команды Subtract.  

При необходимости, объект из одного списка можно перенести в другой 
список. Для этого с помощью левой кнопки мыши выделите объект, который 
вы хотите переместить, и нажмите активизировавшуюся кнопку со стрелкой. 

После того как списки Blank Parts и Tool Parts будут сформированы 
нажмите кнопку ОК. В результате выполнения команды Subtract, в дереве 
модели останется один узел Cylinder3, а в окне 3D-конструктора появится 
изображение коаксиального Т-разветвления.  

Узел Cylinder3 можно переименовать. Сделайте это, произведя двойной 
щелчок левой кнопкой мыши по этому узлу и изменив в открывшемся окне 
имя Cylinder3 на - CoaxTee. 

 
1.5. Определение портов и задание граничных условий 

 
Если построенная модель обладает геометрической симметрией, то ее 

можно рассечь плоскостями симметрии, в полученных сечениях задать 
соответствующие граничные условия и решать задачу лишь для части 
структуры. Если разбиение произведено корректно, то полученные результаты 
будут справедливы и для полной модели. Использование свойств симметрии 
позволяет существенно сократить объем вычислений, что приводит к 
заметному уменьшению времени расчета и повышению точности результатов. 

Построенное нами коаксиальное Т-разветвление является симметричной 
конструкцией и имеет две плоскости симметрии: XY и YZ. 
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Рис.1.13. Операция разрезания модели плоскостью симметрии 
 

Воспользуемся симметрией модели относительно плоскости YZ. Выделим 
модель, щелкнув по ее изображению в окне 3D-конструктора или по узлу 
CoaxTee (Cylinder3) в дереве модели. Подайте команду Edit → Boolean → Split…, 
в открывшемся диалоговом окне выберите плоскость сечения (YZ) и 
сохраняемую в проекте часть модели (Negative side). Нажмите кнопку ОК. 
Результат работы команды можно видеть на рис. 1.14. 

Теперь необходимо определить порты и задать граничные условия в 
плоскости симметрии.  

По умолчанию, границей раздела между трехмерной моделью и 
окружающим пространством является идеальная электрическая стенка (Perfect E) 
через которую не может проникать электромагнитная энергия. Для связи 
моделируемого объекта с внешним миром служат особые участки границы, 
называемые волновыми портами. В HFSS предполагается, что каждый волновой 
порт, который вы определите, подключен к полубесконечному волноводу, 
имеющему такое же поперечное сечение, что и волновой порт. В нашем случае 
волновыми портами служат коаксиальные линии с ТЕМ-волной.  

Коаксиальное Т-разветвление имеет три порта. Начнем с определения 
первого из них.  

На панели инструментов задайте режим выделения поверхности (Face). 
Подведите курсор мыши к участку внешней границы, который будем определять 
как порт, и щелкните левой кнопкой мыши. Выбранный участок будет выделен 
цветом. Для вызова контекстного меню щелкните правой кнопкой мыши и 
подайте команду  Assign Excitation → Wave port… (рис. 1.14). 
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Рис.1.14.  Определение волнового порта 
 

Появляется ассистент инициализации волнового порта (рис. 1.15). 
На первой страницы мастера (Wave Port: General) задается имя порта. По 

умолчанию в качестве имени порта используется WavePort1. Такое длинное 
имя будет доставлять неудобства при анализе результатов постпроцессорной 
обработки, поэтому присвойте порту имя P1. Нажмите кнопку Далее>. 

На второй странице мастера (Wave Port: Modes) определяется сколько 
собственных волн (Number of Modes) будет учитываться при расчете поля в 
плоскости порта. По умолчанию это число принимается равным единице. В 
нашем случае это значение нас устраивает, поэтому менять его не будем. 

Для каждой моды можно также определить линию интегрирования 
(Integration Line)  и способ вычисления характеристического импеданса порта 
(Characteristic Impedance).  

Линия интегрирования представляет собой вектор, который может 
представлять следующие понятия: 

 калибровочная линия, определяющая направление возбуждающего 
поля в порту; 

 линия, вдоль который вычисляется напряжение при расчете 
характеристического импеданса порта ZPV или ZVI. 

Определение линии интегрирования важно, если в порту могут 
существовать вырожденные моды, например как в случае квадратного или 
круглого волноводов. В случае коаксиальной линии, используя свойства 
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симметрии, достаточно принять значения, присваиваемые по умолчанию: для 
Integration Line – None, для Characteristic Impedance - ZPI. Нажмите кнопку Далее>. 

 

 
 

 
 

Рис. 1.15. Асситент инициализации волнового порта 
 

На последней странице ассистента (Wave Port: Post Processing) можно 
определить действия, которые будут выполнены в ходе пост процессорной 
обработки результатов расчета: перенормировать матрицу рассеяния 
устройства относительно заданного значения импеданса порта (Port 
Renormalization) и переместить плоскость отсчета (положение порта) для 
расчета матрицы рассеяния (Deembed Setting). 

Воспользуйтесь установками заданными по умолчанию (рис. 1.15). 
Нажмите кнопку Готово. 

Аналогично, используя мастер инициализации порта, определите два 
оставшихся порта (рис. 1.16). 
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Рис. 1.16.  Три порта коаксиального  Т-разветвления 
 

Структура поля ТЕМ-волны коаксиальной линии обладает симметрией 
относительно идеальной магнитной стенки (Perfect H). Мы рассекли модель 
плоскостью симметрии, которая проходит через все три порта. Граничные 
условия в плоскости симметрии должны соответствовать свойствам 
симметрии ТЕМ-волны коаксиальной линии.  

 

 
 

Рис.1.17.  Задание граничных условий в плоскости симметрии 
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Сечение коаксиального Т-разветвителя плоскостью симметрии представ-

ляет из себя три несвязанных плоских поверхности: одна прямоугольная и две 
Г-образных (рис. 1.17). Необходимо указать, что все эти три поверхности 
являются идеальными магнитными стеками. 

Нажмите клавишу Ctrl и, удерживая ее, в окне 3D-конструктора щелкните 
мышью по каждой из трех поверхностей сечения. Выбранные участки будут 
выделены цветом. Для вызова контекстного меню щелкните правой кнопкой 
мыши и подайте команду  Assign Boundary →  Symmtry… . 

В диалоговом окне Symmetry Boundary переключатель Symmetry установите в 
положение Perfect H. Щелкните кнопку Impedance Multiplier…. В диалоговом 
окне Port Impedance Multiplier установите значение импедансного множителя 
равное 0,5 (рис. 1.17). Импедансный множитель необходим для того, чтобы 
рассчитанные величины характеристических сопротивлений соответствовали 
полной конструкции коаксиального Т-разветвителя. Нажмите кнопку ОК. Имя 
для граничных условий Name оставим то, которое задано по умолчанию, т.е. 
Sym1. Нажмите кнопку ОК.  

 
 

Рис. 1.18. Граничные условия и порты в дереве проекта 
    
 На этом определение портов и задание граничных условий закончено. Все 

назначенные порты (Excitations) и граничные условия (Boundaries) будут 
отображены в виде узлов дерева проекта (рис. 1.18). 
 

1.6. Установка параметров решения задачи, расчет и вывод 
результатов 

 
Чтобы определить, как HFSS будет осуществлять расчет структуры поля 

анализируемого устройства, необходимо произвести установку параметров 
решения задачи. Для одного проекта можно задать несколько разных 
установок. Каждая установка параметров включает следующую информацию: 

 общие данные о решении задачи; 



 22

 параметры адаптивного измельчения сетки, если необходимо изменить 
характер измельчения сетки при плохой сходимости решения; 

 параметры частотной развертки, если необходимо получить решение в 
диапазоне частот. 

Чтобы произвести установку параметров решения задачи для данного 
проекта выполните следующие действия. Теперь выполним установки на 
решение. В дереве проекта выделите узел Analysis, щелкните правой кнопкой 
мыши и из контекстного меню выберите команду Add Solution Setup…. 
Появится диалоговое окно установок Solution Setup  (рис. 1.19). 
 

 
 

Рис. 1.19.  Установки параметров решения задачи 
 

На закладке General задаются общие данные о решении:  
 Setup Name - имя данной установки, под которым она будет 
фигурировать в дереве проекта (по умолчанию – Setup1); 

 Solution Frequency – частота на которой выполняется поиск решения; 
 Maximum Number of Passes – максимальное число итераций 

(максимальное число циклов измельчения сетки) для получения 
решения с точностью; 

 Convergence per pass -  параметр, который определяет критерий 
сходимости решения. 

Поиск решения будет осуществляться по следующему алгоритму: 
1. На заданной частоте производится начальная генерация сетки. В 

результате чего весь объем модели разбивается на конечные элементы  
(тетраэдры). Конфигурация сетки и размер тетраэдров определяются 
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установками параметров, заданными в закладках Options и Advanced. На 
данном этапе примем их такими, какими они задаются в HFSS по умолчанию. 

2. В узлах сетки вычисляется электромагнитное поле, которое 
удовлетворяет уравнениям Максвелла и граничным условиям. 

3. Рассчитывается обобщенная матрица рассеяния устройства. 
4. Выполняется процесс измельчения сетки, в соответствии с установками, 

заданными на закладках Options и Advanced. Для новой сетки вычисляется 
электромагнитное поле и обобщенная матрица рассеяния. 

5. Вычисляется параметр Maximum Delta S, который характеризует степень 
различия матриц рассеяния, рассчитанных для двух соседних итераций. Если 
величина этого параметра становится меньше заданного значения, вычисления 
прекращаются. В противном случае они продолжаются вплоть до достижения 
заданного максимального числа итераций Maximum Number of Passes. 

Произведите установку параметров решения задачи в соответствии с рис. 
1.19 и нажмите кнопку ОК. На этом создание проекта можно считать 
законченным. Перейдем к решению задачи и анализу полученных результатов. 

Проведите проверку созданного проекта, щелкнув кнопку Validate  на 
панели инструментов HFSS. В процессе выполнения этой операции 
проверяется отсутствие ошибок при создании графического изображения 3D-
модели, корректность задания граничных условий и определения портов, 
правильность установок параметров для решения задачи. 

 

 
   а)       б) 
 

Рис. 1.20.  Результаты проверки проекта: 
а) в проекте допущена ошибка;     б) проверка проекта прошла успешно. 

 
После окончания проверки появляется окно Validation Check с результатами 

проверки проекта (рис. 1.20).  
Результаты проверки проекта, в котором допущена ошибка, показаны на 

рис. 1.20а. В данном случае допущена ошибка при установке параметров 
решения задачи. Щелкните кнопку Close и исправьте обнаруженные ошибки. 
Проведите повторную проверку проекта.  

Результаты успешного завершения проверки проекта представлены на 
рис. 1.20б. Щелкнув кнопку Close закройте окно с результатами проверки 
проекта. 
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Проект, успешно прошедший проверку, готов для выполнения задачи 
анализа. Чтобы начать решение задачи анализа щелкните кнопку Analyze   
на панели инструментов HFSS.  

 
 

Рис. 1.21. Вид окна состояния во время выполнения задачи анализа 
 

 
 

Рис. 1.22. Вид окна сообщений после успешного выполнения задачи анализа 
 

Ход выполнения задачи анализа отображается в окне состояния, в 
котором выводится название выполняемого в данный момент шага задания и 
бегущая полоска, показывающая степень завершенности этого шага (рис. 
1.21). Решение задачи анализа можно прервать, нажав кнопку Abort. 

После завершения анализа окно состояния очистится, а в окне 
сообщений появится сообщение об успешном выполнении задачи анализа 
(рис. 1.22). 

Чтобы более подробно просмотреть данные о ходе решения задачи, 
задействованных ресурсах и результатах расчета дайте команду Solution Data, 
щелкнув кнопку   на панели инструментов HFSS. Появится диалоговое 
окно Solution Data с несколькими закладками. 

 

 
 

Рис. 1.23. Диалоговое окно Solution Data с результатами сходимости 
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На закладке Convergence (рис. 1.23) приводятся данные о сходимости и 
проведенном числе итераций. В списке Simulation вы можете выбрать имя 
установки параметров задачи, для которой вы хотите посмотреть результаты 
решения. Это актуально в том случае если было задано несколько установок 
параметров и необходимо сравнить между собой результаты расчета для 
разных установок. Для данной задачи этот список содержит имя только одной 
установки Setup1. 

В таблице  Number of Passes сообщается, что итерационный процесс 
завершился (Completed) за две итерации, при заданном максимальном числе 
итераций (Maximum) равном шести. Минимальное число итераций (Minimum) 
соответствует не итерационному процессу (N/A). 

В таблице Max Mag. Delta S приводится текущее (Current)значение параметра 
сходимости,  равное 0.00168, и предельная величина параметра сходимости 
(Target), при достижении которой итерационный процесс останавливается. 

Из приведенных данных следует что итерационный процесс сошелся за две 
итерации, о чем также свидетельствует зеленая ″птичка″ в верхней части окна 
и сообщение CONVERGED в левом нижнем углу окна. 

Ход итерационного процесса можно просмотреть в виде графика Plot или в 
виде таблицы Table, выбрав вид просмотра посредством переключения кнопки 
View.  Таблица содержит три столбца: номер итерации, число тетраэдров в 
сетке и значение параметра сходимости для данной итерации. 

Закладка Profile содержит записи журнала, отображающие ход 
выполняемого задания. В этих записях содержатся сведения о выполненных 
этапах задания, об объеме задействованной памяти и времени, затраченном на 
выполнение каждого этапа.  

 
 

Рис. 1.24. Диалоговое окно Solution Data с результатами расчета матрицы 
рассеяния 

 
В закладке Matrix Data можно посмотреть результаты расчета матрицы 

рассеяния устройства, характеристические сопротивления и волновые числа 
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для каждой собственной волны (mode) каждого порта и ряд других параметров 
(рис 1.24). Все эти данные можно увидеть для всех итераций и параметров. 

Параметр Simulation содержит два значения, выбираемые из списка: имя 
установки параметров Setup1, и имя итерации; в данном случае выбрана 
последняя итерация LastAdaptive (рис 1.24). 

Флажками отмечены параметры, которые выводятся для просмотра. По 
умолчанию флажок установлен для просмотра матрицы рассеяния S Matrix. 
Можно выбрать вид представления матрицы рассеяния. Выберите значение 
Magnitude/Phase (Модуль/Фаза). Установите также флажки для просмотра 
постоянной распространения собственных волн порта (Gamma) и его 
характеристического сопротивления (Z0). 

Характеристическое сопротивление коаксиальной линии с воздушным 
заполнением определяется соотношением: 
 

⎟
⎠
⎞

⎜
⎝
⎛=

d
DZ ln600 . 

 
Для рассматриваемого примера D/d=7/3, и тогда Z0 = 50.838 Ом. 

Рассчитанные величины характеристических сопротивлений портов (рис. 1.24) 
отличаются от теоретического значения на величину не превышающую 0.1%. 

Длина волны ТЕМ-волны коаксиальной линии: 
fc /=λ , 

где  с = 3⋅108 м/с – скорость света,  f – частота. 
 
    В нашем случае λ = 0.15 м. Рассчитанное значение длины волны Lambda 

для всех равно 0.1499 м. Погрешность расчета составляет 0.07%. 
Используя команду Solution Data, можно осуществлять оперативное 

наблюдение за процессом решения задачи в реальном времени. После запуска 
задачи на решение откройте окно Solution Data и наблюдайте, как изменяется 
параметр сходимости и элементы матрицы рассеяния на каждом шаге 
итерационного процесса. 

После завершения задачи анализа в узле дерева проекта Port Field Display 
появятся узлы портов P1, P2 и P3, каждый из которых включает узлы 
собственных волн порта вида Mode n, где n – номер собственной волны порта. 
Число собственных волн порта определяется при его инициализации. В нашем 
случае было задано по одной собственной волне для каждого порта (рис. 1.25). 

Узлы собственных волн порта  в дереве проекта предоставляют доступ к 
информации о структуре поля собственных волн, возбуждаемых в порту. 
Знание структуры поля собственных волн всех портов позволяет обнаружить 
ошибки проекта, которые не могут быть выявлены при проверке, 
выполняемой по команде Validate  (рис. 1.20). 

Например, вы забыли задать граничные условия в плоскости симметрии 
для коаксиального Т-разветвления. В этом случае по умолчанию будет 
принято, что плоскость симметрии представляет из себя идеальную 
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электрическую стенку. Проверка проекта по команде Validate не выявит этой 
ошибки, так как задача с такими граничными условиями также имеет право на 
существование. 

Поэтому если вы получите решение, которое вас не устраивает, проверьте 
структуру поля собственных волн порта. Раскройте узел проекта Port Field 
Display, выберите узел порта Р1 и щелкните мышью по узлу Mode 1. На чертеже 
модели в сечении порта возникнет семейство векторов, отображающее 
структуру электрического поля собственной волны порта (рис. 1.25). 

 

 
а) ТЕМ                                        б) Н11 

Рис. 1.25. Поле собственных волн порта коаксиального  Т-разветвления 
 

Если граничные условия в плоскости симметрии заданы правильно, то вы 
должны увидеть структуру поля, показанную на рис. 1.25а (направление 
векторов может быть противоположным). Это ТЕМ-волна – основная волна 
коаксиальной линии. 

Если же вы увидите структуру поля, подобную той, что показана на рис. 
1.25б, то это значит, что в порту возбуждается один из высших типов волн 
коаксиальной линии,  а именно волна Н11. По мере приближения к плоскости 
симметрии направление векторов электрического поля становится 
ортогональным к этой плоскости. Это значит, что в плоскости симметрии 
расположена электрическая стенка. 

Чтобы получить решение для структур поля в портах, не обязательно 
решать задачу для всего устройства. HFSS предоставляет возможность 
установить режим решения, который позволяет решать задачу по 
определению поля только в портах. Для этого при установке параметров 
решения задачи в диалоговом окне Solution Setup включите флажок Solve Port 
Only на вкладке General (рис. 1.19).  

Решив задачу для портов, проверьте структуру поля собственных волн. 
Убедившись в том, что в портах возбуждаются нужные типы волн, 
приступайте к решению задачи анализа устройства в целом, предварительно 
сняв флажок Solve Port Only. Такой подход для сложных задач позволит вам 
избежать ненужных затрат рабочего времени. 
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Имея решение для структуры поля, можно получить визуальное 
изображение распределения поля как по всему объему устройства, так и на 
любой поверхности модели или в любой заранее определенной плоскости. Для 
примера выведем распределение поля в плоскости симметрии YZ. 

Обратимся к дереву модели. Раскройте узел Planes и выберите плоскость 
YZ в глобальной системе координат, щелкнув левой кнопкой мыши по ветви 
Global:YZ. В окне 3D-конструктора появится изображение черного квадрата, 
расположенного в плоскости YZ. Правой кнопкой мыши вызовите контекстное 
меню и подайте команду Plot Field → Mag_E. Подавая данную команду, вы 
сообщаете HFSS, что необходимо отобразить распределение амплитуды 
электрического поля. В раскрывшимся диалоговом окне Create Plot 
подтвердите сделанный вами выбор и щелкните кнопку Done (рис. 1.26). 
 

 
 

Рис. 1.26. Команды для отображение распределения поля в плоскости YZ 
 

Через некоторое время, после того как HFSS произведет необходимые 
расчеты, в дереве проекта появится узел E-Field с ветвью Mag_E1, а в окне 3D-
конструктора появится изображение распределения поля в выбранной вами 
плоскости. Это изображение наложено на графический чертеж конструкции. 
Для визуального представления распределения поля выбрана цветовая гамма 
из шестнадцати цветов, каждому цвету соответствует определенная амплитуда 
поля. Соответствие цветов и амплитуд приведено в таблице E Field [V/m],  
которая расположена в левом верхнем углу окна 3D-конструктора (рис. 1.27). 

Параметры визуализации поля можно изменить. Заведите курсор внутрь 
таблицы E Field [V/m], вызовите контекстное меню  и выберите команду Modify…. 
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Откроется диалоговое окно HFSSModel1 -- E Field, в котором можно изменить 
количество цветов для представления поля, вид спектра и ряд других 
параметров. Поэкспериментируйте с этими параметрами, изменяя их значения, 
и понаблюдайте за изменением картины распределения поля.  Это поможет вам 
понять их назначение. 

 

 
 

Рис. 1.27. Распределение амплитуды электрического поля в плоскости YZ 
 

Распределение поля, показанное на рис. 1.27, получено для случая, когда 
коаксиальное Т-разветвление возбуждается посредством источника, 
подключенного к порту P1. Использование порта P1 в качестве источника 
возбуждения в HFSS принято по умолчанию. Чтобы посмотреть 
распределение поля при возбуждении через другие порты, необходимо 
изменить установки, принятые по умолчанию.  

 
 

Рис. 1.28. Редактирования источника возбуждения 
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В дереве проекта выделите узел Field Overlays. Щелкнув правой кнопкой 
мыши, вызовите контекстное меню, в котором выберите пункт Edit 
Sources…(рис. 1.28). 

В диалоговом окне Edit Sources произведите необходимые установки и 
нажмите кнопку OK. HFSS произведет перерасчет и отобразит новое 
распределение поля в окне 3D-вида. 

HFSS позволяет анимировать изображения, которые представляют собой 
последовательность кадров. На каждом кадре отображается распределение 
поля, изменяющееся в зависимости от некоторого заданного параметра.  

Создадим анимированное изображение, зависящее от фазы отображаемого 
поля, воспользовавшись распределением поля, которое было создано на 
предыдущем этапе (рис. 1.29). 

 

 
 

Рис. 1.29. Создание анимированного изображения для распределения поля 
 

В дереве проекта раскройте сначала узел Field Overlays, а затее – узел E Field 
и выделите ветвь Mag_E1. Щелкнув правой кнопкой мыши, вызовите 
контекстное меню, в котором выберите пункт Animate…(рис. 1.29). 

Если это первое анимированное изображение, которые вы создаете, 
появится диалоговое окно Setup Animation. В текстовом окне Name введите имя 
для создаваемого изображения или примите имя, присваемое по умолчанию – 
Animation1. На закладке Swept Variable из списка Swept variable выберите 
значение Phase. Задайте значения фазы, которые вы хотите включить в 
анимированное изображение: начальное значение фазы введите в текстовое 
окно Start, конечное значение фазы введите в текстовое окно Stop, в текстовое 
окно Step введите количество шагов, которое содержит в себе анимированное 
изображение. Отметим, что количество кадров в анимированном изображении 
будет равно Step + 1. Щелкните кнопку OK. 

На экране будет воспроизводится анимированное изображение 
распределения поля. В левом верхнем углу окна 3D-конструктора появится 
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панель управления с помощью которой вы сможете остановить и возобновить 
воспроизведение изображения, изменять скорость и частоту следования 
кадров. 

До сих пор все расчеты производились на фиксированной частоте. Для 
того чтобы получить решение в диапазоне частот, необходимо в установку 
параметров для решения задачи включить развертку по частоте. HFSS 
выполняет расчет в диапазоне частот после завершения итерационного 
процесса на фиксированной частоте. 

Чтобы в установку параметров включить развертку по частоте раскройте в 
дереве проекта узел Analysis и выделите ветвь Setup1. Щелкнув правой кнопкой 
мыши, вызовите контекстное меню, в котором выберите пункт Add Sweep…. 

Появляется диалоговое окно Edit Sweep (рис. 1.30). В текстовом окне Sweep 
Name введите имя для создаваемой частотной развертки или примите имя, 
присваемое по умолчанию – Sweep1. 

 

 
 

Рис. 1.30. Задание частотного диапазона 
 

Из набора частотных разверток Sweep Type выберите развертку Discrete,  
включив соответствующую кнопку. Для данного вида развертки поле будет 
рассчитываться в заданных точках частотного диапазона. 

Установите частотный диапазон. В текстовых окнах Start и Stop введите 
начальную и конечную точки частотного диапазона, соответственно. Из 
списка Type выберите  линейную шкалу для частот Linear Step и в текстовом 
окне Step Size введите расстояние между частотными точками на этой шкале. 
Из выпадающих списков выберите единицу измерения для заданных точек 
частотной шкалы. 

Если вы хотите увидеть весь набор точек частотной шкалы, в которых 
будет производится расчет, щелкните кнопу Display>>. Он будет отображен в 
текстовом окне, расположенном справа от этой кнопки (рис. 1.30). 
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По умолчанию, решение для поля будет сохранено только для конечной 
точки частотного диапазона, а также для частоты, на которой получено 
оптимизированное решение. Если вы хотите сохранить решения для поля во 
всех точках частотного диапазона, установите флажок Save Fields (All 
Frequencies). S-параметры всегда сохраняются для всех заданных точек 
частотного диапазона. 

Важно отдавать себе отчет в том, что для получения решения в диапазоне 
частот HFSS использует сетку, созданную по методу конечных элементов и 
оптимизированную в ходе итерационного процесса при получении решения на 
частоте Solution Frequency, которая была задана при установке параметров на 
решение в окне Solution Setup (рис. 1.19). Эта сетка используется для всех точек 
частотного диапазона без дальнейшего измельчения. Так как эта сетка 
оптимизирована только для одной частоты, то вполне возможно, что при 
удалении от этой частоты точность решения будет падать. Если вы хотите 
минимизировать эту погрешность, то в качестве частоты, на которой ищется 
оптимизированное решение, выбирайте центральную частоту частотного 
диапазона. 

Установите в окне Edit Sweep все параметры, как показано на рис. 1.30, и 
нажмите кнопку OK. На панели инструментов нажмите кнопку  и ждите 
окончания решения для всех точек частотного диапазона. Информация об 
успешном завершении решения появится в окне сообщений. 
 

После окончания задачи анализа результаты расчетов можно вывести в 
виде графиков и таблиц для просмотра и анализа.  

Для вывода результатов расчета выделите в дереве проекта узел Results, 
откройте контекстное меню и подайте команду Create Report…. Откроется 
диалоговое окно Create Report, которое содержит два раскрывающихся списка. 

Список Report Type определяет параметры, выводимые для просмотра. Он 
содержит два элемента: 

1. Modal S Parameters – вывод элементов матрицы рассеяния; 
2. Fields – вывод для просмотра распределение поля. 
Список Display Type определяет способ отображения результатов расчета, 

выводимых для просмотра. Он содержит следующие элементы: 
1. Rectangular Plot – вывод результатов расчетов в виде двухмерного графика 

в декартовой системе координат; 
2. Polar Plot - вывод результатов расчета в виде двухмерного графика в 

полярной системе координат; 
3. Radiation Pattern – строить диаграмму направленности для излучающих 

элементов; 
4. Data Table - выводить результаты расчетов в виде таблиц; 
5. Smith Chart – выводить результаты расчета матрицы рассеяния на 

круговую диаграмму; 
6. 3D Rectangular Plot - выводить результаты расчетов в виде трехмерного 

графика в декартовой системе координат; 
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7. 3D Polar Plot - выводить результаты расчетов в виде трехмерного графика 
в сферической системе координат. 

 
Выведем графики, отображающие зависимость элементов матрицы 

рассеяния от частоты. В диалоговом окне Create Report выберите для 
параметра Report Type значение Modal S Parameters, а для параметра Display 
Type – значение Rectangular Plot (рис. 1.31). Щелкните кнопку ОК. Раскроется 
диалоговое окно Traces. 

 

 
 

Рис. 1.31. Вывод результатов расчета в графиков 
 

Для параметра Solution выберите из списка значение Setup1: Sweep1. На 
закладке Y  в столбце Category выделите, щелкнув левой кнопкой мыши, 
выделите строку S Parameter, в строке Function – выделите dB (выводить 
элементы матрицы рассеяния в децибеллах), а в столбце Quantity поочередно 
выделяйте строки S(P1,P1), S(P2,P1), S(P3,P1) и щелкайте кнопку Add Trace. 
Все выбранные таким образом элементы матрицы рассеяния будут занесены в 
список вывода, который находится в верхней части окна Traces (рис. 1.31). 
Этот список можно редактировать, используя кнопки Remove Trace (удалить 
выделенную строку), Remove All Traces (удалить все строки), Add Blank Trace 
(добавить пустую строку) и Add Trace (добавить строку). 

Теперь легко понять, почему при инициализации портов были выбраны 
короткие имена P1, P2 и P3 вместо предлагаемых по умолчанию имен 
WavePort1 и т.д. Наглядность и читабельность очевидны. 

Сформировав список вывода, щелкните кнопку Done. В дереве проекта в узле 
Result появится ветвь XY Plot 1 и откроется одноименное окно с графиками 
частотных зависимостей для элементов матрицы рассеяния  (рис. 1.32). 
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Рис. 1.32. Частотные характеристики коаксиального Т-разветвления 

 

Выведем таблицу, содержащую элементы матрицы рассеяния, которая 
была рассчитана в ходе итерационного процесса. В диалоговом окне Create 
Report выберите для параметра Report Type значение Modal S Parameters, а для 
параметра Display Type – значение Data Table (рис. 1.33). Щелкните кнопку 
ОК. Раскроется диалоговое окно Traces. 

Для параметра Solution выберите из списка значение Setup1: LastAdaptive. 
На закладке Y  в столбце Category выделите, щелкнув левой кнопкой мыши, 
выделите строку S Parameter, в строке Function – выделите <none>, а в столбце 
Quantity поочередно выделяйте строки S(P1,P1), S(P1,P2), S(P1,P3) и щелкайте 
кнопку Add Trace. 

 

 
 

Рис. 1.33. Вывод результатов расчета в виде таблицы 
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Сформировав список вывода, щелкните кнопку Done. В дереве проекта в 
узле Result появится ветвь Data Table 1 и откроется одноименное окно с 
результатами расчета  (рис. 1.34). 

 

 
 

Рис. 1.34. Результаты расчета матрицы рассеяния 
 

В принципе все девять элементов матрицы рассеяния можно вывести в 
виде одной таблицы, но для наглядности рассмотрения создайте еще две 
таблицы, содержащие по три элемента (рис. 1.34). Матрица рассеяния, 
представленная на рис. 1.34, отличается от матрицы рассеяния, отображаемой 
в окне Solution Data (рис. 1.24), лишь точностью представления результатов. 

Отметим, что рассчитанная матрица рассеяния обладает свойствами 
взаимности:  S21 = S12,  S31 = S13  и  S32 = S23. 

Если построить эквивалентную схему коаксиального Т-разветвления, 
используя теорию длинных линий, и пренебречь влиянием неоднородностей, 
то для элементов матрицы рассеяния можно получить следующие значения: 

⏐S11⏐ =⏐S22⏐ =⏐S33⏐ =1/3 , ⏐S21⏐ = S31⏐ =2/3. 
Рассматривая результаты расчетов, представленных на рис. 1.32 и 1.34, 

можно сделать вывод, что такая простая схема хорошо описывает работу 
коаксиального Т-разветвления на частотах до 2 − 3 ГГц. На более высоких 
частотах, из-за влияния реактивных полей вблизи стыка линий, результаты 
расчетов начинаю отклоняться от результатов предсказанных такой простой 
эквивалентной схемой.  

Матрица рассеяния взаимного многополюсника без потерь должна быть 
унитарной, т.е.  

ISS =⋅
*

, 
где S - матрица рассеяния, 

*
S - комплексно сопряженная матрица,  

I - единичная матрица. 
Подставив рассчитанную матрицу рассеяния (рис. 1.34) в приведенное 

уравнения и произведя соответствующие расчеты, получим 
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т.е. абсолютная погрешность, отличающая полученную матрицу от единичной, 
имеет порядок 10-7. 

В соответствии со свойствами симметрии Т-разветвления должны выполнятся 
следующие соотношения: S21 = S31 и S22 = S33. Как видно из рис. 1.26 для этих 
элементов наблюдается небольшая асимметрия. Это вызвано тем, что 
характеристические сопротивления портов вычислены с небольшой ошибкой, 
составляющей  ∼ 0.1%. Данная асимметрия портов и привела к наблюдаемой 
асимметрии элементов матрицы рассеяния. 

Итак, в этом первом разделе мы построили модель коаксиального Т-
разветвления и рассчитали его частотные характеристики. Познакомились с 
командами HFSS, необходимыми для создания и выполнения проекта. 
Научились чертить отдельные графические примитивы и объединять их в 
единую конструкцию, инициировать порты и задавать граничные условия, 
представлять результаты расчета в виде графиков и таблиц. 
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2. Проектирование микрополоскового фильтра  
 
 
     Программа HFSS моделирует трехмерные (3D) структуры. Однако часто в 
конструкции можно выделить двумерные части, например планарные формы.  
В этих случаях в трехмерном пространстве создается и выделяется плоскость, 
на которой чертится планарная форма. После черчения этой формы ее можно 
преобразовать в трехмерную (с толщиной), а можно просто задать граничное 
условие, моделирующее выбранный металл с потерями. Последний подход 
более экономично использует ресурсы компьютера. 
 
     В анализируемом в данном разделе фильтре (рис. 2.1), для уменьшения 
объема задачи,  рисуется только половина структуры, используя то, что 
микрополосковый фильтр имеет симметрию.  В плоскости симметрии 
устанавливается специальное граничное условие Symmetric H-Boundary. 
        Сначала начертим два параллелепипеда (в англоязычной литературе часто 
используется термин Box – коробка, вместо математического термина  
«параллелепипед»), один поверх другого, представляющие подложку и 
воздух. Затем  на верхнем слое подложки чертится двумерная 
микрополосковая линия. 

 
 

Рис. 2.1. Размеры фильтра на микрополосковой линии 
 
    Для черчения микрополоскового фильтра используем следующую после-
довательность шагов: 
 

• Черчение одной половины бокса подложки. 
• Черчение одной половины бокса воздушного корпуса. 
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• Черчение половины двумерной микрополосковой линии. 
   
     Пошагово выполните следующие действия: 
 
1. Запустите программу HFSS. Появляется менеджер проектов. 
2. В списке Projects нажмите New.  
3. В поле New Project впечатайте имя lpfilter. 
4.  Нажмите OK. 
 
5. Откройте диалог Option -> General Project, чтобы установить единицы для 
проекта. Для этого примера используйте параметры настройки, которые пока-
зываются на рис. 2.2. Кроме этого нужно установить единицы в разделе 3D 
Modeler -> Unit…, которые относятся к данной конструкции (в проекте может 
быть несколько конструкций, каждая из которых может иметь единицы изме-
рения в разных системах). 

 
 

Рис. 2.2. Установка единиц измерения параметров в проекте 
 

2.1. Черчение диэлектрической подложки 
 

      Используя команду Draw - > Box, начертим  параллелепипед – подложку 
под микрополосковый фильтр. Параметры подложки можно изменить, исполь-
зуя окно свойств (рис. 2.3) объекта. 
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Рис. 2.3. Параметры микрополосковой подложки 

 

 
 
 

Рис. 2.4.  Половина диэлектрической подложки 
 

     Ниже мы зададим материал подложки. Верхняя часть фильтра будет 
воздушная, а металлическая форма будет иметь бесконечно малую толщину. 

  
2.2. Черчение воздушной коробки 

 
   Чтобы начертить воздушную коробку, которая охватывает фильтр на микро-
полосковой линии, выполним следующие шаги: 
 
1. Начертим бокс, командой  Draw-> Box  и зададим ей следующие парамет-

ры: 
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Рис. 2.5. Параметры бокса над микрополосковой линией 

 
 

Рис. 2.6. Задание двумерной плоскости для черчения на ней микрополосковой 
линии 

 
     Выделим плоскость face7  параллелепипеда Box1. Это можно сделать либо 
курсором, либо используя команду Select By Name в меню Edit. После выде-
ления этой плоскости она будет рабочей и на ней можно чертить микропо-
лосковую линию. Другим способом создания рабочей плоскости можно счи-
тать сдвиг глобальной системы координат на 25 mil вверх. 
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2.3. Черчение металлической формы фильтра 
 
  В окне состояний (рис. 2.7) наберем X=0, Y=185, Z=25,  чтобы попасть в 
угол, с которого будем чертить форму микрополоскового фильтра (точнее, 
половину формы фильтра, разрезанной плоскостью симметрии). Это будет 
нулевая точка будущей металлической формы фильтра. 

 

 
 

Рис.  2.7. Установка первой точки для черчения формы микрополосковой 
линии 
 
   Теперь поставим режим черчения, использующий относительное прираще-
ние, с помощью перевода режима Absolute в режим Relative. В этом режиме 
будем вводить в окна изменения  координат очередной точки (в mils) относи-
тельно предыдущей. После введения координат каждой точки (табл.2.1) нажи-
майте клавишу Tab. 

 
Табл. 2.1. Последовательного ввода данных в окна. Каждый ввод разделяется 

нажатием клавиши Tab 
Номер точки Δx Δy Δz 

1 0 -12.5 0 
2 70 0 0 
3 0 -60 0 
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4 45 0 0 
5 0 65 0 
6 65 0 0 
7 0 -125 0 
8 25 0 0 
9 0 125 0 
10 65 0 0 
11 0 -65 0 
12 45 0 0 
13 0 60 0 
14 70 0 0 
15 0 12.5 0 
16 -385 0 0 

 
    После завершения ввода нужно замкнуть металлическую форму, используя 
команду Close Line, нажав Enter, либо дважды левую кнопку мыши. 
 

 
Рис. 2.8. После окончания черчения микрополоскового фильтра, появляется 

окно свойств этой формы 
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Рис.  2.9. Начерченная форма половины микрополоскового фильтра 

 
     После завершения черчения и создания формы микропоскового фильтра,  
выделим его и придадим ему граничное условие Perfect_E. 
 
     2.4. Назначение границ для микрополоскового фильтра 
  
    На входе и выходе фильтра устанавливаются порты. В данном случае в ка-
честве порта принимаем и верхнюю и нижнюю части пространства, в котором 
распространяются электромагнитные волны. Выделим обе эти плоскости и 
зададим команду Waveport. С помощью ассистента (рис. 2.10) выполним 
установку порта, в том числе интегральной линии. 
     Аналогично устанавливаем порт 2, выделяя два противоположно стоящих 
прямоугольника. Задание порта 2 можно выполнить также сдвигом первого по 
оси x. 
     Линию полного сопротивления на каждом из портов можно задать в центре 
подводящей линии. По этой линии тангенциальная составляющая вектора 
электрического поля будет максимальная.   
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Рис.  2.10. Задание портов в виде волноводного порта  

 
  В микрополосковом фильтре напряженность поля волны первого типа будет  
максимальной между центром микрополоска (полной ширины) и  экраном 
(нижней заземленной поверхностью). В этом случае программа вычисляет 
импедансы Zpv (по мощности и напряжению) и Zvi  (напряжению и току) на 
каждом из портов для типов волн, которые Вы задали. Импеданс Zpi 
рассчитывается всегда, за исключением случая, когда  граница порта не 
содержит никаких проводников. Чтобы задать порты: 

1. Выделите сечение сверху, и снизу микрополоскового фильтра. 
2. Поскольку микрополосковый фильтр имеет магнитную стенку в 

плоскости симметрии, введите значение 0.5 в поле для множителя полного 
сопротивления Impedance Multiplier.Это обеспечит расчет входного 
сопротивления фильтра с учетом его разрезания. 

3. Введите порт волноводного типа и войдите в ассистент задания 
порта.  

4. Введите интегральную линию порта между земляной платой и 
верхней подводящей линией фильтра.  
     Портом становятся две плоскости, внизу и вверху микрополоскового 
фильтра. 
 
    Далее выполните аналогичные  шаги, чтобы задать порт 2. 

 
      Симметричная магнитная стенка, которая показывается на рис.  2.10 – это 
граница, которую Вы создали для черчения одной половины 
микрополоскового фильтра. 
     Выберите эту плоскость, параллельную глобальной плоскости xz, и опре-
делите её как симметричную магнитную стенку, что будет учтено в ходе 
решения задачи. 
 
     Чтобы задать симметричную H границу: 
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1. Нажмите на правую кнопку мышки и в выплывающем меню выберите  

Symmetric Boundary, а в окне (рис. 2.11) выберите Perfect H (симметричная 
H плоскость). 

Рис. 2.11. Выбор параметров плоскости 
симметрии 

 

Рис 2.12. Электрическое поле в 
сечении порта 

микрополоскового фильтра 
 
Заметим, что имя границы Symmetric_H_Plane появляется в дереве проекта.  
     Внешняя поверхность модели определяется по умолчанию как идеальный 
проводник (заземленный корпус).  Сечениями портов служат вертикальные  
плоскости, включая часть в подложке, под микрополосковой линией, и вся 
плоскость корпуса, над микрополосковой линией. Такое описание порта 
позволяет связать поля в сечении слоев с разными диэлектрическими 
проницаемостями (рис. 2.12). 

 
     

2.5. Назначение материалов на объекты,  
входящие в микрополосковый фильтр 

 
     Верхний бокс над микрополосковым фильтром заполнен воздухом, а под-
ложка имеет электрическую проницаемость  Eps=9.6  и тангенс диэлектри-
ческих потерь tan =0.0003. Выделив пространство, которое заполняет объект, 
командой Assign Material зададим материал этого объекта (рис. 2.13). 
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Рис. 2.13. Задание материала  подложки микрополоскового фильтра 
 
     В HFSS имеется банк данных большого количества материалов. Кроме это-
го имеется возможность описать любой материал, не имеющийся в банке дан-
ных. Для описания можно ввести проницаемость и тангенс диэлектрических 
потерь. Более сложные случаи описания материалов будут показаны ниже.  

 
Рис. 2.14.  Задание проводимости с потерями микрополоскового фильтра 

 
     Кроме назначения материала трехмерному объекту, свойства материала 
можно задать при описании граничных условий, например границы с  конеч-
ной проводимостью (рис. 2.14). В таком описании можно задать потери, шеро-
ховатость и толщину слоя. 



 47

 
2.6. Решение проекта микрополоскового фильтра 

 
      Командой Analysis -> Add Solution Setup устанавливаем частоту решения, 
которая является основанием для начального разбиения на ячейки, равной 2 
ГГц, а затем с  помощью команды Add Sweep устанавливаем  полосу частот 
расчета фильтра, от 1 до 10 ГГц через 0.2 ГГц. 
   Чтобы вывести результаты расчета S параметров в диапазоне частот, нажми-
те правой кнопкой мыши Result -> Project Report. Появляется диалог (рис. 
2.15): 

 
Рис. 2.15. Окно создания характеристик 

 
     В нем выбираем тип выводимых характеристик: Modal Solution Data, тип 
графика – прямоугольный, а затем S- параметры из диалогового окна рис. 2.16. 

 

 
Рис.  2.16. Выбор рассчитанных параметов для вывода на частотную 

характеристику 
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     Поскольку в конструкции два порта, то можно вывести четыре параметра: 
S11, S21, S12 и  S22, перечисленные в столбце Quantity. Добавляя характе-
ристику, нажимая на кнопку Add Trace и Done, получаем характеристики, 
показанные на рис. 2.17. 

 
Рис.  2.17. Частотная характеристика микрополоскового фильтра 

 
     В качестве результатов расчета можно считать также электрические и 
магнитные поля, распространяющиеся в пространстве СВЧ устройства. 
Выделим металлическую форму фильтра и правой кнопкой мыши командой 
Field -> Mag E, выведем электрическое поле на поверхности фильтра (рис. 
2.18). 

 

 
Рис. 2.18. Электрическое поле, перпендикулярное  поверхности металлической 
формы фильтра 



 49

 
     Для того, чтобы получить верную картину поля, распространяющегося 
вдоль фильтра, рекомендуется увеличить число адаптаций величины ячеек, до 
12 и выше. 
 
     Итак, в этом разделе мы применили черчение сложной планарной структу-
ры по точкам, используя ввод координат. Планарные схемы широко использу-
ются в технике СВЧ, и они анализируются с помощью программы HFSS иск-
лючительно точно.  
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3. Моделирование рупорной антенны 
 
 
      В рассмотренных нами примерах коаксиального Т-образного разветвителя 
и микрополоскового фильтра внешние границы были металлическими, 
образуя экранирующий корпус. Электромагнитное поле в этих конструкциях 
было сосредоточено внутри анализируемого объема.  
     Антенна – это устройство, которое принципиально излучает 
электромагнитную энергию бесконечно далеко в пространство. Поэтому 
излучаемая конструкция  будет охвачена границей, называемой границей 
излучения. 
    Рупор - простая антенная структура. Она состоит из базовой части, 
расширяющегося рупора и раскрыва. В данном случае раскрыв (растр) имеет 
пирамидальную форму. Чтобы начертить эту антенну, используются  
несколько полезных команд черчения, для создания трехмерных объектов из 
двумерных объектов, которые составляют плоскости рупора (рис. 3.1). 
 

 
Рис. 3.1. Размеры рупорной антенны в дюймах 

 
    Процесс черчения рупорной антенны состоит из следующих шагов: 
 
• Черчение трехмерного параллелепипеда, который представляет собой  базу, 
или горловину рупора. 
• Черчение двумерного прямоугольника, отображающего апертуру рупора. 
• Черчение наклонных сторон рупорной антенны. 
• Черчение бокса, охватывающего антенну, на котором будет установлено 
граничное условие излучения. 
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    Чтобы подготовиться к черчению рупора, создадим и назовем проект, уста-
новим сетку черчения и единицы.   Чтобы создать новый проект: 
 

1. Запустите программу. Появляется  окно менеджера проекта. 
2. В списке Projects, нажмите New. Появляется окно New Project. 
3. Напечатайте имя horntutor в поле New Project. 
4. Нажмите OK. 

 
     Файл по имени horntutor.hfss появляется в директории Project. После вы-
полнения задания в этом же корне появляется папка, где сохраняются решение 
задачи.  
 

3.1. Установка опций 
 
       Установки проекта можно сделать отдельно для каждого проекта. Для это-
го в меню выбирается команды General Options, и другие опции, имеющиеся 
в меню HFSS.  В них можно установить единицы и другие параметры проекта. 
 
1. Для данного примера используйте параметры настройки, которые 

показываются на рис. 3.2, 3.3.  

  
Рис. 3.2. Опции проекта Рис. 3.3. Единицы проекта 

 
     В разделе Project Options (рис. 3.2) нужно выбрать пути нахождения 
проек-та, временных файлов (TEMP) и путь к библиотеке (Library Directory). 

 
     В меню View выберем команду Grid Setting… (рис. 3.4). 
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Рис. 3.4. Установка параметров сетки 

 
     В данном случае сетка будет идти через 30 пикселей, что задает такую 
точность привязки курсора при черчении. В этом диалоге задается также  
точность при черчении окружностей (для чего нужно нажать кнопку Polar) и 
установить точность угла в градусах.  
      Координаты объектов, из которых состоит проект, можно вводить, исполь-
зуя поля ввода координат в нижней части интерфейса HFSS.  Эти координаты 
могут быть введены в прямоугольной системе координат, цилиндрической 
системе координат и сферической системе координат.  Когда установлена пер-
вая точка, координаты будут вводиться по умолчанию как относительные.  В 
режиме Relative эти координаты не становятся больше абсолютными 
(измерен-ными от начальной точки координат в рабочей системе координат).   
   В поле ввода координат  Entry  можно вводить уравнения, которые будут 
использоваться для расчета координат.  Например, можно ввести  выражения 
2*5,   2+6+8,  2*cos(10*(pi/180)). Однако переменные нельзя вводить в поле 
координат «Entry Field». Переменные можно ввести в диалог, который появ-
ляется после окончания черчения объекта. 

                   
3.2. Черчение компонентов рупора 

   
     Основание рупора (рис. 3.5) - это параллелепипед с  шириной 0.4 дюйма, 
длиной 0.9 дюймов и высотой 0.315 дюймов. Оно чертится как трехмерный 
бокс, на сторонах которого устанавливаются граничные условия, отражающие 
его металлические свойства. 
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Рис. 3.5. Черчение основания  рупорной антенны 

 
    Чтобы начертить его, создайте трехмерный параллелепипед  и задайте его 
размеры. Для этого: 
  
1. В меню нажмите  команду Draw > Box.  Можно также нажать кнопку с 

изображением бокса на инструментальной линейке интерфейса (рис. 3.6). 
 

 
Рис. 3.6. Команды для черчения двумерных и трехмерных примитивов, из 

которых создается сложное устройство 
  
3. Нажмите первую точку в активном окне черчение. Затем протащите курсор 
и  щелкните мышью снова, чтобы задать противоположный угол бокса. 
Появляется диалог  шаблона бокса (рис. 3.8). 
4. Заполните шаблон и нажмите OK. База  антенны будет начерчена на экране. 
 
     Теперь на высоте 5.475in начертим прямоугольник, параллельный плос-
кости XoY. Это выполняется командой Draw->Rectangle. Параметры этого 
прямоугольника, расположенного на высоте «5.475 in» по оси z  показаны на 
рис. 3.7. 



 54

 

 
Рис. 3.7. Параметры параллелепипеда рупорной антенны 

 
    Черчение боковых стенок рупорной антенны выполняем по команде черче-
ния многополюсников Draw->Line, выбирая по очереди все углы скошенной 
стороны. 
    Последовательно, операцией Draw-> Polyline, по точкам, используя захват 
курсора к точкам прямоугольника раскрыва, начертим все четыре стороны 
пирамиды рупорной антенны (рис. 3.8), которые будут иметь нулевую толщи-
ну. 

 
Рис. 3.8. Вид  рупорной антенны 

 
     Далее установим бокс, который охватывает антенну со всех сторон, а со 
стороны порта совпадает с сечением порта антенны. Его параметры: 
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Рис. Рис. 3.9. Размеры бокса, охватываемого рупорную антенну 

 
    Теперь установим граничные условия на всех гранях антенны. Граничные 
условия можно задать сразу на трехмерный объект, а можно создавать его по 
отдельности на каждую сторону. Выделим все боковые стенки основания ру-
пора и расходящиеся стенки рупора и установим на них условие Perfect E. 
Возбуждение рупорной антенны выполняется установкой волноводного порта 
(рис. 3.10). Частота анализа 8 ГГц. 

 

Рис. 3.10.  Порт на входе рупорной 
антенны 

Рис. 3.11. Распределение 
электрического поля в сечении порта 

 
     После решения задачи, поле в сечении волноводного порта можно рассмот-
реть, открывая папку в дереве проекта. Эта картина (рис. 3.11) подтверждает, 
что волновод возбуждается волной H10.  
    Поскольку мы имеем дело с излучаемым объектом, границу  излучения,  
поверхность Radiate нужно максимально удалить от самой антенны. Тогда 
можно считать, что поле в дальней зоне тангенциально направленно к грани-
цам бокса излучения. В качестве границы излучения можно также использо-
вать сферу. 
    Для того, чтобы использовать поверхность излучения для расчета диаграм-
мы направленности в дальней зоне, необходимо в дереве проекта и папке 
Insert Far Field Setup задать команду Infinite Sphere… (рис. 3.12). 
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Рис. 3.12. Установки для использования границы излучения для расчета 

дальнего поля 
     Внесем параметры бесконечной сферы, на которой будут выбраны 
параметры точек, в которых будет рассчитываться дальнее поле.  
Это выполняется в диалоге рис. 3.13. 
 

 
Рис. 3.13. Диалог, в котором устанавливаются параметры расчета 

характеристик дальнего поля 
 
    В этом диалоге установим имя и параметры сферы, которая используется 
для расчета диаграммы направленности. 
 

3.3. Расчет характеристик рупорной антенны 
 
   Далее выполним установки для расчета антенны на одной частоте 8 ГГц, 
установки разбиения на ячейки оставим по умолчанию и выполним расчет. 
     После расчета, в разделе  Results в дереве проекта, можно вывести 
диаграмму направленности в дальней зоне. Для этого нажмите правой 
кнопкой мыши на Results и выберите характеристики антенны, указанные на  
рис. 3.14. 
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Рис. 3.14. Выбор типа рассчитанных характеристик: характеристики в 

дальнем поле, выводимые на трехмерную систему координат 
 

 
Рис. 3.15. Выбор выводимых характеристик дальнего поля: Направленность 

антенны в дБ 
 
 

 
 
 
     Кроме этого, на графики можно вывести следующие характеристики антен-
ны: направленность (Directivity), реализуемое усиление (Realized Gain), поля-
ризационное отношение, характеризующее степень круговой поляризации 
антенны Polarization Ration, отношение большой к малой оси поляризации-
онного эллипса Axial Ratio, а также параметры антенны: 
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Рис. 3.16. Трехмерная диаграмма 
направленности рупорной антенны. На 

ней видим, что  максимальная 
направленность равна  13.92 dB

Рис. 3.17. Параметры антенны 
 

 
       На рис. 3.17 видим следующие параметры антенны:  
Max U - максимальная интенсивность поля, излучаемая в направлении 
максимального излучения 1.9957 Ватт/стерадиан.  
Peak Directivity - пиковая направленность (КНД) D=23.665 = 13.74 dB. 
 
Total – максимальная напряженность поля в дальней зоне, для нашей антенны, 
равна 38.792 V. 
EX - компонента полного электрического поля, идущая вдоль оси X, равная 
38.791 V, достигаемая при Phi=360° и при Θ=0 град,  
EY – компонента полного электрического поля, равная 2.2462 V, достигаемая 
при азимутальном сдвиге 30° и угле места 150°, 
EZ -  компонента полного электрического поля, равная 9.14 V, достигаемая  
при углах 0 и 20°. 
    Далее в таблице рис. 3.17 выводятся компоненты электрического поля по ϕ 
и по θ, и при каких углах достигаются эти максимальные значения. 
 
    Параметры LHCP и RHCP – это характеристика левой и правой круговой 
поляризации для антенн, предназначенных для приема электромагнитной 
волны с круговой поляризацией. В этом случае поле может быть записано как 
E = (ER, EL) где: 
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( )φθ jEEER −=
2

1
   (3.1) 

( )φθ jEEEL +=
2

1
   (3.2) 

 
    Параметр Ludwig3/X  показывает отношение со-поляризованного поля к 
кросс-поляризованному полю для антенны, которая преобладающе излучает в 
направлении оси X. Параметр Ludwig3/Y показывает отношение со-
поляризованного  поля к кросс-поляризованным полям для антенны, которая 
преобладающе излучает в направлении оси Y. Эти характеристики можно 
вывести на трехмерный график. 
    Чтобы вывести диаграмму направленности какой-либо характеристики 
антенны  на полярную систему координат, нужно выбрать следующих опции: 

 
 

Рис.  3.18. Выбор опций для вывода характеристик дальнего поля на полярную 
диаграмму 

    Для того, чтобы построить угломестную диаграмму направленности, в 
качестве первичного параметра (Primery Sweep) необходимо выбрать угол 
Theta, а угол Phi установить, например, равным 0deg (рис. 3.19). 
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Рис. 3.19. Выбор параметров изменения углов для вывода угломестной 

диаграммы направленности 
    Угломестная диаграмма направленности (рис. 3.20) – это контур сечения 
трехмерной диаграммы направленности вертикальной плоскостью. 

 
Рис. 3.20. Угломестная диаграмма направленности рупорной антенны 
 
     Для вывода азимутальной диаграммы направленности, в качестве первич-
ной переменной выбираем Phi, а угол Theta зафиксируем равным 90deg. Тогда 
будем видеть (рис. 3.21), как рупорная антенна излучает в азимутальной 
плоскости. 
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Рис. 3.21. Азимутальная диаграмма направленности рупорной антенны для 

нескольких углов места 
 

3.4. Вывод ближнего поля в сечении антенны 
 
Очень важно просмотреть электромагнитное поле, в том числе 
анимированное, в сечениях антенны.  Выделим в разделе Planes  плоскость 
Global: YZ. Правой кнопкой мыши зададим команду Field  и на эту плоскость 
выведем модуль электрического поля (рис. 3.22). 
 

 
Рис. 3.22. Вывод модуля электрического поля Mag_E 
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Рис. 3.23. Электромагнитное поле, распространяющееся по рупорной 
антенне 

 
    Теперь можно выполнить анимацию поля. Чтобы видеть, как ближнее поле 
распространяется в центральной плоскости рупорной антенны, задайте коман-
ду View -> Field -> Animate.  
    Чтобы увидеть поле поперек распространения, создадим плоскость, 
параллельную оси z, или выделим любую плоскость на боксе излучения. 
Так например, можно выделить плоскость апертуры, которая была начерчена, 
но на неё не устанавливались граничные условия.  
     Это поле в сечении апертуры можно использовать для решения других 
задач, и считать, что излучает не рупорная антенна, а прямоугольник, на 
котором наводится заданное распределение поля (рис. 3.24). 
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Рис.  3.24. Вывод ближнего электрического поля в плоскости апертуры 
рупорной антенны 
 
    Ближнее поле можно вывести и в численном виде, создав сетку линий в 
раскрыве рупорной антенны и выводя значения характеристик поля в таблицу. 
     Далее создадим параллелограмм перед раскрывом антенны и будем 
считать, что антенна облучает слой диэлектрика с потерями (рис. 3.25). 
 

 
Рис. 3.25. Рупорная антенна и слой диэлектрика 
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Такая ситуация моделирует, например, облучение поверхности земли антен-
ной для поиска полезных ископаемых, или, например, вкраплений металла. 
Расчет коэффициента отражения при наличии металла или при отсутствии 
можно считать моделью миноискателя. 
 

3.5. Создание диэлектрического слоя 
с различными характеристиками 

 
    Создадим этот диэлектрический слой, на который падает электромагнитная 
волна рупорной антенны, командой Draw -> Box. Его параметры приведены в 
диалоге рис. 3.26. 
 

 
Рис.  3.26. Параметры бокса, моделирующего поглощаемый слой диэлектрика, 

на которую падает волна из рупорной антенны 
 
     Придадим материалу, заполняющему этот бокс материал, диэлектрическую 
проницаемость, которая меняется с частотой. Для этого в диалоге Propeties 
нажмем кнопку Material и войдем в базу данных материалов. 
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Рис. 3.27. Банк  материалов 

 
     Нажмем в этом диалоге кнопку Add Material, после чего появляется диалог 
создания нового материала (рис. 3.28). Допустим, что нам нужно создать мате-
риал, свойства которого зависят от частоты. 
 

 

Рис.  3.28. Выбор типа частотной зависимости свойств материала 
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   Нажмем в этом диалоге (рис.  3.28) кнопку Enter Frequency Dependence… и 
выберем кусочно-ломанную аппроксимацию Piecewise Linear Input (рис. 
3.30). 
 

 
Рис.  3.29. Пример задания частотной зависимости в виде кусочно-ломанной 
аппроксимации 
 
     Другая модель, Loss Model Input, в дополнение к кусочно-ломанной ап-
проксимации параметров, задает потери материла на низких частотах. 
 

3.6. Введение частотной зависимости по точкам данным 
 
     Допустим, что нужно описать характеристику материала в виде более 
сложной зависимости, например по точкам. Тогда выберем в диалоге рис. 3.28 
опцию Enter Frequency Dependent Data Points. 
 
    Когда Вы нажимаете OK , в диалоговом окне Frequency Dependent 
Material Setup,  появляется окно  Enter Frequency Dependent Data Points 
(рис. 3.30). 
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Рис. 3.30. Введение частотной зависимости с помощи данных 

 
      Оно  состоит из таблицы с четырьмя столбцами: 
 
•  Name Имя свойства материала.  
• Set Freq Dependent (установление частотной зависимости). Отметьте оп-
цию, чтобы указать, выражено ли свойство как частотно-зависимый набор 
данных. Если свойство не может быть установлено как частотно-зависимый 
набор данных, галочка снимается. 
• столбец Dataset: галочка снимается, если частотной зависимости не задается, 
или характеристика не может быть установлена в виде частотной зависимости. 
Когда открывается, появляется всплывающее меню со списком существующих 
наборов данных и возможностью добавления или импорта набора данных 
командой Add/ Import Data.... 
 
• Freq As: после того, как набор данных успешно импортирован или добавлен, 
имеются два доступные выбора: « X datapoint » или « Y datapoint ». Набор дан-
ных, в общем случае, может использоваться не только как частотная зависи-
мость, и зависимость от любого параметра. 
•Если Вы выбираете Add/Import dataset, появляется диалог Add Dataset (рис. 
3.31).  
       Он содержит поле Name для имени текущего набора данных, по умолча-
нию ds1. 
 



 68

 
 

Рис.  3.31. Диалог ввода функции по точкам 
 
    Нажатие на кнопку Import from File открывает окно выбора файла, в кото-
ром уже записан набор данных. 
  Столбцы в разделе Coordinates содержат текстовые поля X и Y, в которые 
можно вводить данные в точках. Величины, которые Вы прибавляете,  тут же  
показываются на графике  справа от таблицы. Вы можете также добавлять 
строки выше или ниже выбранной строки, удалять строки, или добавлять 
заданное число строк командой Append row…. 
   После того, как Вы задали и внесли точки данных, нажмите OK. Диалог 
Enter Frequency Data Points  покажет имя набора данных и частотные точки. 

 
3.7. Описание анизотропного материала 

 
     Анизотропный материал, это материал, характеристики которого меняются 
от направления в пространстве. Тензор относительной диэлектрической 
проницаемости для анизотропного материала имеет следующий вид: 
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где 

• 1ε - относительная диэлектрическая проницаемость материала по первой оси 
тензора (ось X), 

• 2ε - относительная диэлектрическая проницаемость по оси Y, 
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• 3ε - относительная диэлектрическая проницаемость по оси Z, 

• 0ε  - диэлектрическая проницаемость свободного пространства. 
 

Тензор диэлектрической проницаемости связывает вектора 
электрической индукции D и электрического поля Е: 
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Определите относительную диэлектрическую проницаемость для 

анизотропного материала, вводя значения 1ε , 2ε , и 3ε  в поля T (1,1), T 
(2,2), и T (3,3), рис. 3.34. Эти значения могут также быть введены как 
переменные. 
 

1. В разделе Relative Permeability окна View/Edit Material выберите 
Anisotropic из выплывающего меню Type. Три строки T(1,1), T(2,2) и T(3,3) 
добавляются вместо строки Relative Permeability. 

2. Введите относительную диэлектрическую проницаемость вдоль первой оси 
X как тензор материала в бокс  Value в строку T(1,1). 

3. Введите относительную диэлектрическую проницаемость вдоль второй оси 
Y в бокс Value в строку T(2,2). 

4. Введите относительную диэлектрическую проницаемость вдоль третьей оси 
Z в бокс Value в строку  T(3,3). 

    Если относительная диэлектрическая проницаемость равна по всем направ-
лениям, вводятся одинаковые величины.  Эти величины могут быть также 
переменными. 
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Рис. 3.32. Установка 
анизотропных свойств 
материалов  

Рис. 3.33. Появление в таблице  
величин T(1,1), T(2,2), T(3,3) 

 
3.8. Тензоры относительной магнитной проницаемости 

анизотропного материала 
 
       Тензор относительной магнитной проницаемости для анизотропного 
материала имеет следующий вид: 
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 где 
• µ1 - относительная магнитная проницаемость по первой оси X. 
• µ2 - относительная магнитная проницаемость по второй оси Y. 
• µ3 - относительная магнитная проницаемость по третьей оси Z. 
• µ0 – магнитная проницаемость свободного пространства. 

 
     Тензор магнитной проницаемости связывает вектора магнитного поля H  и 
магнитной индукции B: 
 

[ ]
⎥
⎥
⎥

⎦

⎤

⎢
⎢
⎢

⎣

⎡
=

⎥
⎥
⎥

⎦

⎤

⎢
⎢
⎢

⎣

⎡

z

y

x

z

y

x

H
H
H

B
B
B

μ     ( 3.6) 

 
     Чтобы определить относительную проницаемость для анизотропного 
материала, введите µ1, µ2, и µ3 значения в полях Value     T (1,1), T (2,2), и T 
(3,3), соответственно (рис. 3.33). Если относительная магнитная 
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проницаемость – одна и та же во всех направлениях, используются равные  
значения для µ1, µ2, и µ3.  
 

3.9. Задание нелинейных свойств материалов 
 
      В HFSS имеется возможность описания нелинейных свойств  материала, 
например, феррита. 

 
Рис. 3.34. Диалог задания нелинейных свойств материала 

 
      Для этого нужно выбрать опцию Nonlinear в диалоге задания свойств 
нового материала (рис. 3.34), и по точкам вести зависимость B(H), в диалоге, 
показанном на рис. 3.35. 
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Рис.  3.35. Введение по точкам зависимости B(H) ферритового материла 
 
    Задание ферритового материала используется при расчете циркуляторов и 
вентилей. 

3.10. Падение электромагнитной волны оптического 
диапазона на материал с отрицательной диэлектрической 

проницаемостью 
 

       Известно, что длины световых волн расположены в районе 1 микрона. 
Начертим рупорную антенну с поперечным размером 0.6 микрон и возбудим 
ее волноводным портом.  Частота анализа 300 THz находится в инфракрасном 
диапазоне волн. 

 
Рис. 3.36. Падение излучаемой из рупорной антенны электромагнитной волны 
на диэлектрический  слой 
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    Начертим базу рупорной антенны с размерами 0.4 x  0.6 микрон (рис. 3.38), 
в сечении которого будет задан волноводный порт. 
 

 
Рис. 3.37. Параметры базы рупорной антенны (стенки идеально проводящие). 

По Y – полдлины волны. Единицы измерения um (микрон) 
 

     А затем начертим раскрыв рупора, вершины которого соединяем с верши-
нами базы с помощью операции Draw -> Line. На эти наклонные плоскости 
задаем граничные условия Perfect E. 

 
Рис. 3.38. Параметры прямоугольника – раскрыва рупорной антенны 

 
         Затем начертим бокс излучения размером 1.6 uм x 1.8 uм x 4 uм. 

 
    Для того чтобы вывести интенсивность поля в пространстве излучения ан-
тенны,  и видеть, как эта интенсивность, а также фаза компоненты электри-
ческого поля меняются при падении поля на диэлектрическую плату, с 
помощи команды Draw -> Line построим прямую линию (рис. 3.39), вдоль 
которой будем выводить модули и фазы составляющих поля. 
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Рис. 3.39. Точки линии, вдоль которой выводится ближнее поле 

 
      Диэлектрическая пластина, на которую падает электромагнитное поле, и 
которая обладает определенной диэлектрической проницаемостью, имеет раз-
меры, показанные на рис. 3.40. 

 
Рис. 3.40. Параметры диэлектрической пластины 

 
   Распределение модуля поля E вдоль линии, идущей от начала антенны и 
через  диэлектрический слой, выводится как ближнее поле и показано на рис. 
3.41. 

 
Рис. 3.41. Распределение поля вдоль оси Z и график компоненты  
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Рис. 3.42. Фаза компоненты Ex при падении поля на диэлектрическую 
пластину с проницаемостью 10 
     
   Теперь решим ту же задачу, но вместо рупорной антенны зададим в прост-
ранстве планарную волну, падающую на диэлектрическую пластину. 
Падающая волна создается командой Assign Axcitation -> Incident Wave -> 
Plane Wave. Появляется диалоговое окно рис. 3.43, в котором нужно ввести 
координаты центра и направление падения на структуру плоской волны. 
 

 
Рис. 3.43. Координаты падающей планарной волны 

 
     После выполнения решения выведем поле в сечении плоскостиYoZ. Затем  
зададим команду Edit Sources. В появившемся диалоге редактирования источ-
ников можно видеть три радиокнопки Incident Waves:  Scattered Fields (выбор 
которой показан на рис. 3.44), Total Fields (рис. 3.45), Incident Fields (рис. 3.46).  
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Рис. 3.44. Рассеиваемое поле в сечении бокса анализа 

 
Рис.  3.45. Падающая волна представляет  Общее поле 

           
При выборе источника в виде падающей волны расчет выполняется 
значительно быстрее, чем при полном моделировании вместе с рупорной 
антенной.  В случае с отрицательной диэлектрической проницаемостью поле 
за пластиной значительно слабее. Картина фаз также другая.  Этот расчетный 
эксперимент показывает, как  HFSS учитывает отрицательную проницаемость 
материала.  

 
Рис. 3.46. Установка падающего поля в диалоге редактирования источников и 
вид поля в плоскости  
     Итак, в этом разделе мы начертили рупорную антенну, выполнили ее ана-
лиз, вывели рассчитанные характеристики. Затем перед антенной был постав-
лен слой диэлектрики, и было показано, как описать разнообразные свойства 
материала этого слоя. В следующем разделе будет продолжен анализ этой 
конструкции. 
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4. Расчет характеристик ближнего поля  
 
        
     Задачи, связанные с антеннами и излучающими структурами, требуют 
больших вычислительных ресурсов. Чтобы уменьшить объем задачи, можно 
запоминать промежуточные результаты расчета одной части задачи и ис-
пользовать их на следующем этапе. 
      Например, используем поле в раскрыве рупорной антенны для формули-
рования другой задачи облучения диэлектрического слоя. Выделим плоскость 
апертуры, соответствующую этому раскрыву и выведем на него вид поля E 
Field. Получаем вид поля, показанный на рис. 4.1. 

 

Рис.  4.1. Рупорная антенна и 
векторное поле в раскрыве 
рупорной антенны 

Рис.  4.2. Векторы электри-
ческого поля при определенной 
фазе источника возбуждения

 
     Вид поля, полученный в сечении апертуры, может подсказать проекти-
ровщику, как изменить проект, чтобы получить нужную направленность 
антенны в ближнем и дальнем поле. 

              
Рис. 4.3. Вид распространяющегося поля внутри рупорной антенны с двух 
перпендикулярных точек зрения. Можно видеть сферичность 
распространения волны, а также дифракцию ее на крае антенны 
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     Если установить курсор мыши в прямоугольник, на котором отражается 
масштаб выводимого поля, то, нажав на правую кнопку мыши, можно улуч-
шить вид поля, установив границы максимального и минимального поля, а 
также перевести цветопередачу (рис. 4.3) в логарифмический масштаб. 
       При расчете рупорной антенны пространство было разбито на 13743 
тетраэдров, в результате анализа коэффициента отражения от входа получе-
но: S11=0.0709   ∠ 97.3°, что можно считать хорошим согласованием рупор-
ной антенны с генератором, подводящем мощность. Порядок вывода 
диаграммы направленности был показан в предыдущем разделе. 
     Для вывода ближнего поля, нужно задать линию или сферу заданного ди-
аметра (отметим, что в плоскость значения ближнего поля не выводятся). В 
разделе полей необходимо задать эту линию, или сферу, заранее созданную 
(рис. 4.4). Начертим сферу радиусом 5.7 in, которая касается края рупорной 
антенны и расположена над апертурой. 

 
 

Рис. 4.4. Внесение сферы, на которую будет выводиться ближнее поле 
 

   Теперь на этой сфере нужно задать сетку, в узлах которой будут выводиться 
значения электрического и магнитного поля (рис. 4.5). 

 
Рис.  4.5. Задание параметров сферы, на которую будет выводиться ближнее 

поле 
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    После выполнения расчета,  можно вывести  результаты ближнего поля на 
эту окружность, в виде графика или в таблицу.  Выберем таблицу (рис. 4.6). 

 
Рис. 4.6.  Вывод параметров ближнего поля в таблицу 

 
     Нажмем на OK и в диалоге характеристик (рис. 4.7) выберем ближнее 
электрическое поле Near E. 

 
Рис. 4.7. Выбор параметра ближнего поля 

 
    Чтобы правильно выбрать зависимые параметры, нужно выбрать в качестве 
Primary Sweep параметр, идущий по первой строке таблицы, а именно угол θ 
(рис. 4.8). 
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Рис. 4.8. Установка первичных и вторичных параметров для создания 
трехмерного и двумерных графиков 
 
    В результате получаем таблицу (рис. 4.9), которую можно запомнить в виде 
файла. 

 

Рис. 4.9. Ближнее поле, выведенное в таблицу при различных азимутальных 
углах и на расстоянии 5.7 in  от центра входного волновода рупорной 
антенны 

 
4.1. Вывод ближнего поля в точках пространства вдоль 

линии 
 
      Чтобы вывести значение ближнего поля вдоль какой-либо линии в прост-
ранстве, нужно эту линию начертить  до расчета. Например, начертим линию, 
идущую вдоль оси Z, командой Draw->Line. Введем две точки (0,0,0)  и 
(0,0,10). 
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Рис. 4.10. Координаты точек, которые задают прямую линию, коллинеарную 

оси Z 
 
     Теперь нужно добавить эту линию в папку Radiation для расчета ближнего 
поля командой Insert Near Field Setup.  Появляется диалог (рис. 4.11). 
 

 
 
Рис. 4.11. Параметры линии, вдоль которой выводятся параметры ближнего 
поля 
      
   Выведем ближнее поле на прямоугольный график вдоль этой линии. Имя 
линии Line1 устанавливается впоследствии в разделе Geometry блока Context 
(рис. 4.12), когда мы задаем вывод ближнего поля командой Results ->Create -> 
Reports и выбором опции Near Fields. 
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Рис. 4.12.  Выбор параметров ближнего поля для вывода их вдоль линии 
 
    В диалоге Traces можно выбрать различные компоненты ближнего поля 
вдоль линии Line1. Выберем суммарное значение ближнего поля NearETotal 
(рис. 4.12). Значение ближнего поля будет выведено на график относительно 
нормализованного расстояния (рис. 4.13). 
 

 
Рис. 4.13. График суммарного  ближнего поля вдоль линии 
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     Кроме графика, ближнее поле можно вывести в виде таблицы. Для этого 
выбираем опцию Data Table и выбираем характеристики ближнего поля в 
диалоге Traces (рис. 4.14). 

 
Рис.  4.14. Выбор характеристик данных ближнего поля вдоль линии 

 
     Добавление в таблицу модулей и углов значений ближнего поля дает 
полную информацию о ближнем поле вдоль линии (рис. 4.15). 
 

 
Рис.  4.15. Таблица вывода ближнего поля  вдоль линии 
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4.2. Возбуждение структуры планарной волной 
 

      
    HFSS может использовать решения, полученных в других задачах, как 
исходные данные для нового моделирования.  Это новое моделирование 
может быть выполнено в HFSS, а также в других программа, например в 
SIWAVE или в Maxwell3D. Некоторые примеры:  
 
1. Детальная и оптимизированная конструкция сотового телефона, излучаю-
щего в большом пространстве (HFSS-HFSS),  
 
2. Сложная печатная плата, вызывающая проблемы электромагнитной сов-
местимости внутри и вокруг корпуса (SIWAVE - HFSS), 
 
3. В структуре присутствует электромеханическая компонента, создающая 
проблемы электромагнитной совместимости / электромагнитных шумов в 
транспортном средстве (Maxwell3D - HFSS).  
 
    Во всех случаях, излучаемые поля от “исходного” проекта наложены как 
падающая волна в “целевом” проекте. 
    Эти излучаемые поля могут оба быть и полями в дальней зоне и ближними 
полями, в зависимости от  вашей задачи.  
     В “целевом” проекте, они определены через Incident Wave / Far Field 
Wave  и Incident Wave / Near-Field Wave.  
    Итак, должна быть установлена связь (link) к “исходному (Source)” проекту. 
Также, в “целевом (target)” проекте, должны быть заданы границы излучения с 
дополнительными (Advanced Options) параметрами,  чтобы определить, где 
поля от “исходного” проекта вводятся “целевой” проект. 
 
   В предыдущей задаче удалим рупорную антенну, а оставшееся простран-
ство будем использовать для анализа падения поля на диэлектрический слой с 
различными параметрами. Будем считать, что поле в пространстве бокса (рис. 
4.16) возбуждается какой либо уже существующей антенной. 
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Рис. 4.16. Возбуждение планарной волной диэлектрического слоя  

 
     Нажмем правой кнопкой мыши, удерживая ее в области бокса (рис. 4.16) и 
выделим команду установки возбуждения планарной волной. Появляется 
диалог Incident Wave Source, в котором можно установить параметры пада-
ющей волны: ее поляризацию (вектор Eo) и направление распространения 
(вектор k). 
 

 
Рис. 4.17. Установка начала координат для задания плоской волны 

 
     Направление распространения можно изменить в диалоговом окне, выводи-
мом после создания плоской волны (рис. 4.18). 
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Рис. 4.18. Задания вектора поляризации и вектора направления 
распространения планарной волны 

 
   После установки планарной волны, которая примерно соответствует ре-
зультатам излучения рупорной антенны, запустим расчет, устанавливая 
частоту 8 ГГц. 

 
Рис. 4.19.  Волны распространяются от слоя диэлектрика. 

 
    В данном случае (рис. 4.19) HFSS выводит отраженные волны. 
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      Падающая плоская волна - это волна, распространяющаяся в одном на-
правлении, однородная в направлении, перпендикулярном направлению 
распространения. Угол, под которым волна падает на устройство, известен как 
угол падения. Уравнение, которое использует HFSS , чтобы вычислить 
падающую волну, имеет вид 

)ˆ(
0

0 rkjk
inc eEE ⋅−= , 

где 

Einc  - падающая волна, 

E0  - вектор E-поля с заданной поляризацией, 
ko - волновое число свободного пространства. Оно равно  00εμω , 
k - вектор распространения волны, 
r  - положение вектора в пространстве. 

     Возбуждение падающей  волны оценивается максимальным значением.  
Так, например, если величина падающей волны равна  5 V/m, то функция E – 
поля во временном виде записывается как 

                                   )cos(5)( trktE ω+⋅= . 

 . 

4.3. Возбуждение диполем Герца 
 

    Падающая волна диполя Герца Hertzian-Dipole модулирует поле элемен-
тарной короткой дипольной антенны, помещенной в начале координат.  
    Диполь Герца – это направленный источник тока, с размером, намного 
меньше длины волны. 

 
Рис. 4.20. Расположение диполя Герца, излучение которого падает на слой 

диэлектрика. 
     Для задания диполя Герца: 
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1. Задайте команду HFSS>Excitations>Assign>Incident Wave>Hertzian-
Dipole Wave. Появляется диалог Incident Wave Source: General Data (рис. 4.21). 

2. Выберите имя источника в боксе Name. 

3. Выберите в разделе Vector Input Format  координаты  Cartesian или 
Spherical. 

4. Введите координаты X-, Y-, и Z точки возбуждения падающей волны  
Excitation Location and/or Zero Phase Position. 

5. Кликните Далее>. 

 
Рис.  4.21. Направление диполя возбуждения на угол 45 градусов 

6. Если вы выбрали Cartesian, появляется диалог Incident Wave Source: 
Cartesian Vector Setup (рис. 4.21). В нем вводятся компоненты X-, Y-, и Z для 
вектора  тока I*Dipole Length, где  I  - амплитуда тока (пиковое значение) в 
ампер-метрах (A*m). Будет задана только падающая волна.  

7. Если вы выбрали Spherical, появляется диалог Incident Wave Source: 
Spherical Vector Setup. 

a. В разделе  IWavePhi, введите следующие данные: 

Start  Начальная точка вращения  φ. 

Stop Точка, в которой вращение φ заканчивается. 

Points Число точек при изменении φ.  

     Кликните View Point List чтобы видеть величины φ. 

b. В разделе  IWaveTheta, введите величины  Start, Stop, и Points. Кликните 
View Point List, чтобы видеть величины  θ. 
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c. Введите компоненты  φ и θ вектора  I*Dipole Length в боксы Phi и Theta .  

 
Рис.  4.22. Поле в сечении пространства анализа при возбуждении диполем 

Герца 
   В каждой точке сетки, падающая волна представляется  как бегущая от 
точки начала координат. Число падающих волн и точек сетки может быть 
рассчитано умножением числа точек φ  на число точек θ. Отметим, что только 
один угол падения падающей волны может быть определен для 
периодической структуры, которая задана границами master и slave. 

 8. Кликните Next. Появляется диалог Incident Wave Source: Hertzian-Dipole 
Wave Options. 

9. Выберите радиус окружности Radius of Surrounding Sphere. Внутри этой 
сферы, величина поля будет равна полю на поверхности сферы.  Чтобы 
использовать значение по умолчанию (10 mm), кликните кнопку Use Defaults. 
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Рис. 4.23. Диаграмма направленности излучения диполя Герца  

 

10. Кликните Finish. Падающая волна, которую вы задали, будет добавлена в 
список Excitations в дереве проекта. 
 

4.4. Возбуждение структуры цилиндрической волной 
 
      Падающая цилиндрическая волна (Incident Cylindrical Wave) - это волна, 
которая моделирует дальнее поле бесконечной линии тока, расположенной в 
начале координат. Для создания такой волны: 
1. Кликните HFSS>Excitations>Assign>Incident Wave>Cylindrical Wave.  

     Появляется диалог Incident Wave Source: General Data. 

2. Выберите Vector Input Format как Cartesian или Spherical координаты.  

3.  Введите координаты  X-, Y-, и Z начала координат падающей волны 
Excitation Location and/or Zero Phase Position. 

4. Если вы выбрали Cartesian, появляется диалог Incident Wave Source: 
Cartesian Vector Setup. Введите компоненты  X-, Y-, и Z  как  I Vector в 
боксы  X, Y, и Z. I  - это амплитуда тока (пиковое значение). Единицы в 
амперах (A). 

5.  Если вы выбрали Spherical, появляется диалог Incident Wave Source: 
Spherical Vector Setup. 

a. В разделе IWavePhi, ведите следующее: 

Start Точка, где начинается вращение φ. 
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     Stop Точка окончания вращения  φ. 

   Points  Число точек свипирования φ.  

    Кликните View Point List чтобы видеть величины φ. 

b. В разделе  IwaveTheta  введите величины Start, Stop, и Points. Кликните 
View Point List, чтобы увидеть величины  θ. 

c. Введите компоненты φ и θ вектора I Vector в поля  Phi и Theta. I – это 
амплитуда тока (пиковое значение), в амперах (A). 

      Сферическая сетка создается, когда угол θ изменяется через каждую точку 
φ. В каждой точке сетки, падающая волна представляется как волна, распро-
страняющаяся в направлении системы координат расчета. Число падающих 
волн и точек сетки может быть рассчитано, умножая число точек  φ на число 
точек θ. 
 

  

Рис. 4.24. Установка начала 
координат цилиндрического 
источника 

Рис. 4.25.  Задание вектора 
IVector падающей 
цилиндрической волны 

 
 

6. Кликните Next. Появляется диалог Incident Wave Source: Cylindrical Wave 
Options (рис. 4.26). 

7. Выберите Radius of Surrounding Cylinder. Внутри цилиндра, величина 
поля будет рассчитана на поверхности цилиндра. Чтобы выбрать величину по 
умолчанию (10 mm), кликните кнопку Use Defaults. 

8. Кликните Finish.  Падающая волна добавляется в список Excitations. 
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Рис. 4.26. Задание радиуса окружающего цилиндра 

     
    Внутри этого цилиндра, величина поля будет равна величине поля на по-
верхности внутреннего цилиндра. 

 
4.5. Источник излучения в виде падающего луча 

 

      Падающая волна Gaussian Beam – это волна, которая распространяется в 
одном направлении и имеет распределение Гаусса в направлении, перпен-
дикулярном направлению распространения. Для возбуждения такой волны в 
пространстве анализа: 

1. Кликните HFSS>Excitations>Assign>Incident Wave>Gaussian Beam.  

    Появляется страница  Incident Wave Source: General Data. 

2. Выберите  Vector Input Format как Cartesian или Spherical. 

3. Введите координаты X-, Y-, и Z для начала падающей волны Excitation    
Location and/or Zero Phase Position, в котором имеет место нулевая фаза. 

4. Если вы выбрали Cartesian, появляется диалог Incident Wave Source: 
Cartesian Vector Setup. Задайте вектор распространения , k, и вектор поляри-
зации E-поля, E0,  для чего: 

a. введите компоненты X-, Y-, и Z для вектора  k vector (рис. 4.28).  

b. введите координаты  для вектора  E0 vector в поля  X, Y, и Z.  

   Будет задана простая падающая волна.  При вводе вектора распространения 
k, и вектора поляризации E-поля, E0, используя прямоугольную систему 
координат, выполните следующие правила: 
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• Для определения падающей волны, распространяющейся в направле- 
             нии z, введите (0, 0, 1) как координаты вектора k vector. 

• Модуль вектора E0 не может быть равен нулю. 

• k  должен быть ортогональным к  E0. 

5. Если вы выбрали Spherical, появляется диалог Incident Wave Source: 
Spherical Vector Setup. 

a. В разделе IWavePhi, введите следующее: 

Start Точка, где начинается вращение φ. 

Stop Точка, где вращение  φ заканчивается. 

Points Число точек свипирования φ.  

    Кликните View Point List чтобы видеть величины φ. 

b. В разделе  IWaveTheta, введите величины для Start, Stop, и Points.  

     Кликните View Point List чтобы увидеть величины  θ. 

c.  Введите компоненты  φ и θ   E0 в боксы  Phi и Theta. 

    В каждой точке сетки, падающая волна представляется как распро-
страняющаяся вдоль системы координат. Число падающих волн и точек сетки 
может быть рассчитано умножением точек φ на количество точек  θ. Заметим, 
что только один угол падающей волны может быть определен для 
периодической структуры, когда задаются границы  master и slave. 

 6. Кликните Next. Появляется диалог  Incident Wave Source: Gaussian Beam 
Options.  

7. Выберите Beam Width at Focal Point. По умолчанию (10 mm), кликните 
кнопку Use Defaults. 

8. Кликните Finish. Падающая волна, которую вы определили, добавляется в 
список Excitations в Project. 
    Для создания такого источника не нужно задавать поверхность. Нажимаем 
правой кнопкой мыши и выбираем граничное условие в виде падающей 
волны. Выбираем Beam (луч). 
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Рис.  4.27. Первая страница задания луча в виде падающей волны 

 

 
 

Рис. 4.28. Задание вектора 
волны поляризации и 
направления излучения (вектор 
k) 

Рис. 4.29. Установка ширины 
луча падающей волны  

 

4.6. Возбуждение волной линейной антенны 
 

   Падающая волна линейной антенны (Incident Linear Antenna Wave) - это 
волна, которая моделирует дальнее поле линейной антенны, расположенной в 
начале координат. Для создания такой падающей волны в пространстве 
анализа: 
1.Кликните HFSS>Excitations>Assign>Incident Wave>Linear Antenna Wave. 
Появляется страница Incident Wave Source: General Data. 

2. Напечатайте имя источника в боксе Name или оставить имя по умолчанию. 

3. Введите Vector Input Format как координаты  Cartesian или Spherical. 
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4. Введите координаты  X-, Y-, и Z точки возбуждения падающей волны 
Excitation Location and/or Zero Phase Position. Кликните Next. 

5. Если вы выбрали  Cartesian, появляется Incident Wave Source: Cartesian 
Vector Setup. Введите компоненты  X-, Y-, и Z- для  I Vector в боксы  X, Y, и 
Z.  I  - это амплитуда тока антенны (пиковое значение), в амперах (A). 

6. Если выбрана сферическая система координат Spherical, появляется диа-лог 
Incident Wave Source: Spherical Vector Setup. 

a. В разделе IWavePhi, введите следующее: 

Start Точка, где начинается угол φ. 

Stop Точка конечной точки угла φ. 

Points Число точек свипирования φ.  

     Кликните View Point List, чтобы видеть величины φ. 

b. В разделе  IWaveTheta, ведите величины  Start, Stop, и Points.  

    Кликните View Point List, чтобы видеть величины θ. 

c. Введите компоненты φ и θ вектора I Vector в боксы  Phi и Theta. I – 
это амплитуда тока антенны в амперах (A). Отметим, что только один угол па-
дающей волны может быть определен для периодической структуры при 
определении границ master и slave. 

7. Кликните  Next. Появляется диалог  Incident Wave Source: Linear Antenna 
Wave Options.  

8. Выберите длину антенны (Length of the Antenna). 

9. Выберите  радиус окружающего цилиндра (Radius of Surrounding 
Cylinder). Внутри этого цилиндра, величина поля будет равна величине поля 
на поверхности цилиндра.  

10. Чтобы установить значение по умолчанию (10 mm), кликните кнопку Use 
Defaults. 

11. Кликните Finish. Падающая волна, которую вы определили, будет 
добавлена в список Excitations. 
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Рис. 4.30. Первый шаг установки 
линейной волны: выбор начала 
координат 

Рис. 4.31. Установка  вектора 
возбуждения IVector падающей  
плоской волны

 
 
Рис. 4.32. Установка длины антенны и радиуса окружающего цилиндра. 
Внутри цилиндра, модуль поля будет равен модулю поля рассчитанного на 
поверхности цилиндра 
 
     В следующем разделе мы покажем, как использовать расчеты ближнего и 
дальнего поля в одной задаче для подстановки этих данных в качестве нового 
источника излучения. 
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5. Использование решений поля в других задачах 
      

      Рассмотрим падение электромагнитных волн, излучаемых рупорной 
антенной, на диэлектрический слой.  Альтернативой излучения этой антенны в 
пространства были источники возбуждения  в виде падающих волн (раздел 4).   

     Мы уже рассмотрели использование пяти типов падающих волн на струк-
туру. Теперь рассмотрим оставшиеся в списке возбуждений (рис. 5.1) следу-
ющие типы волн: 

Far Field Wave… (волны дальнего поля) 

Near Field Wave… (волны ближнего поля). 

      Эти режимы позволяют связать решения одной задачи и другой, т.е. полу-
чив дальнее поле в одной задаче, использовать его для расчета поля в другой 
задаче. 

 

Рис. 5.1. Опции падающих волн в HFSS 

    HFSS может использовать полученное решение в дальнем или ближнем 
поле  в одной задаче и создать на их основе источники поля для нового мо-
делирования. Это новое моделирование можно выполнить в программах 
HFSS, SIWAVE или Maxwell3D. В качестве практических примеров задач, 
когда можно использовать та-кую стратегию расчета, можно назвать: 
 
(1) Детальное проектирование сотового телефона внутри корпуса и затем 

использование рассчитанного поля вокруг него, как источник излучения в 
большей окружающей среде (HFSS-HFSS);  

(2)  сложная плата печатной схемы, приводящая к задачам электромагнитной 
совместимости внутри и вокруг корпуса (программы SIWAVE - HFSS);  

(3)  учет работы электромеханических движущихся деталей (программы 
Maxwell3D - HFSS).  
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      Во всех случаях, излучаемые поля из «исходного» проекта становятся 
падающими волнами в «целевом» проекте. 

 
     Эти излучаемые поля могут и дальними полями и ближними полями, в 
зависимости от конкретной ситуации. В «целевом» проекте, они могут быть 
определены через падающие волны Incident Wave / Far Field Wave и Incident 
Wave / Near-Field Wave:  
 
    Для того чтобы связать эти поля, необходимо в целевом проекте (target) 
установить границу излучения Radiate с расширенной опцией, для того, чтобы 
задать поля исходного (source) проекта, вводимые в целевой проект. 
 
       
 
 

5.1. Назначение опций границ излучения 
 
 
     Граница излучения Radiation Boundary  используется в антенных задачах, 
в которой волны излучаются бесконечно далеко в пространство. HFSS погло-
щает волну на границе излучения, по существу отодвигая границу бесконечно 
далеко из структуры.  

 
Рис. 5.2. Рупорная антенна светит на слой диэлектрика. В такой задаче 
нужно установить границу излучения вокруг рупорной антенны, на ней 
рассчитать поле, а потом использовать его при облучении слоя диэлектрика 
     
   Поверхность излучения не обязательно должна быть сферическая, но она 
должна быть выпуклой относительно источника излучения, и отстоять по 
крайней мере на расстоянии четверти длины волны  от источника излучения. 
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       В некоторых случаях граница излучения может быть размещена ближе, 
чем на четверть длины волны, от тех частей, где ожидается небольшая энергия 
излучения. Рассмотрим предыдущую задачу облучения рупорной антенной 
слоя диэлектрика. Только уберем саму антенну, а вместо неё будем 
использовать связь по ближнему полю. 
 

5.2. Волны дальнего поля 
 
     Рассмотрим область, в которой был установлена рупорная антенна (рис. 
5.3) и уберем диэлектрическую плату, на которую падает волна. Поверхность 
излучения установим как падающую волну: 
 

 
Рис.5.3.Рупорная антенна без диэлектрической платы 
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Рис. 5.4. Бокс излучения, 
охватываемый антенну 

 

Рис. 5.5. Дальнее поле рупорной антенны 
без диэлектрической платы 

 
 

     Теперь рассмотрим проект, в котором находится диэлектрическая плата. 
Т.е. это целевой (target) проект без рупорной антенны. Пространство в новом 
проекте сделаем так, чтобы оно было больше, чем в первоначальном. В этом 
проекте не будет явных источников.  
 
1. Нажмите HFSS>Excitations>Assign>Near Field Wave. Появляется страни-
ца источника падающей волны Incident Wave Source:General Data. 
 

 
 
Рис. 5.6. Описание возбуждения как падающей волны ближнего поля 
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Рис. 5.7. Первая страница установки источника поля в дальней зоне: выбор 

имени и смещение начала координат 
 
2. Введите имя источника в текстовом блоке Name или оставьте его по 
умолчанию. 
     Если система координат, которую Вы используете в исходном проекте 
(проекте, с которым Вы связываетесь) отличается от системы координат в 
целевом проекте (проект, в котором Вы создаете связь), нужно задать связь 
между этими системами координат. Связь между двумя системами координат 
задается как смещение и вращение. Перенос состоит из смещения между 
началами из двух систем координат, и вращения, определенного с помощью 
углов. 
3. Введите координаты X -, Y -, и Z Excitation Location and/or Zero Phase 
Position (начало координат для падающей волны). Это показывает перенос 
начала исходного проекта относительно начала координат целевого проекта. 
    Например, если начало координат исходного проекта находится в начале 
координат целевого проекта  в (-2, -2, 1), то смещение между двумя система-
ми координат равно вектору (-2, -2, 1). 
 
4. Щелкните Next. Появляется страница (рис. 5.8), которая содержит кнопку 
Setup Link, чтобы просмотреть источник поля и связать ориентации 
исходного и целевого проектов.  
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Рис. 5.8. Страница выбора опций связи источника с дальним полем 

5. Чтобы задать источник поля, нажмите кнопку Setup Link. 
Появится окно (рис. 5.9), в котором в закладке General имеются строки: 
Project File, Design, и Solution . 

 
Рис. 5.9. Первая страница описания источника, используемого в виде поля в 
дальней зоне 
 
6. Задайте файл проекта, который является источником поля в дальней зоне.  
Кнопка просмотра [...] позволяет найти нужный файл в системе. Если Вы не 
задаете файл проекта, а выбираете текущую модель, автоматически заполня-
ется файл текущего проекта. Мы зададим предыдущий проект (рис. 5.16). 
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Рис. 5.10. Первая страница после заполнения 

 
7. Выберите проект, в котором рассчитывается источник волны в дальнем 
поле. Если эта конструкция находится в текущем проекте (т.е. в проекте 
находится несколько конструкций), Вы можете выбирать ее из выплыва-
ющего меню. Если Вы выбираете текущую модель, файл Project File запол-
няется автоматически. 
 
8. Точно задайте Solution (решение), которое нужно использовать. Выплыва-
ющее меню позволит сделать выбор из доступных решений. 
 
9. Чтобы просматривать конфигурацию внешней связи поля (External Field 
Link) и параметры, выберите каждую закладку. В закладке External Field Link 
configuration нужно установить амплитуду возбуждения и фазу источника 
проекта. В закладке Parameters вы можете установить нужно величины 
переменных в исходном проекте. 

 
Рис. 5.11. Параметры связи проектов 

 
10. Нажмите OK, чтобы закрыть окно HFSS и вернуться к окну Incident Wave 
Source. 
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11. Вы можете определять вращение системы координат источника относи-
тельно системы координат цели с помощью углов φ и θ.  Подобно преобра-
зованию, эти углы задают вращения, которым должен подвергнуться  ис-
ходный проект, чтобы выровняться с системой координат целевого проекта. 
Введите углы с единицами в полях, используя опускающиеся меню: 

• Phi (вращение относительно Z-оси). 
• Тета (вращение относительно оси X) 
• Psi (вращение относительно смещённой Z-оси). 

 

12. Кликните Finish для закрытия диалога. 

     Точка волны источника ближнего поля Near Field и её направление высве-
чивается в окне моделирования и в списке Excitations в дереве проекта по-
является волна. 

 -Поскольку здесь существует падающая волна ближнего поля, вы должны ус-
тановить, по крайней мере, одну границу излучения для падающего (incident) 
или фиксированного (enforced) поля. 

 

Рис. 5.12. Установка границы излучения как падающего поля на одну сторону 
бокса 

     Остальные 5 сторон можно установить как обычные границы излучения, с 
помощью которых рассчитывается дальнее поле. 

 

5.3. Объединение решений 
    При внесении решения в новую задачу,  HFSS выполняет последовательно 
обращение к исходному и целевому проекту, рассчитывает и связывает поля, и 
выводит в результате поле  
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Рис. 5.13. Распространение волны в сечении большого бокса, которая возбуж-
дается с помощью  решения, полученное в малом боксе как значения дальнего 

поля 

 

Рис.5.14. Дальнее поле целевого проекта 

     Итак, в данном разделе мы рассмотрели задачу возбуждения пространства 
источником внешнего поля. Используя источник поля, найденный после 
анализа решения, полученного в другой задаче. Такая возможность 
значительно усиливает возможности HFSS для решения задач возбуждения 
антенной системой поверхностей, составленных из многих слоев диэлектри-
ческого материала с потерями, и для решения других задач. 
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6. Анализ волноводного T-моста 
 
 
       Программа HFSS эффективно выполняет анализ и моделирование трех-
мерных конструкций, в которые входят металлические и диэлектрические 
объекты, расположенные под произвольным углом друг к другу. Окончатель-
ная конструкция строится из параллелепипедов, цилиндров, сфер, спиралей и 
других примитивов, а также объектов, выполненных с помощью операции 
Sweep.  
      Рассмотрим волноводный Т-образный  тройник, созданный в виде   
металлической конструкции с бесконечно тонкими стенками. В тройнике 
имеется перегородка, которая обеспечивает лучшее согласование, а также 
используется для регулирования мощности.  
     Эта волноводная структура (рис. 6.1)  разделяет сигнал от порта 1 на два 
канала. Перегородка направляет сигнал  к выходным портам 2 и 3, и при этом 
обеспечивает малое отражение на входном порту. Рабочая частота 10 ГГц. 
       
 

 
 

Рис.  6.1. Волноводный Т-образный тройник (размеры в inch) 
  
  Коэффициенты передачи к портам 2 и 3 и коэффициент отражения сигнала в 
сечении порта 1, будут зависеть от положения перегородки. 

 
6.1. Выбор типа решения 

 
    В зависимости от того, какой тип решения в HFSS Ansoft задан,  после 
окончания решения возможно будет вывести различные рассчитанные 
характеристики. Для данного примера выберем режим Driven Modal, что 
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соответствует расчету  многомодовых S-параметров пассивного волновода, 
который «возбуждается» источником. Для этого: 
 
1. В меню HFSS, нажмите Solution Type. 
 

 
Рис. 6.2. Выбор типа решения задачи 

 
2. В диалоговом окне Solution Type, выберите Driven Modal, и затем нажмите 
OK (рис. 6.2). 

 
 

 

 6.2. Черчение геометрической модели 
 
     Черчения всей конструкции волноводного тройника будет состоять из 
следующих шагов: 
 
   - Черчение одной части волноводного моста – отрезка волновода в виде 
      параллелепипеда. 
    - Создание волноводного порта с линией интегрирования. 
    - Дублирование секции,  для создания двух других секций волноводного  
       моста. 
     -Объединение этих трех секций, чтобы создать окончательный 
       волноводный мост. 
     - Черчение  перегородки. 
     - Задание математической переменной, связанной с положением перего- 
       родки. 
     - Вычитание объема перегородки из объема волноводного моста. 
 
 

6.3. Черчение отрезка волновода 
 
 
      Геометрические размеры конструкции  первоначально выбираются из 
теоретического расчета. Так, сечение волновода нужно выбрать согласно 
рабочей длине волны, поскольку известно, что волновод имеет предельную 
частоту, ниже которой затухание его резко возрастает. А на частотах, более 



 108

высоких, в волноводе возникают высшие типы волн, которые изменяют 
характеристики устройства.  
 
      Начертим трехмерный бокс, который представляет собой первую часть 
тройника. Установим размеры inch в диалоге, который появится по команде 
3D Modeler –> Units. 
    

1. В меню Draw, нажмите значок Box . 
 
2. Задайте базовый угол бокса в нижней строке окна черчения (в миллиметрах) 
с координатами (0, -0.45, 0): 
   a. Чтобы перейти в статус-баре с одного текстового поля  в другое, нажимай-
те клавишу  Tab. 
   b. Впечатайте 0 в поле X (рис. 6.3) , и затем нажмите Tab, чтобы перейти в 
поле Y. 
   c. Впечатайте -0.45 в поле Y, и затем нажмите Tab. 
   d. Впечатайте 0 в поле Z, и затем нажмите Enter. 
 

 
Рис. 6.3. Внесение координат в поле черчения 

 
 
3. Задайте длину и ширину бокса,  вводя расстояние от базового угла: 
напечатайте (2, 0.9, 0) в поля dX, dY, и dZ. Затем нажмите Enter. 
 
4. Задайте высоту бокса,  вводя точку на  оси Z на определенном расстоянии к 
ранее созданной точке.  Впечатайте (0, 0, 0.4) в поля dX, dY, и dZ, и затем 
нажмите Enter. 
 
     Чтобы вернуться в предыдущее поле координат, нажмите Shift+Tab. 
     Если Вы сделаете ошибку, то нажмите Undo в меню Edit. HFSS позволяет 
отменять каждую выполненную команду, до последнего сохранения. 
 
    Появляется  окно Properties, с выбранной закладкой Command. 
В ней можно изменить размеры или положение бокса (рис. 6.4) . 
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Рис. 6.4. Закладка, в которой можно установить координаты и размеры 

бокса 
 
   Окно Properties имеет две закладки, в которых можно изменить имя,  
материал, и сделать объект более прозрачным. Чтобы выполнить это: 

1. В окне Properties, нажмите закладку Attribute. 
2. Измените имя бокса на  Tee:  Напечатайте Tee текстовом поле Value в 

строке Name, и затем нажмите Enter. 
     

 
Рис.  6.5. Закладка,  в которой устанавливается материал и другие 

аттрибуты бокса 
 
    По умолчанию, материал, назначенный на бокс - вакуум. Это – материал, 
которым  Вы заполните волноводный Т-мост.  
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6.4. Назначение волноводного порта на бокс 
 
   Теперь назначим волноводный порт на поверхность, параллельную плоскос-
ти yz при x = 2. Зададим  линию интегрирования, которая является вектором, 
которая задает направление распределения поля возбуждения в порте. 
     Это озадает поле в порту. Фактически в граничных точках линии 
интегрирования HFSS установит максимальные напряженности поля. 
1. Чтобы включить режим выбора стороны,  нажмите клавишу F. 
2. Нажмите поверхность бокса, которая  параллельна плоскости YZ при X = 2, 
как показано на рис. 6.6. 

 
Рис. 6.6. Выделение стороны бокса, на которую назначается порт 

 
3. Щелкните  правой кнопкой мыши окно 3D Modeler и затем нажмите Assign 
Excitation>Wave Port в меню. Появляется ассистент Wave Port. 
4. Напечатайте Port1 в текстовом поле Name, и затем нажмите Next. 
5. Выберите New Line  из списка Integration Line (рис. 6.7). 
 

 
Рис. 6.7. Задание импедансной линии и характеристического импеданса 
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7. В окне 3D Modeler выберите начальную точку вектора (2, 0, 0), щелкая на 
центр границы нижней поверхности. Курсор должен захватиться к ребру в 
этой точке, преобразуясь в треугольник. 
8. Выберите координаты конечной точки (2, 0, 0.4), щелкая точку в центре 
верхней стороны волновода (рис. 6.8).  
 

 
 

Рис.  6.8. Выбор начальной и конечной точки импедансной линии порта 
WavePort1 

 
9. Нажмите на «Далее». В появившемся окне Wave Port оставьте параметры 
порта по умолчанию. 
 

6.5. Дублирование бокса 
 
     Теперь продублируем боксы, чтобы создать вторую и третью части волно-
водного Т-моста. Параметры бокса будут продублированы вместе с 
геометрии-ей. Так, вместе с геометрием можно продублировать и граничные 
условия, включая настройки портов, если эта опция установлена в окне HFSS 
Options (в меню Tools).  
    1. Щелкните правой кнопкой мыши на узел ТEE в дереве хронологии, и 
затем нажмите Edit>Duplicate>Around Axis в выплывающем меню. 
2. Выполним вращение бокса на  90° вокруг оси Z, чтобы создать вторую 

секцию. Для этого в диалоговом окне Duplicate Around Axis , выберите Z 
(рис. 6.9). 
 

 
Рис.  6.9. Установка угла вращения дублированного бокса 
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3. Напечатайте 90 в поле Angle.  Положительный угол будет вращать объект 
против часовой стрелки. 
4. Впечатайте 2 в поле Total Number. Это - общее количество создаваемых 
объектов, включая исходный объект. 
5. Щелкните OK. Исходный объект Тee дублируется, и дубликат получает имя 
Tee_1, по умолчанию. Он сдвинулся  вокруг оси Z на угол  90° (рис. 6.10). 
      Атрибуты исходного объекта, включая его размеры, материал, 
цвет, проницаемость, порт, и линия интегрирования дублируются вместе с 
боксом. 
 

 
 
 

Рис. 6.10. Дублирование и вращение бокса 
 

    Итак, порт Port1 был продублирован с геометрией бокса. Новый порт наз-
ван Port2, что можно увидеть в разделе Exitation. 
7. Нажмите  Ctrl+D, чтобы согласовать размеры объектов в окне представле-
ния. 
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 Рис. 6.11. Порт WavePort1 дублируется вместе с частью перехода 

 
      Дерево хронологии показывает, что объект Tee был продублирован и был 
создан новый объект с именем Tee_1. 
    Снова продублируем первый бокс, используя ту же самую процедуру, но на 
этот раз вводя -90 deg в поле Angle (рис. 6.12). Отрицательный  угол  повернет 
объект по часовой стрелке (рис. 6.13). 
 

 
Рис. 6.12. Установка угла вращения объекта 

 
       Во время операции вращения все еще выбран и исходный объект, и его 
дубликаты.  
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Рис. 6.13. Включение второго продублированного бокса в конструкцию волно-
водного моста 

 
6.4. Объединение секций 

 
    Перед этим нужно убедиться, что HFSS не будет создавать копии исходного 
объекта перед соединением их, для чего снимите опцию  дублирования в диа-
логовом окне, появляющейся после команды Tools ->3D Modeler Options. 

 

 
Рис. 6.14. Установка режима дублирования объекта  при операциях над ним 

 
    В закладке  Operation диалогового окна 3D Modeler Options, 
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убедитесь, что  опция Clone tool objects before uniting  пуста, и нажмите OK. 
     Включите режим выбора объекта, нажимая  клавишу O. Выберите первый 
бокс,  щелкая на него в окне. 

 
 
Рис.  6.15. Три отрезка волновода, из которых составляется волноводный 

разветвитель 
 

5. Удерживайте клавишу Ctrl и нажмите на второй и третий боксы. 
6. В меню 3D Modeler, задайте команду Boolean -> Unite,  или нажмите на 

кнопку  . 
 

 
 

Рис.  6.16. Волноводный разветвитель после объединения 3-х отрезков 
волноводов 
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    Объекты объединяются в общих областях (рис.6.15). Новый объект (рис. 
6.16) будет иметь те же атрибуты, какие имел первый выбранный объект.  
 

6.5. Создание перегородки в разветвителе 
 
    Перегородка – это параллелепипед, который будет вычитаться из объема 
волноводного моста. Когда Вы начертите перегородку, сделайте  ее поло-
жение зависимым от  координаты y. Начертим  бокс вручную, не вводя точные 
координаты, а затем изменим его размеры и положение в диалоге Properties. 

    В меню Draw, нажмите Box . Выберите угол прямоугольника, затем 
второй угол, и затем точку на перпендикулярной оси к базовому 
прямоугольнику. После создания бокса появляется окно его свойств (рис. 
6.17).     
 

  
Рис. 6.17.  Геометрические параметры перегородки 

 
    Теперь, в окне  Properties можно ввести точное положение бокса и размеры. 
     Первая точка будет иметь координаты (-0.45, 0, 0), вторая точка  (0.45, 0.1, 
0), и третья точка (0, 0, 0.4). 
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Рис. 6.18. Параллелепипед перегородки в модели Т-образного разветвителя 

 
     Теперь нужно вычесть из объема компоненты Tee  бокс Box1 (рис. 6.17). 
Это выполняется командой 3D Modeler -> Boolean -> Substract после 
выделения этих двух объектов.  Для этого: 
1. Щелкните Tee в дереве хронологий, чтобы выбрать волноводный разветви-
тель. 
2. Удерживая клавишу Ctrl, нажмите имя Septum в дереве хронологий, и этим 
выберите перегородку. 
3. В меню 3D Modeler, укажите Boolean, и затем нажмите Subtract. Это 

аналогично нажатию кнопки . 
 
      Появляется диалоговое окно Subtract (рис. 6.19). Имя перегородки Box1 
находится в разделе Tool Parts, а имя тройника Tee находится в списке Blank 
Parts, указывая, что перегородка будет вычитаться из тройника. 
4. Убедитесь, что  опция Clone tool objects before subtracting (дублирование 
объектов перед вычитанием) отключена. 
5. Щелкните OK. Перегородка вычитается из тройника. Новый объект имеет 
те же самые атрибуты как объект Tee, который выбран первым. 
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Рис.  6.19. Диалог вычитания объекта ToolParts из объекта Blank Parts 
 
    В результате получается окончательная конструкция волноводного развет-
вителя с индуктивной перегородкой (рис. 6.20). 
 

 
 
Рис.  6.20. Окончательный вид волноводного Т-разветвителя с перегородкой 
 

 
6.6. Параметризация положение перегородки 

 
      Чтобы изменить положение перегородки, введите выражение для коорди-
наты y: offset - 0.05, где offset  имя переменной (рис. 6.21). Когда вы напечатаете 
это выражение,  появится диалоговое окно Add Variable, в которой  вводится 
переменная offset и ее численное значение. 
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Рис. 6.21.  Внесения переменной смещения offset в диалог задания размеров 
перегородки 
 
      Когда Вы даете значение переменной, необходимо включить в описание и 
единицы измерения, следующим образом: 
1. В текстовом поле Position (рис. 6.21), напечатайте -0.45in, offset - 0.05in, 
0in, и затем нажмите Enter. Появляется диалоговое окно Add Variable (рис. 
6.22). 

 
Рис. 6.22.  Добавление переменной offset к модели Tee 

 
2. Напечатайте 0in в текстовом поле Value, и затем нажмите OK. Затем, возв-
ратившись в окно Properties, установите точные размеры бокса. 
3. В окне Properties, в закладке Command, напечайте 0.45 в поле Xsize. 
4. В поле Ysize введите  0.1, а в поле Zsize введите 0.4. 
 
    При желании, переменную, которая описывает смещение перегородки, мож-
но задать прежде, чем Вы используете ее в черчении, задавая команду Project 
Variables. 
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      Затем эту локальную переменную нужно ввести вместо координаты в окне 
Properties (рис. 6.23), которое можно вызвать, щелкая правой кнопкой мыши 
на имени конструкции в дереве проекта.  
 

 
Рис.  6.23. Диалог свойств объекта 

- 
    Назначим имя боксу. Для этого: 
1. В окне Properties нажмите закладку Attribute (рис. 6.24). 
2. Напечатайте Septum в текстовом поле Value в  разделе Name. 
3. Щелкните OK. 

 
Рис.  6.24. Закладка аттрибутов в диалоге свойств. 

 
 

4. По желанию, вращайте представление, чтобы лучше видеть перегородку. 
Для этого нажмите Alt, и передвигайте мышь в направлении, в котором хотите 
вращать волноводный разветвитель. 
 
 
 



 121

 
6.5. Установки и выполнение решения 

 
     Далее выполним  следующие задачи: 
 

-Добавление установок на решение; 
-Добавление диапазона частот; 
-Проверка правильности конструкции; 
-Выполнение анализа; 
-Изменение положения перегородки; 
-Повторный анализ конструкции с новым положением перегородки. 

  Зададим  адаптивный анализ на частоте 10 GHz. Во время адаптивного анали-
за, HFSS уплотняет сетку разбиения итерационно в областях Т-разветвителя, в 
которых имеются самые  большие напряженности поля. Чтобы подготовить 
задачу на решение: 
 
1. В дереве проекта, под узлом проекта TeeModel, щелкните правой кнопкой 
мыши Analysis, и затем нажмите Add Solution Setup в выплывающем  меню. 
Появляется диалоговое окно Solution Setup (рис. 6.25). 
2. В закладке General , напечатайте 10 в поле Solution Frequency, и оставьте 
заданные по умолчанию единицы в GHz. 

 
Рис. 6.25.  Диалоговое окно установки решения 

 
3. В разделе Adaptive Solutions, оставьте Maximum Number of Passes  = 3.  
Это - максимальное число циклов измельчения сетки, которое выполнит 
HFSS. 
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Установка решения появляется в дереве проекта в папке Analysis. Она  назва-
на Setup1 по умолчанию. Если  Вы хотите выполнить решение в диапазоне 
частот, то нужно добавить изменение частоты к установке решения. 
       В рассматриваемой задаче ожидается плавная частотная характеристика, 
поэтому выберем метод интерполяции (Interpolating). Используя интерполя-
цию, HFSS сам выберет дополнительные частотные точки,  чтобы получить 
лучшую частотную характеристику. 
      Свипирование заканчивается, когда  HFSS достигнет критерия ошибки или 
выполнит максимальное число решений. Расчет в диапазоне частот выполня-
ется после того, как закончен адаптивный анализ на центральной частоте. 
Чтобы сделать установки на решение: 
 
1. Нажмите правой кнопкой Setup1 в дереве проекта, и затем нажмите Add 
Sweep. Появляется диалоговое окно Edit Sweep. 
2. Выберите режим Interpolating. 
3. Примите настройки по умолчанию для опций Error Tolerance и Max 
Solutions. Адаптивный анализ будет выполнен на частоте  10 GHz. Это значит, 
что при расчете в диапазоне частот, HFSS будет использовать окончательное и 
самое плотное разбиение на сетку.   
4. Нажмите Linear Step  в списке Type. 
5. Задайте следующий диапазон частот:  Start 8 GHz, Stop 10 GHz, 
Step Size 0.05 GHz. HFSS решит задачу в каждой частотной точке на каждом 
шаге в указанном частотном диапазоне, включая начальную и конечную точку 
частот (рис. 6.26). 
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Рис. 6.26. Установка диапазона и режима изменения частот решения 

 
     Режим изменения частот перечислен в дереве проекта под Setup1 и называ-
ется Sweep1 по умолчанию. Нажмите кнопку  Display (рис. 6.26), чтобы прове-
рить частоты, на  которых будет выполняться решение. 
 
 
 

6.6. Сдвиг положения перегородки 
 
     Когда анализ закончен, измените положение перегородки,  изменяя    зна-
чение переменной offset. 
1. Щелкните правой кнопкой мыши TeeModel в дереве проекта, и затем наж-

мите Design Properties. Появляется диалоговое окно Properties.  
2. В закладке Local Variables , выберите Value. 
3. Напечатайте 0.2 в текстовом поле Value для переменной offset. 
4. Щелкните OK. 
 
    После этого геометрия изменяется: перегородка перемещается в новое поло-
жение, ближе к порту 2. 
 
    Теперь Вы выполните второе моделирование, чтобы  получить результаты 
для волноводного моста Т-типа, когда перегородка смещена ближе к порту 2. 
Предыдущее решение сохраняется и остается доступным для вывода на 
график. 
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• Щелкните правой кнопкой мыши Analysis в дереве проекта, и затем нажмите 
Analyze. HFSS вычисляет новое решение трехмерного поля. 
 
      Процесс решения, как ожидается,  потребует приблизительно 1 - 5 минуты. 
      
       Перейдите к следующему шагу в следующей главе, создавая двумерный 
график x-y S-параметра. Выполним  следующие операции: 
 
     Создание графиков S-параметров. 
     Создание поля над поверхностью T-разветвителя. 
     Анимация поля. 
     Изменение положения перегородки, и получение нового графика поля с 
измененной конструкцией. 
     

 
Рис. 6.27. Закладка выбора первичной переменной графика 

 
7. Нажмите закладку Sweeps. Переменная Freq,  содержит точки частот, в 
которых выполнен расчет (рис. 6.28). 
8. Выберите кнопку Sweep Design and Project variable values. В данном 
случае в таблице появятся все переменные проекта и конструкции. Это даст 
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возможность вывода частотных характеристик при всех  значениях смещения 
offset. 

 
 Рис. 6.28. Установка первичного параметра свипирования Primery Sweep 

(частота Freq) для вывода на ось X 
8. Кликните Add Trace, чтобы добавить характеристику. Линия характеристи-
ки представляет линию, соединяющие точки  на графике. Три характеристики 
добавляются в список в верхнем окне. 
9. Щелкните Done.  Модули S-параметров для каждого сдвига перегородки 
будут нанесены на частотный график, как показано на рис. 6.29. График будет 
перечислен в разделе Result в дереве проекта. 

 

Рис.  6.29.  Рассчитанные характеристики волноводного Т-моста 
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    Три голубые линии показывают значения S-параметров, когда смещение пе-
регородки  offset = 0. Три красные линии показывают модули  S-параметров 
при offset = 0.2 дюйма. Типы линии в графике выше изменялись в диалоговом 
окне Traces Properties для лучшего просмотра. 
     Как ожидается, небольшое отражение S11≅0.2 имеет место в порту 1, когда 
значение переменной offset = 0, то есть когда перегородка находится напротив 
порта 1.  В этом случае отражение немного больше и передача равна  0.7 на 
двух выходных портах 2  и 3. 
      Графики показывают также, что отражение в порту 1 немного уменьшает-
ся, когда значение offset = 0.2 дюйм, то есть когда перегородка смещена на 0.2 
дюйма к порту 2. Передача в порту 2 уменьшения и передача в порту 3 увели-
чивается при положении перегородки в этом положении. Далее создадим 
график поля и анимируем его, чтобы увидеть разницу полей между двумя 
положениями перегородки. 
       Для лучшего чтения графиков, в окне Trace Properties  можно изменить 
типы линий, а также добавить маркеры ко всем линиям на графике. 
     Дважды щелкните на линию в графике. В появившемся диалоговом окне 
Trace Properties нажмите закладку Line Style, выберите Show Symbols On All 
Trace, и затем напечатайте 2  в поле. Символы, связанные с каждой линией, 
показанной в условных обозначениях справа от графика, будут добавлены к 
линиям в каждой второй точке данных. 
      Чтобы изменять  цвет линии в закладке Under the Color , измените цвет 
выбранной линии,  определяя новые величины цвета RGB. 
 

6.7. Вывод  графика электромагнитного поля 
 
       График электромагнитного  поля  представляет в цвете величины поля на 
поверхности  (рис. 6.30) или в объеме объекта. Составим график модуля E-
поля на верхней поверхности волноводного Т- моста. Сначала, переместите 
перегородку назад в ее исходную позицию напротив порта 1. 
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Рис. 6.30.  Вывод поля в верхней плоскости волноводного Т-разветвителя  

 
    Изменим значение переменной offset = 0. Для этого: 
 
1. Убедитесь, что  окно Property находится на панеле. Если его нет, нажмите 
View> Property Window.  
2. Нажмите имя проекта TeeModel в дереве проекта. 
3. В закладке  Variables в окне Properties, в поле Value введите offset= 0 для 
смещения перегородки, и нажмите  Enter. В результате мы видим, что чертеж 
конструкции перечерчивается с учетом нового положения перегородки. 
 
Чтобы создать график поля при новом положении перегородки: 
 
1. Возвратитесь к окну 3D Modeler: в меню HFSS, нажмите 3D Model Editor. 
2. Переключитесь к режиму выбора: щелкните правой кнопкой мыши в окне 
представления, и затем нажмите Select Faces в меню. 
3. Выберите верхнюю поверхность T- разветвления. 
4. Щелкните HFSS>Fields>Plot Fields>Mag_E. Появляется диалоговое окно 
Create Field Plot. 
5. Выберите Setup1:LastAdaptive как решение, полученное при лучшем 
разби-ении сетки. 
 
7. Остальные параметры примите по умолчанию и щелкните Done. На верхней 
поверхности волноводного Т-моста появляется картина E-поля, равномерно 
расходящегося к порту 2 и порту 3. 
      Этот график появляется в дереве проекта в разделе Field Overlays. Он 
назван Mag_E1, что было задано по умолчанию в окне Create Field Plot . 
     График Mag_E1 показывает E-поле при расположении перегородки 
напротив порта 1. Теперь мулиплицируем график поля. 
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      В левом верхнем верхнем углу окна 3D Modeler находится цветовая па-
литра, показывающая, какому цвету соответствует определенный уровень 
напряженности поля. Если поле имеет значительный разброс, удобно перейти 
в логарифмический масштаб отображения цвета, нажимая правой кнопкой 
мыши Modify… и выбирая кнопку Log в закладке Scale. 
 

6.8.Анимация поля 
 
     Анимация графика поля выполняется по ряду картин поля, картин разбие-
ния на сетку ячеек, или по ряду картин геометрии при изменении переменных. 
Для анимации нужно задать график, которые хотите включить в анимацию, а 
также правило, по которому будут выбираться отдельные кадры для мульти-
пликации. Для этого: 
 
1. Щелкните правой кнопкой мыши Mag_E1 в дереве проекта, и затем нажми-
те Animate. Появляется  окно Setup Animation. 
2. В закладке Swept Variable, нажмите Phase в списке Swept Variable. 
3. Чтобы задать значения фазы, используемые в мультипликации: 

a. Напечатайте Start =0deg . 
b. Напечатайте Stop =160deg. 
c. Напечатайте Steps= 8. 

4. Щелкните OK. Начинается мультипликация, которая показывает, как пере-
городка разделяет электромагнитную волну к порту 2 и порту 3. Диалоговое 
окно Animation появляется в левом верхнем углу, позволяя выполнить оста-
новку, повторный запуск, и управлять скоростью и последовательностью 
мультипликации. Мультипликация будет последовательно отображать график 
при 8 значениях фазы волны возбуждения между 0 и 160º.  
     Мультипликацию можно экспортировать в виде файла в формате GIF или  
формате Audio Video (AVI),  используя команду Export в диалоговом окне 
Animation.       
     Теперь переместим перегородку ближе к порту 2, чтобы видеть влияние 
этого положение на распределении E-поля на верхней стороне волноводного 
моста. 
1. Нажмите проект с именем  TeeModel в дереве проекта. Вы можете 
перетащить диалоговое окно Animation, чтобы видеть имя конструкции в 
дереве проекта. 
2.  В закладке Variables в окне Properties, напечатайте 0.2 в  поле Value для 
смещения offset, и затем нажмите Enter.  Начинается мультипликация E-поля. 
Она показывает, что в порт 3 перемещается большая мощность 
электромагнитной волны. 
  
    В следующем разделе мы продолжим рассмотрение этого примера, чтобы 
показать применение параметрической оптимизации.  
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7. Оптимизация T-образного волноводного 

разветвителя 
 

 
 
     Программа Оптиметрик, входящая в систему HFSS Ansoft,  дает возмож-
ность найти лучшую конструкцию, изменяя ее геометрию, параметры матери-
алов и элементов. В процессе проектирования сначала создается 
первоначальная модель, или номинальная конструкция, и затем задаются 
параметры конструкции, которые изменяются. 
     Этими параметрами может быть почти любой параметр, имеющий 
численное значение в HFSS. Например, можно параметризировать геометрию 
модели, свойства материала, или граничные условия. С помощью HFSS можно 
выпол-нить следующие типы исследований  номинального проекта, при 
оптимизации конструкции: 
 
Parametric 
(параметрический 
анализ) 

Задание одного или большего числа изменяемых параметров, 
составляющих  ряд значений в заданном диапазоне. HFSS 
выполняет анализ при каждом изменении параметров. 

Optimization 
(оптимизация) 

Задается целевая функция и цель оптимизации. Оптиметрик 
изменяет значения параметров проекта так, чтобы достиг-
нуть заданной цели. 

Sensitivity 
(чувствительность) 

Расчет чувствительности характеристик к небольшому изме-
нению заданных переменных. 

Tuning 
(подстройка) 

Переменные значения изменяются в интерактивном (ручном)  
режиме, и для каждого положения настраиваемой конструк-
ции  рассчитываются характеристики. 

Statistical 
(статраспределе‐
ние) 

Нахождение статистического распределения характеристик 
проекта, вызванное случайным распределением переменных. 

 
         В данном разделе мы будем оптимизировать волноводный Т-мост, черче-
ние и анализ которого был выполнен в разделе 6. В результате оптимизации 
найдем оптимальное положение перегородки, при котором мощность в порту 
3 будет в два раза больше, чем мощность в порту 2. Этот искомый результат 
называется целью оптимизации. Оптиметрик будет варьировать конструкцию 
проекта, пока целевая функция не достигнет минимума. 
      До выполнения оптимизации, выполним т. н. параметрический анализ. Для 
этого вводится переменная offset, равная смещению перегородки. В процессе 
параметрического анализа выполняется расчет S –параметров, и находится 
т.о., как каждое изменение конструкции влияет на разделение мощности на 
выходах Т-моста. Это поможет задать разумный диапазон величин смещения 
offset, для последующей оптимизации. 
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     Результаты параметрического анализа помогут также определить начальное 
значение смещения перегородки для последующей оптимизации. 
       Анализ волноводного тройника показывает, что когда перегородка нахо-
дится напротив порта 1, она делит сигнал пополам между портом 2 и портом 
3. Параметрический анализ  покажет, что когда перегородка смещается ближе 
к порту 2, мощности передачи и мощность ответвления сначала  уменьшатся в 
порту 2 и увеличится в порту 3.             
         Эта параметрическая оптимизация даст полезную информацию для 
стартовой установки на оптимизацию. Например, она должна показать 
положение перегородки, при котором значение мощности в порту 3  равно 
удвоенной мощности в порту 2. Это сузит диапазон значений смещения, 
который Вы установите для оптимизации.  
       Целевая функция может быть составлена на основании любых характерис-
тик,  типа значений поля, S-параметров, и собственных чисел (резонансов). 
     Когда Вы выполняете параметрический анализ и оптимизацию, задача 
решается на одной частоте 10 ГГц. Решать в диапазоне частот для каждого 
изменения конструкции не нужно, так что удалите установку Sweep1 в дереве 
проекта при Analysis> Setup1. Теперь Вы готовы выполнить параметрический 
анализ. 
 

7.1. Установки параметрического анализа 
 
    Установки параметрического анализа включают все изменения проекта, 
необходимые, когда Оптиметрик будет управлять HFSS. Эта установка 
составляется из одного или большего количества изменяемых размеров, 
каждого в своем диапазоне изменений. 
      Сначала, прибавим параметрические установки к проекту. Для этого 
щелкните правой кнопкой мыши Optimetrics в дереве проекта (рис. 7.1), и  

 
Рис. 7.1. Выбор режима параметрического анализа 

 

затем нажмите Add>Parametric в меню, или кнопку  . Появляется диало-
говое окно Setup Sweep Analysis.  Пределы изменения переменной задаются, 
нажимая кнопку “Add”. 
 
     Чтобы прибавить изменяемую переменную: 
 
1.  В закладке Sweep Definitions, нажмите Add. Появляется окно Add/Edit 
Sweep (рис. 7.2). 



 131

2. Cмещение offset находится в списке Variable по умолчанию. Это – перемен-
ная, значение которой мы будем изменять в процессе оптимизации. 
3. Выберите Linear step как равномерный шаг изменения переменной. 
4. В поле Start напечатайте 0, и затем выберите «in» (дюйм). 
5. В поле Stop напечатайте 1, и выберите «in». 
6. В поле Step напечатайте 0.1, и выберите «in». Размер шага определяет число 
изменений конструкции между начальным и конечным значениями. HFSS 
решит модель на каждом шаге в указанном диапазоне, включая начальное и 
конечное  значения. 
7. Щелкните Add. Появляется диалоговое окно, показанное на рис. 7.2. 
 

 
Рис.  7.2. Диалог редактирования параметров оптимизации 

 
8. Щелкните OK. Вы возвращаетесь к диалоговому окну Setup Sweep Analysis 
(рис. 7.2). Кроме равномерного шага в диапазоне изменения, можно выбрать 
разбиение на заданное количество шагов (Linear count), логарифмический 
масштаб изменения диапазона (Exponential count). 
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Рис. 7.3.  Установки изменения  переменной offset 

 
       По умолчанию HFSS не сохраняет полученные значения электромагнит-
ного поля для каждой измененной конструкции. Если нужно сохранить 
решения поля, чтобы  рассчитать характеристики на этапе постобработки 
данных,  в закладке General выберите режим Save Fields (рис. 7.4). 
 

 
Рис. 7.4. Закладка General, в которой выполняются  установки изменения 

переменной 
         
    Если открыть закладку Table, то в ней будут перечислены все значения 
пере-менной offset, при которых будет решаться задача. Это дает возможность 
увидеть вариации проекта, которые будут решены и вручную скорректировать 
величины изменений, в случае необходимости (рис. 7.5).  
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Рис. 7.5. Значения offset  перечисленные в таблице для выполнения 

параметрического анализа 
 
  Установка параметрического анализа включает все изменения конструкции. 
Она может быть составлена также из нескольких определений variable sweep 
definitions. 
 
 

Задание рассчитываемых характеристик 
 
      Зададим три характеристики волноводного T-моста, которые рассчитает 
HFSS и сделает их доступными для последующей обработки. Эти три пере-
менные - математические выражения величин мощности в каналах порта 1, 
порта 2 и порта 3. Для расчета их: 
1. В закладке  Calculations, нажмите кнопку Add (рис. 7.6). 
    По умолчанию, решение электромагнитного поля будет извлечено из 
решения, полученного на последней итерации. 

 

 
Рис. 7.6.  Перечисленные переменные Power11, Power 21 и Power31 в закладке Calculations 
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2.  Щелкните Edit Calculation. Появляется диалоговое окно Output Variables 
(рис. 7.7). 
3. Задайте первую выходную переменную, которую Вы хотите рассчитать, для 
чего: 

a. В текстовом поле Name напечатайте «Power13». 
b. В списке Category, нажмите S Parameter. 
c. В списке Quantity, нажмите S (Port1, Port1). 
d. В списке Function, выберите модуль параметра: mag. 
e. Щелкните Insert Quantity Into Expression. 
f. В конце выражения в строке, в текстовом поле Expression, 
напечатайте  * (умножение)  и затем снова нажмите Insert Quantity Into 
Expression. 

 
Рис. 7.7. Создание новых имен и функций Power11= |S11|2 и др. 

 
    Выражение должно иметь вид 

mag (S (Port1, Port1)) *mag (S (Port1, Port1)). 
 
    Щелкните Add. Новая переменная Power11 и выражение, которое она пред-
ставляет,  добавляется в список выходных переменных сверху диалогового 
окна. 
4. Повторите шаг 3, задавая вторую выходную переменную по имени 
«Power21», но на сей раз нажимая S (Port2, Port1) в списке Quantity. Должно 
появиться выражение:                   

mag (S (Port2, Port1)) *mag (S (Port2, Port1)). 
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5.  Прибавьте третью переменную вывода по имени «Power31», используя 
параметр S (Port3, Port1) в списке Quantity. Должно появиться следующее 
выражение:                  

mag (S (Port3, Port1)) *mag (S (Port3, Port1)). 
 
6. Щелкните Done.  Последняя  созданная выходная переменная, Power31, 
появляется в текстовом поле Calculation. По умолчанию, расчет Power31 
выполняется на единственной частоте 10 ГГц. Это частота  адаптации, которая 
была задана при установке решения.  
7. Кликните Add, чтобы добавить Power31. 
8. В новой строке выберите Power21 в опускающемся списке Calculation, и 
затем нажмите Enter. 
9. Кликните Add. 
10. В следующей строке, в столбце Calculation напечатайте Power11, и затем 
нажмите Enter.  

 
Рис.  7.8.Установка в диапазоне решения (частоты 10 Ггц) в закладке 
Calculations 
 
11. Кликните OK. 
 
     Таким образом, мы ввели новые переменные, которые теперь можно вывес-
ти в виде частотной зависимости, а можно использовать как переменную для 
задания целевой функции. 

 
7.2. Выполнение параметрического анализа 

 
     Теперь запустим параметрический анализ, в результате мы получим пара-
метры волноводного моста, при каждом положении перегородки, указанном 
ранее. 
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    Щелкните правой кнопкой мыши ParametricSetup1 в дереве проекта, и 
затем нажмите Analyze. 

 
 
       HFSS вычисляет электромагнитное поле для каждого указанного измене-
ния конструкции, кроме уже решенных во время расчета номинального проек-
та. Например,  в процессе решения можно видеть в окне Progress (рис. 7.9), 
что HFSS не выполняет решения для значений 0 дюйм и 0.2 дюйм, потому что 
эти решения ранее получены. 

 
Рис.7.9. Окно просмотра процесса оптимизации 

 
 Процесс решения, как ожидается,  потребует приблизительно 10 мин. Когда 
решение закончено, появляется подтверждение об этом в Message Manager. 
 

7.3. Зависимости  S-параметров от  положения перегородки 
 
 

 
Рис. 7.10. Синяя линия показывает зависимость модуля S11 на порту 1, другие 

линии – S12 и S13 для каждого значения смещения 
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      Как и ожидается, когда перегородка перемещается ближе к порту 2, 
передача к порту уменьшается, и увеличивается передача к порту 3. Когда 
перегородка смещается ближе, чем на 0.3 дюйма, к порту 2, передача 
становится меньше, чем передача к порту 3.  
  Одновременно увеличивается отражение в сторону порта 1, поскольку элек-
тромагнитные волны отражаются от стенки напротив порта. В результате 
полу-чаем оптимальное  значение, при котором S11 минимальное,  равное 0.3 
дюйма. 
 
 

7.4. Создание графика зависимости разводки мощности  
относительно параметра offset 

 
    Теперь создадим прямоугольный график, на котором сравниваются  мощ-
ности в каждом порту для каждого положения перегородки. Для этого 
используем уже подготовленные выражения для мощности, зависящие от S-
параметров: 
 
1. Щелкните правой кнопкой мыши Results в дереве проекта, и затем нажмите  
Create Report. Появляется окно Create Report.  
2. Нажмите Modal S Parameters в списке Report Type. 
3. Выберите тип графика Rectangular Plot в списке Display Type, и нажмите OK. 
Появляется диалоговое окно Traces (рис. 7.11). 
4. В закладке Y, задайте графики по оси Y: 
  a. В списке Category, нажмите Output Variables. 
  b. В списке Quantity, нажмите Shift, и нажмите Power11, Power21, и 
Power31. 
  c. В списке Function, нажмите <none>. 
5. В закладке  X выберите Use Primary Sweep. 
6.  Откройте закладку Sweeps. 
7. Измените первичную переменную на графике, которая будет идти по оси x, 
на offset. Для этого: 
          a. Выберите Sweep Design and Project variable values. 
          b. Нажмите имя Freq, и в выплывающем списке выберите имя offset. 
 
8. Щелкните Add Trace. 
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Рис. 7. 11. Вывод мощностей Power11, Power21 и Power31 на график 

 
9. Щелкните Done. 
      Разводка мощности показывается на графике зависимости мощности в 
каждом порту от величины смещения (рис. 7.12). Имя графика появляется в 
разделе Results  в дереве проекта. 
 

 
Рис. 7.12. Зависимость распределения мощностей от положения перегородки 

offset 
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    Для каждого значения смещения offset, синяя линия (рис. 7.12) показывает 
значения мощности в порту 1, красная линия показывает значения мощности в 
порту 2, а зеленая линия показывает значения мощности в порту 3. 
     Цель параметрической оптимизации состоит в том, чтобы найти положение 
перегородки, при которой мощность в порту 3 в два раза больше, чем в порту 
2. Обратите внимание, что когда offset= 0.1 дюйм, значение Power21 
приблизительно равно 0.32, и Power31 приблизительно равно 0.65, или 
примерно вдвое больше. Поэтому, установим начальное значение переменной 
offset=0.1 дюйм.  
   Анимация поля выполняется  в окне View, в котором отображается график 
поля при каждом смещении offset между 0 и 1.0 дюйм,  что дает общее 
количество 11 кадров мультипликации (рис. 7.13). 

 
Рис.7.13. Мультиплицируемый график показывает E-поле на верхней 
плоскости T-моста, когда перегородка перемещается ближе к порту 2 
 
    Графики поля показывают, что когда смещение находится между 0 и 0.3 
дюйм, в сторону порта 3 идет большая мощность. Когда offset  > 0.3 дюйм, 
поле начинается отражаться назад к порту 1; и в этом случает перегородка 
меньше влияет на передачу электромагнитных волн к порту 2 и порту 3.  
     Поэтому, зададим величины смещения между 0 и 0.3 дюйм. 
 

 
7. 5. Установка и выполнение оптимизации 

 
      В этом разделе Вы выполним следующие задачи: 
-Установка переменной offset как переменную оптимизации; 
- Выбор параметров оптимизации; 
-Прибавление целевой  функции для установки оптимизации; 
-Выполнение оптимизации. 
 

7.5.1. Выбор переменной оптимизации 
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       Прежде, чем запустить процесс оптимизации, нужно выбрать переменные, 
которые будет изменяться во время оптимизации. Это выполняется в диалого-
вом окне Design Properties. 
 
1. В меню HFSS нажмите команду Design Properties. Появляется окно 
Properties. 
2. В закладке Local Variables, выберите Optimization. 
3. Для переменной offset, отметьте галочкой Include (рис. 7.14) и  нажмите 
OK. 
 

 
 
Рис.7.14.  Установка переменных для оптимизации, подстройки, расчета поля 

разброса и статистического анализа 
 
 
    В этой же строке можно выбрать минимальное из максимальное значение 
параметра offset, в пределах которых будет изменятся эта переменная. 
 
 

7.5.2.  Выбор  цели оптимизации 
 
       Установка оптимизации включает задание целевой функции, которая 
включает одну или большее количество целей с учетом весовых коэффици-
ентов каждой из целей. Для этого: 
 
1. Щелкните правой кнопкой мыши Optimetrics в дереве проекта, и затем 

нажмите Add>Optimization (или значок ) в выплывающем меню. 
Появляется диалоговое окно Setup Optimiеzation (рис. 7.14). 
2. В закладке Goal, выберите  Quasi Newton (метод квази-Ньютона) в 
опускающемся списке Optimizer. 
3. Выберите максимальное число шагов поиска Max. No. of Iterations=100.     
Когда выполнится это число расчетов целевой функции,  оптимизация 
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остановится. Иначе HFSS продолжает выполнять итерации,  пока не будет 
достигнута заданная целевая функция, или достигнут другие ограничения. 
4. Снимите опцию Save Fields. Нам не нужны будут поля, поскольку их расчет 
не будет использоваться для включения в целевую функцию. 
 
     Ошибка расчета (числовой шум) не будет существенна во время процесса 
решения, поэтому в данной оптимизации больше подходит метод Quasi 
Newton. 
     Заметим, что значение смещения установлено на 0.2 дюйм. Это – текущее 
значение переменной в номинальном проекте. 
 

 
7.5.3. Добавление целевой функции 

 
      Выберем целевую функцию. Цель оптимизации – найти положение перего-
родки, при котором мощность в порту 3 будет в два раза больше мощности в 
порту 2. Установим целевую функцию так, чтобы  
                 (мощность в порту 3) - 2 * (мощность в порту 2) = 0  
в оптимальной точке.  
        Будем использовать рассчитанные S параметры, чтобы составить это 
выражение. Зададим, что если в процессе поиска минимума целевая функция 
становится меньшей, чем 0.01,  то цель оптимизации достигнута (рис. 7.15). 
 

 
Рис.7.15.  Установка целевой функции,  метода поиска минимума целевой 
функции Квази-Ньютон, максимального количество шагов поиска и др. 

параметров 
 

 
1. В закладке Goal нажмите Add. В таблице Cost Function добавляется новая 
строка. По умолчанию, целевая функция будет рассчитана по данным, 
полученным из последнего адаптивного решения. 
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2. Определите величину решения,  чтобы задать целевую  функцию: 
     В текстовом поле Calculation, напечатайте  
 
                  Power31 - 2*Power21,  
  
и затем нажмите Enter. По умолчанию, расчет будет выполнен на частоте 10 
GHz.  
3. Оставьте условие Condition  = (равно). 
4. В текстовом поле Goal, напечатайте 0, и затем нажмите Enter. 
5. Оставьте набор значений Weight = [1]. 
6. В текстовом поле Acceptable Cost, напечатайте 0.01. Если значение целевой 
функции равно или меньше этого значения, оптимизация остановится. 
7. Оставьте Noise = 0.0001. Значения Weight полезно задать, когда имеются 
несколько целей, и нужно увеличить или уменьшить их вклад в целевую функ-
цию. 

 
       

7.5.4. Выбор метода оптимизации 
 
      В общем случае можно выбрать два оптимизатора: Quasi Newton и Pattern 
Search.  
 
     Если изменение значения целевой функции плавное и небольшое, 
используйте оптимизатор Quasi Newton. Этот оптимизатор рассчитывает 
градиент целевой функции в процессе поиска минимума целевой функции.  
    Если нестабильность расчета, или чувствительность в начальной точке 
существенна, используйте оптимизатор Pattern Search. Этот оптимизатор 
реализует  симплекс-метод, который в процессе оптимизации использует 
треугольники в двумерном пространстве или тетраэдры в трехмерном 
пространстве (симлексы). Целевая функция рассчитывается на вершинах 
симплекса. Оптимизатор отражает симплекс поперек одной из его 
поверхностей, используя математические правила, и определяет, дает ли 
новый симплекс лучшие результаты. Если лучшего результата нет, 
используется следующая поверхность для отражения, и процесс 
продолжается. Если улучшения не происходит, сетка уплотняется. Алгоритм 
Pattern Search менее чувствителен к нестабильности расчета. 
 
 

7.5.5. Модификация начального значения переменной 
 
      Начальное значение переменной - первое значение, при котором выполня-
ется решение в процессе оптимизации. В нашем примере Оптиметрик авто-
матически устанавливает начальное значение, равное 0.2 дюйм. Если  устано-
вить начальное значение равным offset = 0.1 дюйм, то это соответствует тому 
случаю, когда мощность в порту 3 приблизительно вдвое больше, чем 
мощность в порту 2. 
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1. Нажмите закладку Variables (рис. 7.16). 
       Смещение offset - единственная переменная в нашем списке. В общем 
случае изменяемых переменных может быть несколько. 
 

 
 
Рис. 7.16. Установка переменной offset, изменяемой в диапазоне  от 0 до 0.3 in 
(дюйм) 
 
2. В поле Starting Value, напечатайте 0.1, и затем нажмите Enter. Выберите 
оп-цию Override. Это указывает, что значение, которое Вы ввели, будет 
использо-ваться для начального шага оптимизации и отменяет текущее 
значение перемен-ной. Минимальное значение переменной устанавливается 
Оптиметриком  автоматически, равное приблизительно половине начального 
значения пере-менной. Для нашего случая установите минимальное значение 
равное нулю, для чего в поле  Min впечатайте 0. 
    Максимальное значение Max должно быть установлено равным 0.3.  Это 
зна-чение выбрано потому, что уже параметрический анализ показал, что 
величины смещения большее, чем 0.3 не дадут улучшения целевой функции. 
 
 
 
 
 

7.5.6. Установки для решения параметрического анализа 
перед оптимизацией 

 
      При выполнении параметрического анализа перед оптимизацией, Оптимет-
рик может найти начальную точку  для оптимизации. В нашем примере, после 
выполнения шага ParametricSetup1 , Оптиметрик не будет повторно 
выполнять решение для начального значения переменной. Выполните 
следующее: 
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1. Откройте закладку  General (рис. 7.17). 
2. Выберите ParametricSetup1 в списке Parametric Analysis. 
3. Выберите опцию Solve the parametric sweep before optimization. 
 

 
Рис.7.17. Установки оптимизации в закладке General 

 
 
      В этом случае HFSS  выполнит параметрический анализ перед оптимиза-
цией, а после оптимизации перечертит геометрию T-разветвителя с новой 
оптимальной величиной offset. 
4. Выберите опцию Update design parameter values after optimization 
(подстановка величин параметров после оптимизации). 
5. Кликните  OK   диалогового окна Setup Optimization.В выбранном режиме 
начальное значение переменной, установленное ранее, игнорируется, если в 
результате параметрического анализа находится более подходящее начальное 
значение. 
    Теперь запустим оптимизацию. Для этого в дереве проекта в разделе 
Optimetrics, нажмите правой кнопкой мыши установку OptimizationSetup1, и 
затем кликните Analyze в выплывающем меню. 
       Процесс решения, как ожидается, будет занимать 2 - 4 минуты. Когда ре-
шение выполняется, можно наблюдать процесс изменения целевой функции, 
если выбрать команду View Analysis Results... 
 

 
7.5.7. Просмотр изменения целевой функции 

 
      График зависимости целевой функции относительно номера выполненной 
итерации постоянно изменяется. График показывает, как приближается значе-
ния целевой функции к желаемой величине 0. 
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1. Щелкните правой кнопкой мыши OptimizationSetup1 в дереве проекта, и 
затем нажмите View Analysis Result… в меню. Появляется окно Post Analysis 
Display. 
2. В закладке Results, выберите Plot. Появляется график целевой функции при 
каждой итерации (рис. 5.17). 

 
 

Рис.7.18. Изменение целевой функции по мере выполнений итераций 
 
 
      Для первых 11 итераций Оптиметрик уже имеет расчеты, выполненные во 
время параметрического анализа. Поэтому Оптиметрик извлекает целевую 
функцию из 11 вариантов конструкции, решенных во время параметрического 
анализа. Это уменьшает время оптимизации, которая останавливается, когда 
достигается значение целевой функции, равное 0.01 (рис. 7.18). 
3. Точные значения целевой функций на каждом шаге оптимизации можно 
вывести в таблицу, если выбрать Table. Оптимальное значение переменной, 
при которой достигается  минимальная целевая функция, должно быть около 
0.09 дюйм. 
4. Кликните Close.  В этот момент HFSS изменяет геометрию волноводного Т-
моста так, чтобы смещение становится равным оптимальному значению 0.09 
дюйм. 
      Теперь можно выбрать различные значения смещения в таблице, и нажать 
Apply, чтобы изменить геометрию волноводного Т-моста. 
    Чобы возвратить геометрию к номинальному проекту, нужно нажать 
Revert.  
 
 

7.5.8. Повторный анализ конструкции с оптимально 
установленной перегородкой 
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       После окончания оптимизации  решения для поля нет; поэтому график 
поля Mag_E1  отсутствует. Чтобы получить графики электромагнитного поля, 
нужно запустить задачу на решение  при оптимальном значении переменной 
offset. Для этого: 
   • Щелкните правой кнопкой мыши Setup1 в дереве проекта под Analysis, и 
за-тем нажмите Analyze в меню. Анализ займет приблизительно 1 минуту. 
    • Дважды щелкните на графике Mag_E1, чтобы увидеть модифицированный 
график в окне View. Можно видеть, что поле, движущееся к порту 3 прибли-
зительно в два раза больше, чем поле, движущееся к порту 2. 
       График на рис. 7.19 показывает E-поле, когда перегородка находится  в 
оптимальном положении. 
 

 
 

Рис. 7.19. Поле в сечении верхней плоскости Т-разветвителя при 
расположении перегородки в оптимальном положении 

 

 
     Теперь можно  закрыть проект  OptimTee и выйти из HFSS. Для этого: 

1. Сохраните проект нажатием на . 
2. В меню File, нажмите Close. 
3. В меню File, нажмите Exit. 

 
     Итак, в этом разделе мы выполнили оптимизацию волноводного Т-моста, с 
выбранной целевой функцией, когда мощность в одном выходном порту в два 
раза больше мощности на выходе второго волноводного порта. 
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8. Моделирование СВЧ линий с помощью HFSS 
 
    
 
     В данном разделе выполним моделирование следующих трехмерных 
структур: отрезок волновода, отрезок микрополосковой линии, линии с 
подвешенной подложкой,  щелевой линии и отрезок диэлектрической линии. 
В этом разделе будут рассматриваться различные типы волн, возникающие в 
волноводных линиях, что необходимо для понимания расчета многомодовых 
матриц рассеяния. Важными вопросами при проектировании сложных СВЧ 
устройств являются вопросы их возбуждений. 
     В программе HFSS имеются два типа портов, с помощью которых вводится 
и выводится мощность в пространство расчета поля.  
 

8.1.Волноводный порт (Wave Port) 
     

   Волноводные порты является специальной границей, предназначенной для 
моделирования с учетом поглощения энергии. Этот порт вида моделирует 
бесконечно длинный волновод, соединенный со структурой.  
     При описании волноводного порта необходимо выделить прямоугольник и 
задать команду Assign Exitation -> Wave Port. В этом случае все его внешние 
ребра являются металлическими. Порт задается в виде волновода, идущего из 
бесконечности. 
    Для возбуждения структуры волноводный порт может охватывать 
различные линии передачи (рис. 8.1):  микрополосковую, щелевую, 
копланарную или диэлектрическую. Порт распознается своими гранями порта. 

 
Рис. 8.1. Пример возбуждения микрополосковой линии волноводным портом 

 
     На рис. 8.1 показано поле в сечении порта, когда диэлектрическая 
проницаемость подложки, на которой расположена микрополосковая линия, 
небольшая. Если проницаемость подложки большая, то поле концентрируется 
в диэлектрической подложке. При задании порта нужно выбрать количество 
типов волн так, чтобы они описывали сложный характер поля в сечении 
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волноводного порта. Чем большее поле сосредоточено под линией, тем 
меньше типов волн нужно задавать. 
    При описании волноводного порта нужно установить опции, в которые вхо-
дят направление и полярность полей возбуждаемых типов волн и 
интегральную линию, по которой вычисляется напряжение и токи при расчете 
внутри HFSS характеристического сопротивления Zpi, Zpv, Zvi. 
     Типы волн задаются разные, но нельзя установить несколько 
распространяющихся квази - TEM типов волн в сечении одного волноводного 
порта. Поэтому в методе Driven Modal в одном сечении нельзя установить 
связанные многопроводные линии передачи, которые будут возбуждаться 
волноводными портами. Для анализа многопортовых структур, в каждом 
порту которых распространяется только ТЕМ волна и используется метод 
решения Driven Terminal. Метод решения Driven Terminal использует 
линейную  комбинацию узловых напряжений или токов и применяется в 
анализе излучаемых СВЧ структур с дискретными интегральными схемами. 

 
8.2.Дискретный порт (Lumped Port) 

 
     При задании этого порта необходимо начертить прямоугольник и задать ко-
манду Assign Exitation -> Lumped Port. Краями порта становятся стороны, 
которые соприкасаются с проводящей поверхностью или другим ребром 
порта. Все оставшиеся грани порта принимают свойства Perfect H (рис. 8.2). 

 
Рис. 8.2. Задание дискретного порта в общем случае, между двумя 

стенками с граничными условиями Perfect H 
 
    Дискретный порт моделирует ситуацию, когда в микрополосковую струк-
туру включается микросхема. В этом случае можно считать, что размер порта 
намного меньше длины волны, и многомодовость порта можно исключить. 
Это значит, что можно считать основными свойствами порта напряжение и 
ток, протекающий по интегральной линии, задаваемой при описании 
дискретного порта. 
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       8.3. Анализ волновода электромагнитных волн 
 
      Выполним  EM моделирование волновода с параллельными плоскостями, 
разнесенными на ширину w = 30 мм и высоту d = 18.75 мм (рис. 8.3). 
Установите единицы черчения как mm. 
   Магнитные стенки означают, что тангенциальные составляющие магнитных 
волн справа и слева стенок равны. Таким образом, бегущие по такому 
волноводу волны будут многократно повторяться (дублироваться) по оси x. 
Такое расположение электрических стенок будет означать, что, моделируя 
только волноводный ствол, показанный на рис. 8.3, электромагнитные волны в 
этой области будут такие, как будто мы имеем дело с двумя плоскостями 
бесконечного размера вдоль оси X. Но что касается возбуждения разных типов 
волн, то не все типы волн будут моделироваться в бесконечных параллельных 
плоскостях.  А вот волна типа TEM, возбуждаемая в волноводе, будет 
периодически дублироваться вдоль оси X. 
 

 
8.3.1. Создание параллельных плоскостей волновода 

 
    Создадим волновод командой “Draw -> Box”. Размеры бокса (рис. 8.3) вве-
дем в диалог свойств численно (рис. 8.4). 

 
Рис. 8.3. Отрезок волновода в трехмерной системе координат  

 
    Введите координаты первой точки бокса: x = 0, y = 0, z = 0, переводя данные 
из одного окна в другой клавишей TAB. Затем, после нажатия на “Enter”, вве-
дите размеры бокса dx = 30 мм (ширина волновода), dy = 18.75 мм (высота 
волновода), dz = -100 мм (длина волновода) и нажмите  “Enter”. 
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Рис. 8.5. Диалог черчения трехмерного бокса волновода 

      После нажатия на Enter, появится окно свойств “Properties” созданного 
бокса (рис. 8.5). Используя закладку “Attribute”, измените имя бокса на  
“PPWG” и прозрачность бокса “Transparent” = 0.6.  
      После черчения бокса, нужно задать материал заполнения и граничные 
условия на стенки, командой “HFSS -> Boundaries -> Assign -> Perfect E”. С 
другой стороны, можно задать эти границы как внешние с идеальной 
проводимостью (outer).  
      

8.3.2. Задание многомодовых портов 
 
    HFSS позволяет рассчитать многомодовую матрицу рассеяния, а также 
выделить в волноводном тракте основную, а также высшие типы волн. Это 
становится особенно важным, когда в дальнейшем расчете нужно учитывать 
высшие типы волн. 
   На рис.8.6 первые моды волновода показываются, сортируя их по частоте 
среза. Число распространяющихся типов волн изменяется из-за выбранного 
частотного диапазона. Как правило, число типов волн, которые нужно задать в 
волноводном порту должно быть равно, по крайней мере, числу 
распространяющихся типов волн. Реактивные, возникающие из-за 
неоднородностей типы волн будут отражены портом.  

   

Рис. 8.6. Типы волн в прямоугольном волноводе 
 
     Кратные волноводные моды могут преобразовывать энергию друг в друга в 
неоднородностях структуры. Из-за этого, на S параметры влияют также 
нераспространяющиеся типы волн.  
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    Для того, чтобы задать волноводный порт, выберите вертикальную 
поверхность (плоскость xy  при z = 0 mm)  волновода (рис. 8.6) и задайте  
команду  “HFSS -> Excitations -> Assign -> Waveport”.  
     Вы увидите окно ассистента “WavePort: General”. Кликните “Next” чтобы 
увидеть окно  “WavePort: Modes”.  В текстовом боксе “Number of Modes” 
(количество типов волн), введите  3 и кликните “update”. Теперь будет виден  
список трех типов волн. 
 

 
Рис 8.6. Выбор плоскости для задания порта и количества типов волн в его 
сечении 
 
      Кликните столбец  “Integration line” для первого типа волн (Mode 1) и 
выберите  “New Line”  из опускающего меню. Введите  x = 15 mm, y = 18.75 
mm, z = 0  и нажмите  “Enter”, переведите в режим  приращений, затем 
введите  dx = 0 mm, dy = -18.75mm, dz =0 mm и нажмите  “Enter”. Таким 
образом, будет задана интегральная линия для первого типа волн. 
      Для задания интегральной линии для второго типа волн (Mode 2) введите x 
= 10 mm, y = 6 mm, z = 0, нажмите  “Enter”. Далее введите dx = 0 mm, dy = -6 
mm, dz =0 mm и нажмите  “Enter”. Теперь определена  интегральная линия 
для второго типа волн (рис. 8.7). 
     Для режима Mode 3, кликните столбец “Integration line” и выберите “Copy 
from Mode 2”. Третий тип волны возбуждает тоже стоячую волну, которая 
имеет одну вариацию, но по другой оси. 
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Рис. 8.7. Интегральные линии для 
первого и второго типа волн 

 

Рис. 8.8.  Установки для пост-
процессорной обработки 

результатов расчета (отключение 
перенормализации всех типов волн 

на 50 Ом) 
 
      Столбец “Integration line” для всех типов волн должен показывать 
“defined” (линия определена). Кликните “Далее” в окне “WavePort: Modes”  и  
“Готово” в окне “WavePort: Post Processing” (рис. 8.8). 
 

 
 

8.3.3. Расчет характеристик отрезка волновода 
 
      Выберите  команду “HFSS -> Analysis Setup -> Add Solution Setup”. 
Появится окно “Solution Setup” (рис. 8.9). В окошке частоты решения 
(Solution Frequency) введите  “10 GHz”. В разделе Maximum Number of 
Passes ведите “0”. Это будет означать, что адаптивный поиск решения 
выполняться не будет, а расчет будет выполнен только для начальной сетки 
разбиения на тетраэдры. 
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Рис. 8.9. Установки на 
решение 

Рис. 8.10. Выбор частотного диапазона 
анализа 

 
 
     Выберите команду “HFSS -> Analysis Setup -> Add Sweep. В окне  
“Solution Setup” выберите “Setup1” и кликните OK. Появится окно “Edit 
Sweep”. 
     В окне  Edit Sweep, введите следующие опции (рис. 8.10): 
 

Sweep type: Discrete Frequency Setup 
Type: Linear Step 
Start: 3 GHz 
Stop: 12 GHz 
Step: 1 GHz 

 
     Отметьте опцию “Save Fields (All Frequencies)”, чтобы сохранить решения 
для электромагнитного поля на всех частотах. Это нужно делать, если нужно 
получить частотные зависимости характеристик дальнего поля от частоты. 
     Кликните “OK” для завершения установок на расчет. 
 

8.3.4. Просмотр результатов расчета 
 
     Проверим правильность создания конструкции проекта и всех установок 
(нажимая иконку ), и запустим моделирование командой “HFSS-> Analyze 
” (или нажатием на кнопку ).  
     Когда моделирование выполнено, появится сообщение “ Normal 
Completion of Simulation on Server”. 



 154

      В дереве проекта, кликните на символ “+” чтобы раскрыть данные. Рас-
ширьте данные в парке “Ports Field Display -> WavePort1”.  Вы увидите типы 
волн в сечениях портов, перечисляя Mode 1, Mode 2 и Mode 3 в разделе  
Waveport1 (рис. 8.11).  
      Рассмотрим  распределения поля в сечении порта для различных типов 
волн  (TEM, TM01 (H01)или TM10 (H10)). 
 

  
 

Mode1 (TEM- волна) Mode2 (H01) Mode3  (E10) 

Рис. 8.11.  Распределение типов волн в сечении порта волноводного сечении (в 
параллельных пластинах) прямоугольного волновода 

 
     На средней и правой части рис. 8.11 можно видеть, что смещенные линии 
возбуждения моды 2 и моды 3 имеют одинаковую амплитуду напряженности 
электрического поля. Это поясняет, почему мы просто дублировали 
возбуждение 2 и 3 типы волн. 
     Выполним расчет характеристического импеданса для режима TEM 
используя формулы и сравнивая с рассчитанным на HFSS (235.45 Ом). 
 

 
Рис.  8.12. Рассчитанные характеристические импедансы  отрезка волновода 
по 1 (TEM),2 и 3 типу волн 
 
   Известно, что характеристические сопротивления волновода можно рассчи-
тать, используя токи, напряжения на стенках волновода и мощности в 
сечении: 
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     где    а – размер по оси x,    b – размер по оси y. 
 
      Для волновода второе определение наиболее соответствует эксперимен-
тальному методу измерения (в этом случае измеряется мощность и напря-
жение) и будет применяться нами в дальнейшем. Подставив в (8.2) выражение 
для постоянной распространения Kz  [2], получим для волновода, заполнен-
ного воздухом, 
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длина волны в волноводе находится, через длину волны в свободном прост-
ранстве и критическую длину волны,  следующим образом: 
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   В этой формуле критическая длина волны, связанная с шириной волновода 

m
а

с
2

=λ ,  где m – номер типа волн. Пусть ширина волновода a=3 см   (8.6). 

Для m=1   )5(6 GHzсмс =λ , 

Для m=2   )10(3 GHzсмс =λ . 
    Ниже критической частоты сигнал через прямоугольный волновод не 
проходит. С увеличение частоты становится распространяющейся первая 
мода, вторая, и т.д. 
    Длина волны в свободном пространстве 
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Тогда для первой моды (m=1) с частотой 5 ГГц получаем длину волны в 
волноводе  
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Рис. 8.13. Различные характеристические сопротивления для различных 
типов волн, при установке типов характеристических импедансов Zpi 
       
    Изменим граничные условия, снимая PerfectE и PerfectH. Тогда все стенки 
станут металлом. В этом случае от параллельных плоскостей мы переходим к 
волноводу. Частотная характеристика такого отрезка волновода показана на 
рис. 8.14. 

 

 
Рис.  8.14. Зависимость параметра S12  для волновода шириной 30 мм  
 
     Из характеристики рис 8.14 видно, что частота, соответствующая крити-
ческой длине волны, равна 5 ГГц, что соответствует расчету. 
 

           8.4. Микрополосковая линия 
 
   Микрополосковая линия это наиболее распространенная линия, 
используемая при создании интегральных структур СВЧ. Этот тип линии - 
относительно сложный с электромагнитной точки зрения: она открытая с 
одной стороны и может считаться антенная. С другой стороны, такая 
структура требует связи поля в подложке и над микрополосковой линией. 
    Микрополосковую линию можно возбуждать дискретным портом, однако 
для большей точности, возбуждение микрополосковой линии выполняется 
волноводным портом, устанавливаемом в сечении (рис. 8.15). Рассмотрим, как 
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выбрать размеры волноводного порта, и как от размеров зависят рассчитанные 
характеристики отрезка микрополосковой линии. 
    Ширина микрополосковой линии  = 2.01 mm, толщина подложки 0.762 мм. 

 
Рис. 8.15. Структура отрезка микрополосковой линии 

 
     Параметры подложки: диэлектрическая проницаемость εr=2.94, тангенс 
диэлектрических потерь = 0.0012, толщина подложки h = 31 mils (0.762 mm). 
Толщина металлизации меди = ¼ oz (~ 9 microns) 
 

8.4.1.Черчение подложки 
 
     Выберите команду “Draw -> Box” на инструментальной линейке. Для ввода 
используем  окно ввода координат в окне статуса. 
    Введите  x = -30 мм, y = 0, z = 0 (рис. 8.16) и нажмите  “Enter”; далее введи-
те dx = 60 мм, dy = 15 мм, dz = - 0.762 мм и нажмите  “Enter”. 
 

 
Рис. 8.16. Параметры проводящей линии 
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       В окне свойств  “Properties”, в разделе Attribute можно изменить имя бок-
са, и можно сделать подложку прозрачной для просмотра, установив " Trans-
parent " равным 0.5.  

 
Рис. 8.17. Подложка для микрополосковой линии 

 
       Сделайте щелчок левой кнопкой мыши на боксе подложки и выберите из 
выплывающего меню команду Assign Material. Появится окно "Select 
Definition". 
   Добавьте новый материал, нажимая кнопку “ Add Material ” внизу этого 
окна. Теперь, нажмите на " View/Edit ". Напечатайте “Duroid6002” для имени 
материала, измените относительную диэлектрическую постоянную на 2.94 и 
величину тангенса угла потерь на 0.0012. Другие параметры оставим по 
умолчанию. 

 
Рис. 8.18. Окно задания параметров нового материала 
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8.4.2.Черчение микрополосковой линии 
 
     Выберите “Draw -> Box” в инструментальной линейке. Далее будем 
использовать окно ввода координат в системе xyz. 

 

 

Рис. 8.20.  Микрополосковая линия 
 

Рис. 8.19. Параметры проводящей 
полоски микрополосковой линии

 
      Введите x = -1.005, y = 0, z = 0 (рис. 8.19) и нажмите “Enter”, а затем вве-
дите dx = 2.01, dy = 15, dz = 0.009 и нажмите  “Enter”. В окне “Properties” 
измените имя бокса и выберите величину прозрачности “ Transparent”  
(например 0.5). 
     Выберите медь (cooper) как материал линии, нажимая кнопку Material в 
закладке Attribute. Таким образом, линия была создана как трехмерный 
объект. 

Рис. 8.20. Микрополосковая плата, охваченная боксом с разбиением 
пространства  на тетраэдры 
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8.4.3.Черчение  земляной платы 
 
     Земляная плата находится на противоположной от микрополосковой линии 
стороне подложки. Выберите команду  “Draw -> Box”.  Выполним ввод ее 
координат по точкам.  Задайте материал полоски медным. 
      Введите  x = -30, y = 0, z = -0.762 (рис. 8.21) и нажмите  “Enter” и затем 
введите dx = 60, dy = 15, dz = -0.009 и введите  “Enter”. В окне “Properties”, 
вы можете изменить имя бокса и величину прозрачности “Transparent” = 0.5. 
 

 
Рис. 8.21. Параметры земляной подложки 

   Таким образом, как линию, так и земляную подложку задаем конечной 
толщины. Это требует аккуратного задания порта, интегральная линия не 
должна пересекать металлические части объектов. Отметим, однако, что 
можно задать проводящие свойства земляной подложки и с помощью 
граничных условий. 
 

8.4.4. Задание многомодового порта для возбуждения 
микрополосковой линии 

 
      Возбуждение микрополосковой линии выполняется волноводным портом, 
который возбуждает волны над микрополосковой линией и в подложке. 
Поэтому для возбуждения микрополосковой линии используется волноводный 
порт.  
    Когда волноводный порт подключается к микрополосковой линии, или 
какой- либо линии с квази-TEM волной, мы должны выбрать область связи 
или размер волноводного порта (рис. 8.22).  Основной вопрос: насколько 
большой должна быть эта область? 
    Вообще, очень важно выбрать размер порта. С одной стороны, порт должен 
быть достаточно большим, чтобы охватить значительную часть 
микрополосковой линии и  квази - TEM волны. С другой стороны, размер 
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порта не должен быть выбран слишком большой, потому что это может 
заставлять выше волноводные моды порядка распространяться в порте. 
    Следующие рис. показывают основной тип волны в микрополосковой линии 
и типы волн более высокого порядка. 

 

  

Основной тип волны Высшие типы волн 
  

    Высшие типы волн микрополосковой линии похожи на высшие типы 
волн в прямоугольных волноводах. Это можно объяснить тем, что по 
периметру порта автоматически добавлена граница волновода. Граничные 
условия в гранях порта будут автоматически адаптированы согласно 
трехмерной модели. Этот корпус вокруг порта заставляет порт вести себя 
подобно прямоугольному волноводу и таким образом определяет типы волн 
более высоких  порядка. 
     Порт большего размера имеет более низкую критическую частоту этих 
типов волн. Так как более высокие типы волн несколько искусственны, они 
не должны рассматриваться в расчете. Поэтому, размер порта должен быть 
выбран достаточно малый, высшие типы волн не могли бы распро-
страняться.  
     Если высшие типы волн микрополосковой линии, станут распро-
страняющимися, это обычно приводит к крутым выбросам в результатах 
моделирования в частотной области. С другой стороны, выбор размера 
порта слишком малым вызовет снижение точности расчета S - параметров 
или даже неустойчивости  решающего устройства. Как правило, размер 
порта должен быть выбран как на рис. 8.22. 

         
Рис. 8.22. Размеры волноводного порта, возбуждающего микрополосковую 

линию 
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    Начертим прямоугольник, идущий в плоскости XoZ, а затем на него зададим  
волноводный порт. Размеры прямоугольника выберем в пять раз шире 
ширины линии передачи и в четыре раза больше высоты подложки. 
   Высота волноводного порта будет зависеть от диэлектрической проницае-
мости подложки. Чем больше диэлектрическая проницаемость, тем меньше 
полей распространится в воздухе, и высота порта может быть меньше. 
      Импеданс порта будет зависеть от ширины порта и распространяющихся 
типов волн. Чем уже ширина, тем больше полей будут связаны с боковыми 
стенками порта. Этот эффект может не быть физически реализуемый. Чем 
шире порт, тем большая вероятность, что типы волн с большей частотой будут 
распространяться по волноводу. 
 

 
Рис. 8.23. Распределение поля в плоскости порта(5 мода) 

 
   В линейке инструментов выберите плоскость “XZ” как плоскость черчения. 
Выберите “Draw ->Rectangle”. Ввод координат плоскости, на которую ставит-
ся волноводный порт, выполним по координатам в окне статуса. 
     Введите  x = 20 мм, y = 0, z = -0.771мм, затем нажмите  “Enter”. Введите dx 
= -40мм, dy = 0, dz = 7.62 мм  и нажмите  “Enter”. 

 
Рис. 8.24. Задание плоскости для установки волноводного порта, 

возбуждающего микрополосковую линию 



 163

 
     Выделите начерченный прямоугольник и затем кликните правой кнопкой 
мыши на Assign Excitation -> Waveport. Появляется первая закладка задания 
имени порта. Кликните  “Next”. В окне  “Waveport: Modes” , оставьте по 
умол-чанию величину 1 для числа мод и кликните столбец “Integration line” 
для первого типа волн  Mode 1 и выберите  “New Line” из выплывающего 
меню.  
     Введите  x = 0, y = 0, z = 0.009 мм   и нажмите  “Enter” и затем введите  dx 
= 0, dy = 0, dz = -0.780 mm и затем  “Enter”. Теперь интегральная линия  
“Integra-tion line” для типа волны Mode 1 будет определена как линия от 
верхней грани микрополосковой линии до нижней грани земляной подложки. 

 
Рис.  8.25. Сечение волноводного порта и интегральная линия возбуждения 

 
     Итак, мы задали первый порт. Второй порт  на другом конце микрополос-
ковой  линии определяется с помощью аналогичной процедуры. Или перено-
сом порта 1 на 15мм по оси Y.  
      Если задаются несколько, например 5 типов волн, существующих в 
волноводе, то описываются еще 4 типа волн в плоскости волноводного порта. 
Причем интегральные линии для высших типов волн задавать не надо (потому 
что мы оставляем характеристический импеданс для них Zpi). 
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Рис. 8.26. Установка характеристических импедансов различных типов волн 

      
    Второй порт, с другой стороны линии  можно создать копированием порта 1 
и дублированием  его со смещением на длину. 
 

8.4.4.Черчение бокса излучения над микрополосковой 
линией 

 
      Для того, чтобы ограничить объем, в которой будет рассчитываться поле, 
микрополосковую линию необходимо охватить боксом с установленным на 
нем граничным условием излучения Radiate. Выберите команду “Draw -> 
Box” в инструментальной линейке. В окне ввода координат  “Simulation 
Status Window”. 
      Введите  координаты одного угла бокса x = -35, y = 0, z = -10 и нажмите  
“Enter”, затем введите  размер бокса dx = 70, dy = 15, dz= 20 и нажмите  
“Enter”. В разделе Attribute окна  “Properties”, вы можете изменить имя и 
прозрачность этого бокса  (например на  0.8). 
    Нажмите правой кнопкой мыши на этот бокс и выберите  “Assign -> 
Boundary” и выберите “Radiation”. 
     Окончательно,  микрополосковая линия должна выглядеть, как показано на 
рис. 8.27. 
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Рис. 8.27. Окончательный вид микрополосковой линии, охваченной боксом 

излучения 
 
      Чтобы рассчитать параметр S21, необходимо установить 2 волноводных 
порта. Для этого выделим вертикальную стенку вместе с портом и продубли-
ровать ее, перенося на  15 мм по оси y. 
 

8.4.6. Расчет характеристик микрополосковой линии 
        

    Выберите  “HFSS -> Analysis Setup -> Add Solution Setup”. В появившемся 
окне “Solution: Setup” установите частоту решения  “10 GHz”. В раздел 
адаптивного решения, введите величину “15”  как максимальное количество 
итераций, и кликните “Ok”. 
      Выберите “HFSS -> Analysis Setup -> Add Sweep” и установите в окне   
“Edit Sweep” режим интерполяции результатов расчета в диапазоне частот: 
Interpolating . В этом случае между данными, рассчитанными в точках, будет 
выполняться операция интерполяции.  
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Рис. 8.28. Установки выбора режима изменения частоты 

 
      Кликните “Ok” для завершения установки, затем запустите расчет 
командой “HFSS -> Analyze”. 

 
Рис. 8.29. Рассчитанные импедансы и коэффициенты распространения в 
случае многомодового описания волноводного канала распространения  

 
Рис. 8.30. Параметр S11 отрезка микрополосковой линии 

      Просмотрим распределение поля в сечении порта. В дереве проекта 
откройте раздел “Ports Field Display -> WavePort1”. Кликните на  Mode 1 
чтобы увидеть распределение поля в сечении порта.  
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      Выведите распределение поля на порту на частоте 10 GHz и идентифици-
руйте тип волн (TEM, TM01(H01) или TM10 (H10)), рассматривая 
распределение поля (рис. 8.31). 
    Мода 2 будет соответствовать TEM волне,  но как волна, 
распространяющаяся в волноводе – это TE10 (E10). 

 
Рис. 8.31. Сечение поля в портовом сечении микрополосковой линии 

 
     Рассчитайте характеристический импеданс для микрополосковой линии 
(используя формулы или утилиту  ADS LineCalc  или Txline  имеющиеся в 
программе AWR)  и сравните их с результатами, рассчитанными HFSS (рис. 
8.33). 
 

 
Рис. 8.32. Характеристический импеданс микрополосковой линии в диапазоне 
частот 
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Рис. 8.33. Окно программы MWO, в котором рассчитываются 
характеристики микрополосковой линии 
 
      Отметим, что утилита TXLine включает закладки, в которых можно выпол-
нить анализ и синтез (электрических  параметров к физическим) для целого 
ряда планарных линий, от связанных полосковых линий до копланарной 
линии. 
     Далее выведем в двумерный график HFSS частотные зависимости постоян-
ных распространения для различных типов волн (рис. 8.34). 

 
Рис. 8.34. Частотные зависимости постоянных распространения Gamma  для 
разных типов волн  
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8.5. Моделирование копланарной линии 
(копланарного волновода) 

 
          Копланарная линия часто используется как линия передачи на СВЧ. В 
зависимости от того, есть или нет земляной подложки, такой волновод 
называется  копланарная линия с заземлением, и копланарная линия с 
подвешенной подложкой. 
 

  
Копланарная линия без земляной платы Копланарная линия с земляной платой 

  

    К сожалению, этот волноводный тип - относительно сложный с электро-
магнитной точки зрения. Поэтому некоторые моменты должны быть учтены 
при определении портов для этого типа структуры. Многие из объяснений в 
этом подразделе подобны случаю с микрополосковой линией. Однако, мы 
повторим все здесь еще раз для вашего удобства. 

 
 

Типы волн в порту копланарной линии 
 
   Размер порта очень важно выбрать правильно. С одной стороны, порт 
должен быть достаточно большим, чтобы замкнуть значительную часть 
поля компланарной линии. С другой стороны, размер порта излишне не 
должен быть большой, потому что это может заставлять выше волноводные 
моды порядка распространяться в порте. 
    Далее будут показаны фундаментальные четные и нечетные типы волн, а 
также высшие типы волн для незаземленного компланарного волновода. К     
Копланарная линия состоит из центральной линии и экранирующей ее с 
обоих сторон земляных плоскостей (рис. 8.35). 
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Рис. 8.35. Чертеж копланарного волновода (линии с подвешенной подложкой) 

       
8.5.1.Черчение подложки 

 
      Подложка создается командой Draw -> Box  как параллелепипед с длиной 
L = 5 mm (вдоль оси y), шириной W = 10 mm (вдоль оси x), и H = 0.762 mm 
(вдоль оси z).  После черчения курсором, размеры трехмерно подложки можно 
отредактировать в окне (рис. 8.36). 
 

 
Рис. 8.36. Параметры подложки копланарной линии 

 
     Центральный проводник копланарной линии (рис. 8.35) лежит в центре 
подложки и идет по оси Y. Центральный проводник имеет ширину Width = 1.6 
мм; размер зазора = 0.1 мм; толщина меди = 0.009 мм (рис. 8.37). 
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Рис. 8.37. Параметры центральной линии толщиной 9 микрон 

 
8.5.2. Задание порта и интегральной линии 

 
     Для определения размера порта используйте правила, обсуждаемые ранее. 
Волноводный порт должен быть расположен по центру вертикально и гори-
зонтально относительно центрального проводника CPW. Зададим 
интегральную линию для основного типа волн CPW. 
 

8.5.3. Черчение бокса излучения 
 
    Поскольку микрополосковая линия, а также CPW - излучаемые структуры, 
их нужно охватить боксом излучения. Начертим бокс длиной L = 5 mm (вдоль 
оси y), W = 16 mm (вдоль оси x), и H = 10 mm (вдоль оси z) и зададим на нём  
граничные условия “Radiation”. 
 

 
Рис.  8.38. Параметры бокса излучения 

 
    Окончательно, модель  копланарного волновода CPW должна выглядеть как 
на рис. 8.39.  
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Рис.  8.39. Установка порта возбуждения копланарного волновода 

      
    При анализе зададим центральную частоту 10 ГГц. На этой частоте HFSS 
рассчитывает размеры тетраэдральных элементов для разбиения пространства.  
Частотная зависимость параметра S11 показана на рис. 8.40. 

 
 

 
Рис. 8.40. Частотная характеристика копланарного волновода 

 
       Выведем распределение поля на порту на частоте  10 GHz, а также 
рассчитаем характеристический импеданс линии  CPW  (используя формулы 
или утилиты LineCalc или  Txline,  имеющиеся в  AWR, рис. 8.42) и сравним с 
данными, полученными расчетом на HFSS. 
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Рис. 8.42.  Расчет характеристического импеданса копланарного волновод на 
программе TXLINE, входящей в комплекс AWR 

 

8.6. Щелевая линия 
 
      Для возбуждения щелевой линии, поле электромагнитной волны у которой 
сосредоточено между двумя линиями, можно её возбудить, установив диск-
ретный порт в щель, а можно установить два одномодовых порта на две 
отдельные линии порта, т.е. применить метод Terminal Modal. Третьим, 
наиболее точным подходом, можно считать возбуждение щелевой линии с 
помощью волновода (рис. 8.43). 
 

8.6.1. Черчение подложки 
 
    Начертим подложку в виде бокса длиной  L = 5 mm (вдоль оси y), W = 10 
mm (вдоль оси x), и высотой H = 0.762 mm (вдоль оси z). 
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Рис. 8. 43. Установка порта для возбуждения щелевой линии 

 
 

   Выполним черчение проводников щелевой линии с размерами:  
 

Размер щели = 0.17 mm, 
Толщина меди = 0.009 mm. 

 
Задайте материалы подложки и проводников. 
 

8.6.2. Определения порта и интегральной линии при 
возбуждении щелевой линии 

 
      Задайте прямоугольник размером  10 mm по x и 8 mm по z, на который 
будет устанавливаться волноводный порт.  
     Волноводный порт будет центрирован вертикально и горизонтально отно-
сительно щели или провала щели (или выступа). Задайте возбуждение 
“Waveport” и интегральную линию для основного типа волн щелевой линии 
(рис. 8.44). 
    Альтернативой такого возбуждения можно считать возбуждение с помощью 
дискретного порта, который ставится на прямоугольник, начерченный в 
сечении щелевой линии. 
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Рис . 8.44. Установка волноводного 
порта и интегральной линии щелевой 

линии для высших типов волн

Рис. 8.45. Задание нечетных 3 и 5 
типов волн 

 
 
     Для того, чтобы задать нужное распределение щелевой линии, нужно 
задать нечетные моды (рис. 8.45). 

 

 

Рис. 8. 46. Вторая мода Рис. 8.47. Третья мода 
 

    В качестве упражнения, просмотрите распределение поля в щелевой линии 
на порту на частоте 10 GHz (рис. 8.46, 8.47), а также рассчитайте характе-
ристический импеданс щелевой линии (используя формулы или утилиту Txline  
из  AWR) и сравните с рассчитанным на HFSS. 
 

8.7. Возбуждение диэлектрического волновода 
         
   Правильное возбуждение диэлектрического волновода позволит сравнить 
теоретические расчеты характеристик с расчетом на HFSS, что дает уверен-
ность в точности анализа и более сложных диэлектрических структур.  
   Анализируемая конструкция (рис. 8.48) представляет собой открытый 
резонатор, образованный двумя плоскими металлическими зеркалами и 
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отрезком регулярного диэлектрического волновода, связанного через «щели» с 
отрезком полого металлического волновода стандартного сечения. 
    Важной задачей является расчет дисперсионных характеристик (зависимос-
тей относительной продольной постоянной распространения kz/ko =U от 
частоты ω или обратной зависимости ω от U) собственных волн открытых 
металлодиэлектрических структур или диэлектрических волноводов и 
структуры поля его. 

 
Рис. 8.48. Включение отрезка диэлектрического волновода между отрезками 

волновода 
 

  Диэлектрический волновод возбуждается щелью с переменной толщиной. 
Согласование диэлектрического волновода можно выполнить смещением 
щели относительно центральной оси волновода. 

Рис. 8.49. Возбуждение щели двумя 
модами волн 

Рис. 8.50. Первый тип волны в 
сечении порта
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Рис.  8.51. Параметры конструкции диэлектрического волновода 

 
   Выполняется расчет частотной характеристики |S21|(ω)  или L – длины 
отрезка волновода. 
     На резонансе вдоль диэлектрической линии укладывается целое число 
полуволн, что можно записать как Nλв =2L. Это является основой операцией 
для нахождения постоянной распространения линии. 
     С помощью параметрического анализа нужно изменять длину L до тех пор, 
пока вдоль диэлектрического волновода не будет укладываться целое число 
волн (рис. 8.52). 

 
Рис. 8.52. Распределение поля в отрезках металлического волновода и 
диэлектрическом волноводе (в данном случае частота 66.8 ГГц) 
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    После этого находится постоянная распространения по углу S21, как 
величина фазового сдвига сигнала относительно длины L. Просмотр поля 
позволяет убедиться в том, что электромагнитное поле прижимается к 
диэлектрическому волноводу и резко спадает при удалении от него. 
     Итак, в этом разделе мы рассмотрели построение и анализ характеристик 
нескольких типов линий. Возбуждение линии, структуры, постановка 
источника возбуждения является одним из важных вопросов, о постановки 
которых зависит точность решения, и решать его нужно, просматривая поле в 
сечении порта и сравнивая с физическим представлением. 
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9. Расчет щелевой антенны типа «Бабочка»  
 

   В этом разделе начертим и выполним анализ планарной антенны, которая 
состоит из напыленной с одной стороны металлического слоя в форме 
«Бабочка» (рис. 9.1). Антенна, состоящая из щелей с переменной шириной, 
запитывается щелевыми линиями, которые называются копланарными 
волноводами. В качестве источника возбуждения копланарного волновода 
используется дискретный порт Lumped Port.  

 
Рис. 9.1.  Антенна типа бабочки, запитываемая по копланарному волноводу 
 
      Порт включен между двумя  линиями. В этот разрез может быть включен 
чип, либо внешняя линия, подводящая мощность к антенне. Антенна должна 
работать  в диапазоне частот от 8 до 12 GHz.  
    Запустите HFSS и выберите опции расчета. Для этого используйте команду 
Tool > Option > HFSS Option.  Появляется окно HFSS Option (рис. 9.2), в 
котором:  
1. Откройте закладку General . Используйте ассистент (Wizards) для ввода 
данных при создании новых граничных условий отметьте галочки в разделе 
Clone (рис. 9.2), чтобы дублировать границы вместе с геометрией и кликните 
OK. 
  
3. Выберите команду меню Tools > Options -> 3D Modeler Options.  
4.  В окне 3D Modeler Options установите следующие опции:  
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Рис. 9.2.Установки для создания 
полигонов 

Рис. 9.3. Установки для 
редактирования свойств  новых 
примитивов 

 Отметьте в  закладке Operation опцию для автоматического замыкания 
полигонов, при черчении их как многополюсников (рис. 9.2), затем откройте 
закладку Drawing, и откройте в ней опцию редактирования свойств новых 
примитивов (рис. 9.3). Кликните OK.  
 

9.1. Создание  нового проекта 
 

Создадим новый проект командой  File > New. Назовем проект именем 
Bowtie. В меню Project  выберите Insert HFSS Design (новая конструкция, 
которых может быть несколько в одном проекте). Далее вберем тип решения 
командой    HFSS > Solution Type. Появляется диалог (рис. 9.4), в котором 
нужно выбрать тип решения.  

 
Рис. 9.4. Окно выбора метода решения: расчет многомодовых характерис-
тик, расчет нагрузочных характеристик и расчет собственных резонансных 
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частот 
    
    От типа решения (Solution Type) зависят возможные рассчитываемые 
характеристики, а также задание источников возбуждения.  В HFSS имеются 
следующие типы решений: 
 
Driven Modal  - рассчитываются многомодовые S-параметры.  S-матрица 
будет находиться по падающим и отраженным мощностям волноводных типов 
волн.  
Driven Terminal  - Вычисляет - S-параметры многопроводных линий 
передачи. В этом режиме в одном сечении конструкции, например, связанных 
линий, можно задавать разные, но одномодовые источники возбуждения.  S-
матрицы  будут получены по рассчитанным напряжениям и токам на зажимах. 
Eignemode  – расчет собственных типов волн, резонансов структуры. В этом 
решении находятся резонансные частоты структуры и поля, при которых 
имеются эти резонансные частоты.  
 
     Установим единицы единицы, в которых будет чертиться проект, командой 
3D Modeler > Units. Установите единицы  mm  и нажмите OK (рис. 9.5). 

 
Рис. 9.5. Установка единиц для черчения модели 

 
9.2.Черчение подложки антенны 

 
     Металлические формы антенны удобно чертить на плоскости  xy,  проходя-
щей через начало координат. Поэтому подложку создадим так, чтобы ее верх-
няя грань шла по плоскости XoY. Для этого: 
 

1. Выберите команду меню Draw->Box 
2. Используя поля ввода координат, введите координаты X= -17.0,  Y= -32,  

Z= 0.0.  Нажмите Enter. 
3. Используя поля ввода координат, введите противоположный угол бокса:   

dX= 34.0, dY= 64.0,  dZ= -2.0. Нажмите Enter. 
4. Имя и параметры черчения устанавливаются в закладке Attribute в диа-

логе Properties (рис. 9.6). 
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Рис. 9.6. Диалог редактирования геометрических параметров подложки 
 
     В закладке Attribute напечатайте имя  подложки в разделе Name:  Sub1. 
Кликните OK. Чтобы согласовать размер окна и изображения, выберите 
команду меню View -> Fit All -> Active View. Или нажмите CTRL + D. 

 
 

 
Рис. 9.7. Начерченная  подложка под антенну-бабочку 

 
 

9.3. Черчение подводящей линии 
    Чтобы создать площадку, на которой будет располагаться дискретный  
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источник излучения: 

1. Выберите команду меню Draw > Rectangle. 

2. Используя поля ввода координат, введите координату первого угла: 

     X= -0.5,   Y= 0.5,   Z= 0.0  и нажмите Enter. 

3.  Используя поля ввода координат, введите размеры прямоугольника: 

     dX=13.0,   dY =  0.6,   dZ= 2.0 и нажмите на Enter. 

     Появляется диалог (рис. 9.8), в котором можно откорректировать 
размеры линии, идущей вертикально. Введите имя Rect1 в закладке 
Attribute. 

 

Рис. 9.8. Параметры прямоугольника, на котором будет создаваться 
входной источник 

   Далее начертим форму антенны-бабочки и линии между входным источ-
ником и антенной, для чего: 

1. Выберите команду черчения многоугольника Draw -> Line. Установите 
первую точку с координатами X= -0.5,  Y= 0.5,  Z= 0.0. 

2. Используя боксы ввода координат, введите вторую вершину 

     X= -6.0,  Y= 21.0,   Z=0.0 и нажмите Enter. 

3. Введите координату следующей точки: 

     X=6.0, Y= 21.0, Z=0.0 , нажмите Enter,  затем введите- координаты 
следующей точки   X= 0.5,  Y=1.1,  Z= 0.0 и нажмите на Enter. 

4. Дважды нажмите на конечную точку для замыкания полигона, а затем 
задайте имя этому многоугольнику (рис. 9.9)  Bowtie. 
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Рис. 9.9. Линия и вибратор в форме треугольника 

    Отметим, что сложные формы можно создавать объединением отдельных 
форм, а можно чертить в одном процессе как многоугольник, используя 
команду Draw -> Line. 

9.4. Объединение линии питания и бабочки 

      Чтобы выбрать объекты Bowtie и Rect1, выделите имя Bowtie  и Rect1  в 
разделе Unassigned (с незаданным материалом). 
     Выберите команду меню 3D Modeler > Boolean > Unite. Объединенный 
объект сохранится под именем первой начерченной части антенны (Bowtie).    
Чтобы создать другую сторону бабочки, используем зеркальное отображение. 
Для этого выберите объект Bowtie  из дерева хронологии, а затем: 
1. Выберите команду меню  Edit -> Duplicate … > Mirror. 
2. Установите начальную точку вертикали, нормальную к подложке: 
координаты Z, Y, Z. 
3. Установите конечную точку вертикали, относительно которой будет 
выполняться зеркальное отражение, используя приращение координат dX,  dY,  
dZ (рис. 9.10). 
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Рис. 9.10. Параметры оси, относительно которой выполняется зеркальное 
отражение одной части щели антенны 
 
       Теперь необходимо оставить металл везде, кроме формы антенны. 
Создадим поверхность, лежащей на подложке и назовем его CuClad. 
      Чтобы вычесть Bowtie  из  CuClad, выберите объект  Bowtie,  Bowtie_1  и   
CuClad  из дерева 3D Modeler Design Tree (рис. 9.11). 

 
Рис. 9.11. Вычитание из объекта CuClad  двух объектов Bowtie и Bowtie_1 

 
 
3. Чтобы создать антенну в виде щели, выберем команду меню  3D 
Modeler > Boolean > Substract. 
 
     В левом окне диалога Substrate поместите CuClad, в правом Bowtie и 
Bowtie_1. Нажмите OK.. 
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Рис. 9.12. Вырезание внутренней части антенны бабочки 
      
     Выполним установки для решения антенны. На первом этапе  расчета все 
металлические поверхности будут разбиваться на тетраэдры.  Задание на 
разбиение на ячейки выполняется следующим образом: 
 

1. Выберите объекты Bowtie и Bowtie_1. 
2. Задайте команду в меню HFSS > Mesh Operation>Assign>On 

Selection>Length Based. Появится диалог (рис. 9.13). 
3. Выберите размер Maximum Length of Elements (максимальная длина 

ячейки) в окне.  
 
    Дадим имя опции разбиения Length1 и отметьте галочку режима «Restrict 
Length f Elements». Установим максимальную длину элемента: 3 mm.  
    Не отмечайте режим ограничений количества тетраэдров «Restrict  the 
Number of Elements». 
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Рис. 9.13. Выбор элемента для установки плотности разбиения при 
мешировании 

 
    Напомним, что антенна-бабочка сделана из меди, что будет отражаться 
созданием граничных условий Finite Conductivity. 
  

9.5. Адаптивное разбиение на ячейки 
 
     Адаптивное разбиение на ячейки состоит из разбиения, которая уже дает 
характеристики устройства. Используя процесс адаптации, она автоматически 
настраивается, чтобы получить наиболее эффективное разбиение на ячейки. 
         Адаптивный процесс  алгоритма разбиения на ячейки ищет области с 
самыми большими изменениями электрического поля, и делит стороны 
тетраэдров в этих областях. Чаще всего этими целями становятся края 
проводника, как места, куда добавляются  дополнительные элементы. 
      Уплотнение разбиения на ячейки  на каждом адаптивном проходе управля-
ется опцией Maximum Refinement Per Pass в установках на решение (заклад-
ка Options), рис. 9.14.  
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Рис. 9.14. Страница установки опций разбиения на ячейки 

 
    Заметим, что опция Maximum Refinement Per Pass устанавливается в 
процентах. 20% означает, что между каждым проходом разбиение уплотняется 
на 20% и приближает сходимость. 
     На каждом шаге итерации выполняется расчет поля, затем расчет S 
параметров. После каждого адаптивного прохода, HFSS сравнивает S 
параметры, полученные на текущем шаге разбиения и результаты, которые 
были получены на предыдущем разбиении. Если результаты не изменились 
определенным значением пользователя или Delta S, то решение сходится, и 
текущее разбиение может использоваться, для выполнения расчета в 
диапазоне частот. Если решение сходится, то раннее разбиение столь же 
хорошее, как разбиение текущее. В этом случае, HFSS будет использовать 
предыдущее разбиение, чтобы выполнить расчет в полосе частот, если это 
требуется. 
    Параметр Delta S (рис. 9.14) – это критерий, используемый для определения 
сходимости по разбиению на ячейки и решения.  Delta S определен как макси-
мальное изменение в величине S параметров между двумя последовательными 
проходами: 
    Маx Sij [Мag (S N ij  (N1) ij)], где i и j  перечисляют все элементы матрицы, N 
представляет число проходов. Так как это - модуль вектора, то эта величина 
может изменяться между 0 и 2. 
 

      9.6. Создание дискретного порта 
 
    Чтобы начертить прямоугольник, в котором будет устанавливаться порт 
(рис. 9.15): 
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1. Выберите команду меню Draw > Rectangle.  
2. Установите первый угол прямоугольника:  X= 12.5 , Y= -0.5 , Z= 0.0. 
3. Начертите  прямоугольник, вводя его размеры на противоположных 
вершинах бокса:  

dX= -1.0 , dY= 1.0 , dZ= 0.0.   
     Чтобы задать имя прямоугольника, откройте закладку Attribute в окне 
Properties.  
 
1. Введите имя Value Name  как P1  
2. Кликните OK. 
 

 
Рис.  9.15. Создание дискретного порта в щели линии с подвешенной 

подложкой при питании антенны 

    Чтобы установить дискретный порт на этот прямоугольник: 

1.  Выберите в меню команду HFSS > Exitations>Assign>Lumped Port. 
Откройте закладку Lumped Port: General, задайте имя порта Port 1, уста-
новите импеданс порта равным 50 Ом, реактанс 0 Ом и нажмите  Next. 

    В разделе типов волн, установите :  
1. Число типов волн Number of Modes =1 ,  
2. В строке Mode 1 , кликните  None; в строке Integration Line выберите 
New Line . 
3. Используя поля ввода координат, введите положение вектора  

X= 12.5 , Y= 0.0 , Z= 0.0 и нажмите Enter. 
4.Используя ввод координат, введите приращение вектора интегральной 
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линии dX=-1.0, dY=0.0, dZ=0.0 и нажмите Enter. 
 
   Далее установим материал по умолчанию, в качестве которого выберем 
вакуум.  Анализ будем выполнять в диапазоне частот 8 -12 ГГц. Минимальное 
расстояние между стенками воздушного объема и излучаемой апертурой 
должно быть одно четверть длины волны на частоте 8 ГГц, или 0.25*(3e11/8e9) 
= 9.375 mm. Выбираем расстояние вокруг антенны, равной 9.5 мм. 

 

     9.7. Создание воздушного бокса вокруг антенны 
 
     Для того чтобы рассчитать характеристики антенны, необходимо ее 
окружить боксом излучения AirBox (рис. 9.16) и ввести его поверхность в 
список поверхностей, на которых интегрируется дальнее поле антенны. Для 
этого: 
 
1. Выберите команду Draw > Box 
2. Используя поля ввода координат, введите начальную точку 
                X= -17.0, Y= -32.0,  Z= -9.5 и нажмите Enter. 
    Введите диагональный угол  с помощью ввода dX= 34.0, dY= 64.0, dZ= 19.0 
и нажмите Enter.  

 
Рис.  9.16. Вид антенны-бабочки в боксе излучения 

 
      Чтобы задать поверхность излучения, выделите бокс и в выплывающем 
меню выберите команду Assign Boundary > Radiation.  Затем выполним 
установки для расчета дальнего поля, для чего: 
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1. Выберите команду меню HFSS > Radiation >Insert Far Field Setup 

>Infinite Sphere 
2. Откроется диалог установки параметров сферы излучения, в которой: 
3.  Выберите закладку Infinite Sphere (рис. 9.17) и установите в ней: 

 
        Name:   ff_all 

Phi: (Start= -90, Stop= 90, Step Size=10) 
Theta: (Start=0, Stop=360, Step Size= 10) 

 
Рис.  9.17. Установка углов для расчета поля в дальней зоне 

    Теперь подготовим задачу для запуска на решение. Для этого установим  
параметры анализа антенны, для чего: 

1. Выберите команду меню HFSS>Analysis Setup>Add Solution Setup, 
2. В  появившемся окне Solution Setup установите частоту, на которой будет 
выполняться разбиение на ячейки  Solution Frequency = 10 GHz, 
максимальное число уплотнений разбиения на ячейки Maximum Number of 
Passes = 6     и критерий окончания уплотнения Delta S per Pass = 0.01.  
Кликните  OK. 
 

Для того, чтобы добавить расчет антенны в диапазоне частот: 
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1. Выберите команду меню HFSS > Analysis Setup > Add Sweep . Выберите 
установку решения: Setup1 и кликните OK 
2. В окне Edit Sweep:  

 ‐Установите тип изменения частоты Sweep Type: Fast 
-Установите диапазон частот с равномерным шагом, типа Linear Step,  

Start=   8.0 GHZ,   Stop=  12.0 GHz, Step= 0.02, Save Fields: поставьте галочку в 
окошке: V.  

4. Кликните OK . 
 

 
Рис. 9.18. Распределение поля на поверхности антенны-бабочки 

 
  Запустите задачу на решение, что удобно сделать, нажимая знак «!» на 
панели HFSS. Тангенциальная составляющая электрического поля на 
металлической поверхности антенны показывается на рис. 9.18. Чтобы видеть 
вывести численные данные, получаемые в процессе решения: 

1. Выберите команду HFSS>Results>Solution Data 

2. Чтобы увидеть файл счета Profile, в котором перечисляются счетные 
затраты на выполнение каждого шага решения. 

3. Чтобы увидеть  процесс сходимости, откройте  закладку Convergence. 
По умолчанию данные расчета даются в табличном виде. Выберите Plot, 
чтобы увидеть процесс сходимости в графическом виде.  

     Чтобы видеть данные в виде рассчитанной матрицы, откройте закладку 
Matrix Data. Матричные данные изменяются от итерации к итерации, что 
можно видеть, установив опцию  Simulation на  Setup1, Last Adaptive во время 
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моделирования.   Кликните кнопку Close когда просмотр результатов 
закончен.  

9.8. Вывод частотных характеристик S-параметров. 
 
    Антенна характеризуется, прежде всего, антенными характеристиками: 
диаграммой направленности, поляризацией, шириной луча излучения. Однако 
поскольку антенны – это однопортовое устройство, то и частотные харак-
теристики ее параметра S11 можно вывести на график или в таблицу. 
 
      Для представления этих характеристик: 
 
1.      Выберите команду меню HFSS>Results>Create Report 
1. Создайте окно, в которой выведется сообщение: 
2. Напечатайте сообщение Modal S Parameters, 
3. Тип вывода: Rectangular, 
4. Кликните OK. 
 
Выберите тип характеристик: 
 
1. Решение, полученное на этапе Setup1: Sweep1, 
2. Область решения Sweep, 
3. Нажмите на закладку Y и выберите в Category:  S Parameter, 
          Модуль  S(Port1, Port1), 
          функцию dB и кликните Add Trace, а затем нажмите Done. 
 
     Выберите в меню команду Report 2D > Mark All Trace. 
    Кликните кнопку Min, чтобы увидеть точку наилучшего согласования (рис. 
9.19). 
    Кликните правой кнопкой мыши на график и выберите Exit Marker Mode. 
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Рис. 9.19. Частотная характеристика антенны типа бабочка 

 
    Подобным образом выведем на прямоугольный график реальную и мнимую 
части входного импеданса антенны (рис. 9.20).  

 
Рис. 9.20. Реальная и мнимая части входного импеданса антенны-бабочка 
 
     Отметим, что график, показанный на рис. 9.20 является основой для 
оптимизации антенны и согласования ее с характеристическим сопротив-
лением подводящей линии. 
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Вывод характеристик дальнего поля антенны 

 
          Для вывода на график трехмерной диаграммы направленности антенны: 

1. Выберите команду меню HFSS>Results>Create Report. 
2. Создайте окно вывода: 

Тип сообщения: Far Fields, 
Тип графика  3D Polar Plot. 

 
В появившемся окне Trace выберите: 

Решение: Setup1: Sweep1, 
Геометрия ff_all. 

 
     В закладке Sweep, выберите строку Freq  и частоту 10.44 GHz 
    В закладке Mag   выберите: 

1. Усиление антенны Gain, 
2. Характеристику GainTotal, 
3. Единицы измерения dB, 
4. и кликните кнопку Add Trace, а затем Done. 

 
   Появляется трехмерная диаграмма направленности (рис. 9.21). 
 

 
Рис. 9.21. Трехмерная диаграмма направленности антенны бабочки 
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Чтобы вывести ДН в полярной системе координат: 
 

1. Выберите команду меню HFSS>Results>Create Report. 
2. В появившемся диалоге выберите Far Fields и тип диаграммы направ-

ленности Radiation Pattern, а затем кликните OK. 
3. В окне Trace  выберите  

решение Setup 1: Sweep1, 
Выберите геометрию ff_all. 

 
     В закладке Sweep: 
   Подсветите Phi  в колонке Name, и, открывая выплывающее меню, выберите 
Theta. Таким образом, мы изменили первичную переменную на Theta, и в 
этом случае сечение диаграммы направленности будет угломестной 
диаграммой направленности. 
   Подсветите вторую строчку, в которой теперь читается Phi. Снимите 
галочку при  All Values. Высветите только значения -90deg  и  0 deg. Это 
будет означать, что мы выведем две угломестные диаграммы направленности, 
развернутые по азимуту на 90°. 
   В строке с частотой Freq выберите частоту 10.44 GHz. 
   В закладке  Mag выберите категорию Directivity, функцию DirTotal и еди-
ницы измерения dB. 
   Кликните кнопку  Add Trace, а затем Done. В результате появляется двумер-
ная диаграмма направленности, показанная на рис. 9.22. 

 

 
 

Рис. 9.22. Угломестная диаграмма направленности антенны для двух 
азимутальных углов 
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     Итак, в данном разделе мы начертили и выполнили анализ антенны со 
сложной структурой типа бабочка. Такая антенна объединяет свойства и 
вибраторной антенны и щелевой антенны. Она имеет симметричную 
относительно оси Z диаграмму направленности и довольно широкую полосу 
рабочих частот. 
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10. Моделирование антенны GPS 
 
 
    Антенна, предназначенная для системы определения координат GPS (Global 
Position System), должна обладать определенными свойствами: равномерным 
излучением в верхней полуплоскости, а также иметь круговую поляризацию.   
     Плоскость, в которой  электрическое  поле  изменяется, называется плос-
кость поляризации. Если планарная антенна имеет линейную поляризацию, то 
её поле меняется только в одном направлении. Эта  поляризация  может идти  
или  по вертикальной линии  или по горизонтальной, в зависимости от 
ориентации платы антенны.   Для оптимальной работы передающая антенна 
должна иметь такую же поляризацию, как и приемная.  
    Если же одна из антенн может вращаться, то для устойчивой связи нужно, 
чтобы другая антенна имела круговую поляризацию. В типичной антенне с 
круговой поляризацией она имеет две точки питания, но сигналы на них 
подаются со смещением 90°.  

 
Рис. 10.1. Принцип питания планарной антенны с круговой поляризацией с 

помощью двух точек 
 
      В  антенне с круговой поляризацией, электрическое поле  изменяется по 
двум ортогональным плоскостям (в x  и  y  направлениям)  с одинаковой дли-
ной и  разностью фаз возбуждения 90°.В результате имеем одновременное 
возбуждение     двух   типов волн,   то есть     TM10 (тип волны   в     x направ-
лении)   и     TM01   (волна   в     y   направлении).  

 
 
Рис. 10.2. Распределение электрического поля в сечении антенны GPS 
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     Один тип волны  возбуждается с  90° углом задержки по отношению к  дру-
ому типу. Антенна с круговой  поляризацией может иметь или правосторон-
нюю  поляризацию (RHCP), когда фазы возбуждения источников  0°  и  -90°   
или  левостороннюю поляризацию  (LHCP) когда     фазы   равны  0°  и  90°.     
 
    Поэтому для создания круговой поляризации, необходимо: 

-  Разделить сигнал на две равные части. 
-  Подать сигналы на две точки - первая создает горизонтальное излуче- 
    ние, а другая - вертикальную линию излучения.  

 
     Разделение  сигнала пополам можно выполнить с помощью делителя мощ-
ности. Хотя такой фазовращатель на 90° работает хорошо, делитель и линия 
задержки занимают значительное пространство; они излучают и могут 
ухудшить диаграмму направленности.  
    В качестве другого варианта реализации антенны, работающей без дополни-
тельной схемы, можно рассматривать плату антенны (рис. 10.3)  как 
параллельную RLC резонансную схему. Это означает, что сдвиг фазы, 
который изменяется в диапазоне частот, имеет зависимость, показанную на 
рис. 10.4.  

 
Рис. 10.3. Принцип питания GPS антенны с помощью одной точки. Изменение 
сечения удобно для подстраивания, поскольку увеличение среза увеличивает 

разность фаз между двумя парами щелевой линии. 
 

    Так как имеются два резонанса связанные с противоположными сторонами, 
fa и fb (два типа волн), то это означает, что имеется две эквивалентные 
резонанс-ные RLC цепи. Когда их резонансные  частоты немного отличаются 
и имеется полоса частот, в которой разность фазы двух RLC цепей близка к  - 
90°.  
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Рис.  10.4. Создание разности фаз, возбуждаемых соседними щелями 

планарной антенны GPS 
 
 
     Таким образом, круговая поляризация может быть достигнута созданием 
единственной платы, обладающей двумя резонансными частотами в ортого-
нальных направлениях и использованием двухрезонансных свойств антенны. 
Важно, что два типа волн возбуждены с равной амплитудой и с разностью фаз 
90°. Имеется ряд способов, чтобы реализовать это. Например, отрезание 
сектора по углам планарной антенны - так называемое усечение по углам - 
метод, широко используемый в GPS антеннах. Заметим, однако, что этот 
метод дает меньшую полосу, чем случай питания двумя источниками, когда 
ширина диапазона поляризации в основном ограничена шириной диапазона 
фазо-сдвигающего делителя.  
      Качество круговой поляризации оценивается осевым  коэффициентом 
(AR). Осевой коэффициент 3 dB считается достаточным для большинства 
антенн с круговой поляризацией. Можно сказать, что осевой коэффициент 
изменяется с частотой и имеет оптимум (0 dB) между резонансными 
частотами из двух возбужденных типов волн. Однако, это не значимо в 
предыдущей структуре, в которой осевое отношение изменяется с 
повышением также.  
    Осевое отношение обычно оптимально в направлении z -оси и ухудшается с 
увеличением угла места (дальше от z -оси). Степень снижения работоспособ-
ности антенны сильно зависит от ее геометрии.  
     Другим способом оценки качества круговой поляризации является отноше-
ние со- и кросс- поляризационных  диаграмм направленности.  Со –поляриза-
ционная ДН является диаграммой направленности требуемой поляризации, и 
кросс -полярного диаграмма направленности – ДН  нежелательной противопо-
ложной поляризации.  
       Общий вид антенны GPS с одной, смещенной точкой питания показан на 
рис. 10.5. 
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Рис. 10.5. Верхняя плоскость GPS антенны 
 
    Толщина платы, на которой напыляется антенна, 4 мм, диэлектрическая 
проницаемость подложки 9.8 и потерями 0.0001. Чем толще подложка, тем 
большую полосу можно ожидать. Однако чрезмерно широкая подложка 
приводит к тому, что могут появиться высшие типы волн. 

 
Черчение антенны GPS 

 
     Выберем единицы черчения – мм. Начертим подложку командой Create - > 
Box с параметрами (рис. 10.6): 

 
Рис. 10.6.  Параметры подложки 
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      Эта подложка будет иметь диэлектрическую проницаемость, равную 10, но 
пока можно оставить его материал вакуумом, поскольку из подложки нужно 
вырезать отверстие для питания антенны.  
     Создадим цилиндр радиусом 1 мм и высотой 5 мм, с параметрами  X5 и Y5 
в качестве X-координаты и Y-координаты точки питания (рис. 10.6). Положим 
эти смещения равными 5 мм. 
 

 
Рис.  10.7. Параметры цилиндра, который вырезается из подложки 
операцией Substrate (здесь уже заданы параметры X5 и Y5) 
 
      Этот цилиндр будет вычитаться из объемной подложки, чтобы создать в 
ней отверстие. Выполним это, чтобы создать антенну как можно по конструк-
ции к реальной структуре. Однако с точки зрения установки порта, это не 
обязательно: плоскость, на который  ставится порт, может идти прямо внутри 
подложки. 

 
Рис. 10.8. Вид антенны сверху 

 
     Выделим верхнюю плоскость подложки и начертим на ней, командой 
Draw-> Rectangle,  антенну прямоугольной формы  с параметрами: 
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Рис  10.9. Параметры верхней формы планарной антенны GPS. На эту плату 
ставится граничное условие Perfect E 
 
     Теперь в окошке плоскости черчения установим  «ZY» и начертим 
прямоугольник внутри отверстия с параметрами, указанными на рис. 10.10. 
Положение этого прямоугольника, на который будет установлен дискретный 
порт, будет параметризировано. 

 
 

Рис. 10.10. Параметры перемычки через отверстие в плате 
 
     Теперь нужно решить вопрос о том, как будем устанавливаться дискретный 
порт на часть, или полный размер этого прямоугольника ( рис. 10.11). 
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Рис. 10.11. Установка дискретного порта 

 
    Практика расчета показала, что более точно расчет будет к эксперименту, 
если высоту дискретного порта установить равной толщине подложки.  
    Начертим командой Draw -> Box бокс  с размерами, показанными на рис. 
10.12 и установим на него граничное условие Radiate. 
 

 
Рис. 10.12. Параметры бокса излучения 

 
    Частота анализа 1.61 ГГц. Отметим, что нас интересует диапазон частот от 1 
до 2 ГГц, поскольку в него входит частота, на которой работает система GPS и 
система ГЛОНАСС. После расчета модели, выведем на 3-мерный график 
диаграмму направленности (рис. 10.13). 
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Рис. 10.13. Трехмерная диаграмма направленности Directivity max = 3.85 dB 
 
    Чтобы рассчитать и вывести характеристики направленности антенны на 
прямоугольную систему координат, выберем опцию Rectangular Plot (рис. 
10.13).  
    Чтобы вывести зависимость осевого отношения, выберите в диалоге Traces 
характеристику Axial Ratio (рис. 10.15). Чтобы по оси х задать угол места θ, 
эту переменную нужно выбрать как первую переменную в закладке Sweeps.  

 
Рис. 10.15. Выбор характеристик антенны: поляризационное отношение 
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    Нажимая на Add Trace, а затем Done на этой панели, получаем зависимость 
mag(AxialRatio) от угла места Theta (рис. 10.16). 

 
 
Рис.  10.16. Осевое отношение эллипса поляризации (при круговой поляризации  

величина AxialRatio = 1) в зависимости от угла места 
 

 

 
Рис.  10.17. Частотная характеристика GPS антенны. Двухгорбость 

частотной характеристики объясняется наличием двух резонансных систем 
по двум координатам 

 
 
      Важным параметром антенны является ширина полосы. Наиболее часто 
используется полоса по импедансу. Однако можно использовать и другие 
определения полосы – по направленности, по поляризации и по эффектив‐
ности антенны. Эффективность и направленность в диапазоне частот 
комбинируются с полосой  по усилению. 
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Полоса по критерию импеданса или возвратных потерь 
 
     Это диапазон частот, в котором структура имеет определенный входной 
импеданс, обычно 50  Ом.  
     Ширина полоса по импедансу зависит от большого количества параметров, 
связанных с пач-антенной, например, добротности и типа используемого 
питания.  График внизу показывает возвратные потери пач-антенны и 
показывает, что полоса по этому параметры S11/VSWR (S11 /VSWR). Полоса 
обычно ограничивается несколькими процентами. Это главный недостаток 
обычной пач-антенны. Есть несколько способов, чтобы увеличить полосу. 

 
Рис. 10.20. Ширина полосы антенны GPS 

 
    Отметим, что для определения рабочей полосы частот, используются 
различные определения импеданса в диапазоне частот, такие как: 
VSWR=3;модуль  S11 , меньший, чем–10 dB, максимальный реальный 
импеданс, и т.д. Это относится к антеннам для конкретного применения.  
 

Полоса по направленности и усилению антенны   
Это полоса частот, в котором антенна удовлетворяет требованию по направ-
ленности/ усилению (например, изменение КСВ на 1 дБ).  
 

Полоса частот по эффективности   
 Это полоса частот, в которой антенна функционирует с заданной эффектив-
ностью по излучению общей мощности.  
 

Диапазон частот по поляризации   
 Это диапазон частот, в котором антенна имеет свою основную поляризацию.  
 

Полоса, в которой задано осевое отношение   
Эта полоса частот относится к полосе частот по поляризации и это число 
выражает качество круговой поляризации антенны.  
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Оптимизация антенны GPS 
 
    Переведем переменные в разряд изменяемых при оптимизации. Для этого 
задаем команду HFSS -> Design Properties. Появляется список переменных, 
имеющихся в проекте. Пусть нашими переменными будут координаты точки 
питания и координаты точки угла среза, который также может быть перемен-
ной при нахождении оптимальной конструкции. Выполним оптимизацию на 
одной частоте 1.61 ГГц. 

 
Рис. 10.21. Установка параметров антенны, изменяемых при оптимизации 

 
    Отметим галочки в столбце Include, чтобы внести эти переменные в 
процесс оптимизации. Также нужно также задать целевую функцию. Будем 
считать, что нам нужно получить осевое отношение, близкое к единице (т.е. 
круговую поляризацию) в большом диапазоне углов места (пусть от -60 до 60 
градусов). Тогда устанавливаем, нажимая на Edit в диалоге рис. 10.22. 
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Рис. 10.22. Задание вида целевой функции. В данном случае векторная опти-
мизация включает два параметра: направленность антенны Dir в диапазоне 
углов от -60º до 60º  и  степень круговой поляризации Krug  в том же диапа-
зоне углов  
 
    Теперь запускаем оптимизацию, выбрав метод и максимальное количество 
итераций, командой Analysis, нажимая правой кнопкой мыши на раздел 
Optimization -> Setup. Оптимизация запускается и начинает изменять 
переменные так, чтобы получить наименьшее значение целевой функции. 
Процесс изменения целевой функции будет просматриваться на графике, 
нажимая на команду OptimizationSetup -> View Analysis Results. 
 
     Итак, в данной главе была рассмотрена антенны GPS с круговой 
поляризацией. Мы определили набор спецификаций, которые позволяют 
пользователю задать требования для конкретного применения. Кроме этого, 
были рассмотрены многие опции расчета, и  характеристики планарной 
антенны.  
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11. Антенна Вивальди 

 
     
  Часто в практике проектирования нужно создать компактную антенну с 
узкой диаграммой направленности. Если размеры такой антенны меньше 
длины волны, то нужно максимально использовать объем, в котором может 
размещаться антенна.  
     Рассмотрим типичные характеристики антенн с сужающими щелями 
(Tapered-Slot Antenna,  TSA). Антенна Вивальди - один из типов антенн TSA, 
имеющая диаграмму направленности, излучаемая с края. На рис. 11.1 пока-
зываются  антенны, относящиеся к классу апериодических непрерывно 
изменяемых структур. 

 
Рис.  11.1.  Типичные рупорные планарные антенны 

 
      Антенна строится на диэлектрической подложке с металлической формой 
с одной стороне платы. Привлекательные особенности TSA - то, что они могут 
работать в большой полосе пропускания частоты и  излучают от конца или 
края  с хорошим  усилением и низкими задними лепестками. 
     Важным в проектировании антенны является нахождение подходящих 
методов питания антенны Вивальди. Известно, что TSA имеют широкую 
полосу пропускания, хорошую  направленность и имеют симметричную 
диаграмму направленности.        
     Щель антенны Вивальди может изменяться по экспоненциальному закону, 
а может изменяться и линейно. Это сближает антенну Вивальди к стандартной 
рупорной антенне, у которой ширина диаграммы направленности увеличива-
ется с увеличением расстояния от точки питания антенны.     Можно сказать, 
что  антенна Вивальди эквивалента печатному радиальному рупору (рис. 11.2). 
Структура, направляющая волну – это печатная щелевая линия, которая 
экспоненциально  расширяется.  
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Рис. 11.2.  Различные типы расширяющихся антенн 

 
      Антенна Вивальди – работает на "поверхностных волнах". Поверхностные 
волны распространяет изогнутая дуга щели антенны. В области, где щель 
между проводниками маленькая по сравнению с  длиной волны в свободном 
пространстве, волны сильно связаны и когда расстояние между ними 
увеличивается, взаимодействие становится все более слабым, и волны излу-
чаются от антенны. Это случается, когда расстояние между линиями на краю 
становится больше половины длины волны (λ/2).   
 

Излучение антенны Вивальди 
 
     Антенны с сужающейся щелью генерируют волну, распространяющуюся 
по структуре антенны, которая имеет фазовую скорость, меньшую, чем ско-
рость света,   ph <c (как и в граничном случае ph = c).  
      Для антенны Вивальди характерно излучение в направлении ребра (рис. 
11.3), со стороны более широкой щели.        
      Граничный случай, когда фазовая скорость равная скорости света, отно-
сится к случаю, когда  антенны выполнены с воздушным диэлектриком и 
тогда ширина луча и уровень задних лепестков  получаются больше, чем в  
присутствии диэлектрика. Как правило, ширина луча диаграммы направлен-
ности в E- плоскости и H-плоскости почти одинаковы. 
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Рис.  11.3. Сечение антенны Вивальди 
 
     Излучающая часть изменяет ширину щели, поэтому на различных частотах 
излучают различные части антенны. Таким образом, антенна теоретически 
имеет бесконечную полосу пропускания и её можно, таким образом,  считать 
независимой от частоты. Когда длина волны изменяется,  излучение 
происходит от различных частей антенны, которая имеет в раскрыве размер, 
пропорциональный длине волны. Это дает очень большую полосу 
пропускания. Можно заметить (рис. 11.3), что антенна Вивильди состоит из 
двух областей: 

•  области распространения,  при  WE < W < WA, 
•  области излучения, находящаяся при WA < W < WO, 

    где W -  ширина щели, WE – ширина щели на входе, WA – ширина щели в 
области излучения, WO -  ширина щели на выходе. 
   Теоретически, TSA может иметь полосу пропускания, например, от  2 ГГц 
до 90 ГГц, в то время как фактически рабочая полоса пропускания ограничена 
переходом от линии питания к щелевой линии антенны и конечными разме-
рами антенны. Таким образом, чтобы получить более широкую полосу про-
пускания,  нужно иметь в виду следующие два аспекта:- переход от главной 
входной линии передачи до линии щели для питания антенны; - размер 
антенны. 
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Рис. 11.4.  Вертикальный срез двух антенн Вивальди 

    
    Полная структура антенны показана на рис. 11.5. Антенна работает с кру-
говой поляризацией на центральной частоте  910 MГц  и имеет размеры 50 мм 
x 50 мм x 50 мм.  
  

 
 

Рис. 11.5.  Счетверенная антенна Вивальди размером  50 x 50 x 50 
мм 
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    Каждая отдельная антенна включает емкость между обкладками и индук-
тивности для согласования с линией подвода питания. 
    Комплексная антенна состоит их 4-хэлементарных излучателей - антенн  
Вивальди, запитанных с помощью распределительной цепи так, чтобы 
обеспечить нужный сдвиг фаз между отдельными антеннами, что обеспечит 
круговую поляризацию. 
    Каждая антенна состоит из двух вибраторов. Вибраторы находятся по раз-
ным сторонам подложки, и поэтому нижняя часть образует емкость, служа-
щую элементом согласующей цепи. 

 
 

Рис. 11.6. Согласующие цепи и делитель мощности антенны Вивальди 
устроены так, что они подводят питание со сдвигом в  90º к антеннам, 
лежащим в одной плоскости, а также сдвигают сигналы, подводящие 
мощность к антеннам, лежащим под углом 90 º. 
    
    Согласование с помощью специальных согласующих цепей здесь не нуж-
но,  поскольку согласование выполняется изменение формы в плоскости 
каждой антенны. Так что рассогласование в точке пересечения линий, не 
важно для получения характеристики всей антенны, поскольку согласование 
оптимизируется по общему входу антенны. 
     Если антенну выполнить так, что питание отдельных антенн будет с раз-
ницей фаз 90°, то антенна будет иметь круговую поляризацию. При измене-
нии фазовых соотношений, эллиптичность можно менять. 

 
Проектирование простейшей антенны Вивальди  

 
        Выполним моделирование простейшей антенны Вивальди, состоящую из 
формы в виде расходящейся щели. Начертим подложку толщиной 1 мм и про-
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ницаемостью 10, на которой с двух сторон будут располагаться металлические 
формы антенны (рис. 11.7). 
 

 
Рис. 11.7. Параметры подложки элементарной антенны 

 
      Форму металлической части антенны можно задать с помощью формулы. 
Выделим плоскость YZ и с помощью команды Draw-> Spline начертим в 
плоскости при X=0mm  сплайн. Сплайн можно создать из нескольких точек, а 
затем конечную точку поместить в угол (рис. 11.8). После этого нужно 
перейти в режим черчения прямой линии по ребру. Переход от черчения 
прямой линии к сплайну выполняется командой Set Edge Type  Spline 
(нажимая правой кнопкой мыши). 

 
Рис. 11.8. Форма планарной антенны Вивальди 
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     Поставим дискретный порт на вертикальную площадку, стоящую между 
двумя противоположно лежащими формами. Используя алгоритм модели-
рования, рассчитываем входной импеданс этой антенны на частоте 1.61 ГГц 
(рис. 11.9). 

 
 

Рис. 11.9. Реальная и мнимая части простейшей антенны Вивальди 
 

 
Рис. 11.10.Траектория согласования антенны с помощью электронной 

диаграммы Смита 
 

     Для того, чтобы выполнить согласование антенны, необходимо увеличить 
размер подложки на  10 мм, чтобы расположить на этом площади согласую-
щую структуру. Согласущая структура рассчитывается с помощью диаграм-
мы Вольперта-Смита (рис. 11.10) и затем реализуется в виде индуктивности и 
емкости. 
  В первом приближении можно считать, что размер меандровой индуктив-
ности и гребенчатой емкости, имеют размеры, зависящие от их величин, ко-
торые можно оценить по аналитическим формулам, приведенным в таблице 
11.1. 
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m – число зубьев с одной стороны, l- длина зубьев, 
h-толщина подложки, мм, d- щель между зубьями, мм 

0.2 ... 5 pF 

n 2 3 4 5 6 7 8 9 10 11 12 
Cn 2.76 3.92 6.22 7.6 9.7 10.92 13.38 14.92 16.86 18.46 20.36 
 
    Кроме того, вместо включения согласующих элементов, другим способом 
согласования антенны можно считать изменение ее формы так, чтобы дос-
тичь входного импеданса 50 Ом. Это можно сделать, меняя форму антенны 
(рис. 11.11). Возможно и одновременное применение обоих методов. 

 

 
Рис.  11.11. Добавление пространства подложки, чтобы в это место 
установить согласующую структуру 
 
    После решения антенны с дискретными элементами емкости и индуктив-
ности можно заменить микрополосковыми компонентами, и затем выполнить 
оптимизацию ее. В качестве изменяемых параметров можно выбрать ширину 
линии, длину линии, и даже одну вершину согласующей структуры.  
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Рис. 11.12. Частотная характеристика антенны Вивальди 

 
     Из рис. 11.12 видим, что полоса антенны Вивальди равна примерно 100 
МГц, т.е. около 8%. Это, совместно с ее компактностью, удобством настрой-
ки, делает ее интересной для создания современных излучаемых СВЧ конст-
рукций.  Рассчитанная диаграмма направленности антенны приводится на рис. 
11.13.  

 
Рис. 11.13. Типичный вид диаграммы направленности антенны Вивальди по-
казывает, что антенна имеет приоритетное направление излучения по оси Z 
     
    Диаграмма направленности показывает, что планарная антенна Вивальди 
имеет приоритетное направление излучения со стороны ребра антенны. 
Антенна Вивальди имеет линейную поляризацию. Для того, чтобы сделать 
антенну с круговой поляризацией, можно расположить две или четыре таких 
антенн перпендикулярно, как показано на рис. 11.5.  
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12. Квадрифилярная антенна 
 

     Квадрифилярная антенна обладает уникальными свойствами – она излу-
чает в одну сторону и обладает круговой поляризацией. 
    Чтобы начертить такую антенну, используется операция черчения спирали 
Draw -> Helix. По умолчанию эта команда в меню неактивна, и становится 
активной только, если активизирован одномерный или двумерный объект. 
Если мы ходим создать трехмерную спираль, заполненную материалом, то 
нужно задать сечение профиля спирали в виде двумерного объекта, а если 
хотим создать спираль с нулевой толщиной, то нужно задать сечение в виде 
линии. 

 
 

Рис. 12.1. Квадрифулярная антенна с четырьмя источниками питания 
сдвинутыми на 90 град. 

 

    Свипирование 1D объекта дает в результате 2D объект – ленту с нулевой 
шириной.  Начертим прямую линию командой Draw -> Line с координатами 
точек (15,1,0)  и (15,-1,0). 

 

Рис. 12.2. Параметры отрезка линии – сечения вибратора 
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1. Выберите этот 1D объект (линию или дугу), который вы хотите свипировать 
в форме спирали. 
2. Из меню  Draw кликните Helix.  
3. Теперь нужно установить две точки вектора, вдоль которого будет вращать-
ся спираль. Для нашего случая это будет ось Z. Для создания вектора: 
      a. Задайте начальную точку нажатием на точку (0,0,0) или впечатывания  
          этих значений в окно строки состояния. 
       b. Выберите конечную точку нажатием точки или впечатыванием коорди- 
           нат относительно начальной точки dX, dY, и dZ. (для нашего случая 
           dX=0, dY=0, dZ=30).  Появляется диалог Helix (рис. 12.3). 

 

Рис. 12.3. Черчение спирали как элемента квидрифилярной антенны 
4. Выберите Right hand если направление спирали идет вправо, или Left hand 
если будет левая резьба. 
 5. В боксе Pitch, напечатайте расстояние между каждым витком спирали, и 
выберите единицы (рис. 12.3). Поскольку количество витков у нас задается 
равным 0.5, то для того, чтобы высота антенны была 50 мм, как на рис. 12.1. 
6. В боксе Turns, напечатайте число полных оборотов сечения спирали, 
которое будет двигаться вдоль вектора (0.5).   Выбранный объект свипируется 
вдоль вектора для формирования спирали. Исходный объект, который вы 
свипировали, исчезает. Появляется диалог Properties,  если вы хотите 
изменить параметры спирали (рис. 12.5). 
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Рис. 12.4. Параметры спирали в пол-витка 

7. Нажмите OK. 
   Чтобы параметризовать размеры антенны, внесем переменные в параметры 
линии, из которой чертилась спираль. Sir – ширина линии полоски антенны: 

 

Рис. 12.5. Параметризированный отрезок прямой линии 

Введем также переменную H50 - высоту антенны: 

 

Рис. 12.6. Параметризированный вибратор квадрифилярной антенны 

     Теперь переведем режим черчения на плоскость YoZ  и начертим квадрат, 
на который будет установлен порт. 
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Рис. 12.7. Площадка, на которую устанавливается порт 

    Установим дискретный порт Lumped Port на эту площадку. Теперь нужно 
выполнить дублирование и вращение относительно оси Z полученного 
вибратора и порта командой Edit -> Dublicate Around Axis. Выделим порты, 
дадим команду и занесем параметры в диалоге: 

 

Рис. 12.8. Параметры прокручивания одного вибратора относительно оси Z 

     После того, как созданы все четыре вибратора, необходимо создать кре-
стообразное пересечений линий снизу и вверху антенны. Это можно выпол-
нить черчением двух пересекаемых прямоугольников. 

 

Рис. 12.9. Прямоугольник составляющий соединение вибраторов 
квадрифилярной антенны 
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Рис. 12.10. Второй прямоугольник пересекающей линии 

 Можно рекомендовать также создать теперь это соединение как единый объ-
ект по точкам, командой Draw->Line. Тогда первая линия, связывающая 1-ю  
и 2 точку, с учетом параметризации будет иметь следующие координаты: 

 

Рис. 12.11. Параметризация одного из фрагментов многоугольника 

 

Рис. 12.12. Топология перекрестия линий сверху и снизу квадрифилярной 
антенны 
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    Далее с помощью операции сдвига Edite -> Dublicate -> Along Line выпол-
ним дублирование и смещение второй крестовины вверх на 51 мм. Для этого 
внесем в диалоге Properties (рис. 12.13) параметр Z=51. 

 

Рис. 12.13. Параметры операции дублирования и сдвига объекта 

    Зададим этим всем линиям граничное условие Perfect E. Далее охватим 
антенну боксом, на котором установим граничное условие излучения Radiate с 
размером, указанным в диалоге рис. 12.14. 

 

Рис.12.14. Размеры бокса излучения 

     Зададим теперь установки на решение: частота 1.61 ГГц и запустим расчет 
антенны. Результаты расчета квадрифилярной антенны выводятся на нес-
колько графиков, первый из которых – трехмерная диаграмма направленнос-
ти (рис. 12.15). 
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Рис. 12.15. Диаграмма направленности квадрифилярной антенны 

 

 

Рис. 12.16. Осевое отношение квадрифилярной антенны 
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Рис. 12.17. Частотная характеристика параметра S11 квадрифилярной 
антенны по каждому входу 

 

Рис. 12.18. Реальная и мнимая части входного импеданса квадрифилярной 
антенны 

  HFSS позволяет начертить реально - искривленные компоненты. Однако, 
решение будет получено с тетраэдральной ячейкой, которая соответствует 
истинной поверхности, только в пределах сторон ячеек. HFSS имеет установ-
ки по умолчанию согласования сетки и реальной поверхности, которые дают 
приемлемый компромисс между скоростью решения и качеством решения для 
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большинства объектов, но не может быть идеальна для всех таких объектов. 
Сильно искривленные структуры, типа спиралей с узкими и искривленными 
сечениями, полезно скорректировать с помощью огранки.  
 

 

Рис. 12.19. Разбиение на ячейки квадрифилярной аненны показывает, что 
HFSS c большим трудом решает задачу меширования скругленных 

поверхностей. 
         В HFSS разбиение на ячейки выполняется произвольно для усовершен-
ствования разбиения на ячейки. Этот метод выполнения разбиения на ячейки 
называется подсев. Подсев выполняется, используя команды Mesh Operations 
в меню HFSS.  
      Вы можете выбрать опции уплотнения по длинам тетраэдров на 
поверхности или внутри объема, пока они не меньше некоторой величины 
(уплотнения ячейки на основании длины) или можно инструктировать HFSS, 
чтобы улучшить поверхностную длину треугольника всех тетраэдральных 
элементов на поверхности или внутри объема к заданной величины 
(уплотнения сетки на основании глубины скин-слоя). Эти действия разбиения 
выполняются на текущем разбиении на ячейки, то есть самой последней 
сгенерированной сетке. 
    В некоторых случаях можно создать разбиение, которое изменяет 
поверхностные установки аппроксимации HFSS для одного или большего 
количества граней. Поверхностные установки аппроксимации только приме-
няются к сетке, которая сгенерирована в первый момент расчета.  
 Общий процесс разбиения на ячейки структуры состоит в следующем: 
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1. HFSS генерирует начальное разбиение на основании разбиения поверхнос-
ти на треугольники  (диалог Surface Approximation, рис.12.20). 

 

Рис. 12.20. Установки аппроксимации поверхности. Установки состоят из 
трех частей:  
              Установка максимального отклонения поверхности;  
              установка максимального отклонения нормали поверхности;  
             установка максимального отношения сторон треугольников 

2. Если требуется уплотнение ячеек на основании длины волны (lambda 
refinement), HFSS выполняет разбиение на ячейки, основываясь на длине 
волны в материале.  



 229

 

Рис. 12.21.Установка уплотнения ячеек по критерию длины волны. Диалог 
состоит из двух разделов: установка длины элементов и установка числа 

элементов 
3. Когда задано какое-либо условие по разбиению, то оно и используется при  
 уплотнении разбиения на ячейки. 
 4. Если в конструкции имеются порты, HFSS последовательно уплотняет дву- 
 мерное разбиение на ячейки в портах. 
 5. Используя окончательное разбиение на ячейки, HFSS рассчитывает элек- 
 тромагнитное поле внутри структуры, с учетом, что источник возбуждения 
 имеет заданную в диалоге Solution Setup частоту решения. 
6. Когда выполняется адаптивный анализ, HFSS использует текущее решение 
методом конечных элементов для определения области решения задачи, где 
точное решение имеет большую ошибку. Размер тетраэдров в этой области 
будет уменьшаться. Алгоритм адаптивного меширования ищет максимальное 
изменение поля E и разбивает эту область на более плотную сетку. 
7. Затем HFSS генерирует другое решение, используя более плотную сетку 
разбиения. 
8. HFSS пересчитывает ошибку, и интерактивный процесс повторяется, пока 
критерий сходимости либо достигнет максимального заданного числа адап-
тивных проходов, либо достигнет критерий уменьшения ошибки расчета. 
Опции адаптации находятся в разделе Adaptive Options и максимальное 
уплотнение на один проход задается в процентах (рис. 12.22). Это обеспечи-
вает плавное изменение плотности сетки пошагово. 
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Рис. 12.22.Опции начального разбиения на ячейки, устанавливаемые на 
основании длины волны (деление длины волны на три) 

9.  Разбиение выполняется на заданной частоте решения; а eсли расчет вы-
полняется в полосе частот, то HFSS решает задачу на других частотных точках 
без дополнительного изменении сетки разбиения.  
 
      Разбиение на ячейки можно установить самому пользователю, что 
позволяет более оптимально управлять работой HFSS, на основании знания 
тех частей модели, которые наиболее сильно влияют на электромагнитные 
характеристики.  
    Такие установки до начала адаптивного процесса анализа могут уменьшить 
(иногда значительно) число проходов, необходимых для сходимости, а также 
числа тетраэдров в сетке. Хотя цели сходимости адаптивного процесса, где 
находятся характеристики поля, улучшая ячейку, используя, например, 
понимание характеристик материалов, могут приводить к нахождению 
областей с критическим полем, как только первые несколько проходов 
выполнены.  
    Метод разбиения на ячейки называются посевом сетки. Посев, т.е. разбие-
ние на тетраэдры,  выполняется, используя команды Mesh Operations  в меню 
HFSS (рис. 12.24). 
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Рис.12.23. Выбор операции по разбиению на ячейки 

Можно инструктировать HFSS уменьшать размеры тетраэдров на поверхнос-
ти или внутри объема, пока они не станут меньше заданной величины (length-
based mesh refinement) или вы можете инструктировать HFSS уменьшать 
длины треугольников элементов тетраэдров на поверхности или в заданном 
объеме к заданной величине скин-слоя. Эти установки могут быть заданы 
одновременно. Если вы устанавливаете их перед запуском на решение, они 
используются для улучшения начального разбиения на ячейки после того, 
когда она была сгенерирована. Вы можете также выбрать режим apply mesh 
operations without generating a solution, в этом случае операции меширования 
применяются к текущей сетке разбиения. 
  Иногда можно установить разбиение на ячейки, с установками аппроксима-
ции HFSS для одного или большего количества граней. Поверхностные уста-
новки аппроксимации относятся только к начальному разбиению на ячейки. 
 

Правила разбиения на ячейки 
 
   Вмешательство в процесс разбиения на ячейки  рекомендуется в следующих 
случаях: 
 
• В объеме, где ожидаются значительные изменения электрических или маг-
нитных полей (с сильной емкостной или индуктивной нагрузкой). Такие 
случаи включают промежуток в резонансной структуре, нагруженный ем-
костью, крутые углы волновода, или промежутки между связанными линиями 
в структурах фильтра. 
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• Разбиение на ячейки на каждой из граней, с большой разницей размеров, 
например в длинных линиях передачи внутри микросхеме или на поверхнос-
тях длинных проводов. Разнос точек при уплотнении сетки, приблизительно 
равно ширине или диаметру провода, что позволяет более точно фиксировать 
поведение структуры с высоким аспектом на первом адаптивном проходе. 
 

Уплотнение разбиения на основании длины 
(Length-Based Mesh Refinement) 

 
      Когда вы устанавливаете разбиение на ячейки, основанное на длине, то вы 
инструктируете HFSS разбивать стороны тетраэдральных элементов, пока они 
не станут меньше заданной величины. Длина тетраэдра определяется как 
длина самого длинного ребра. 
     Можно задать максимальную длину тетраэдра на гранях или внутри 
объекта. Можно также задать максимальное число тетраэдров, которые 
добавлены во время уплотнения сетки разбиения. Когда начальная ячейка 
была сгенерирована, критерии уплотнения, которые Вы задали, будут ис-
пользоваться, чтобы улучшить начальную ячейку. 
    Например, выделим какую либо сторону, или поверхность в конструкции и 
зададим команду Length Based. Появляется диалог рис. 12.24. 
 

 
Рис. 12.24. Установка опций для уплотнения разбиении на ячейки 

 
    Если заполнить его как показано, то это будет означать, что максимальная 
длина элемента будет равна 16 мм (все остальные мельче), а количество 
тетраэдров разбиения не превышает 1000. 
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  Когда вы задаете уплотнение на основании длины, вы инструктируете HFSS 
уплотнять длины тетраэдров пока они не становятся меньше определенной 
величины. Эта длина тетраэдра определяется как длина самого длинного 
ребра.   Вы можете задавать максимальную длину тетраэдра на фаске или 
внутри объектов. Вы можете также задавать максимальное число элементов, 
которые добавлены во время уплотнения ячеек. Когда начальное разбиение 
было сгенерировано, критерий уплотнения который вы задаете, будет 
использоваться для улучшения начального разбиения. 
 

Уплотнение ячеек на основании глубины скин-слоя 
 
      Когда Вы хотите выполнить разбиение на основании глубины скин-слоя, 
Вы инструктируете HFSS уменьшить сторону треугольников всех тетраэд-
ральных элементов на грани по отношению к  заданной величине. 
   Разбиение слоя на ячейки создается на основании разбиения на поверхнос-
ти. Слои располагаются ступенчато до полной глубины скин-слоя и число 
слоев задается. 

 

Рис. 12.25. Диалог расчета глубины скин-слоя 
 
    Во время уплотнения сетки, на основании скин-слоя, HFSS создает нес-
колько плоскостей, параллельных к поверхности предмета, и они распола-
гаются внутри точно установленной глубины поверхностного слоя.  
    Для каждой точки на поверхности, ряд  точек (P0, P1, P2, ..., Pn) добав-
ляется к сетке, где n - число уровней. P0 - точка на поверхности, и расстояние 
от P0 до Pn - глубина поверхностного слоя. Точки располагаются неравно-
мерно, и расстояние между ними уменьшается в геометрической прогрессии, 
когда Вы двигаетесь от Pn до P0. 
Например, если  

Skin Depth (глубина скин-слоя): 12 mm 

Number of Layers of Elements (число 
слоев):  

4 

тогда 
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Distance [P0,P1]: 0.8 mm. 

Distance [P1,P2]: 1.6 mm. 

Distance [P2,P3]: 3.2 mm. 

Distance [P3,P4]: 6.4 mm. 

Distance [P0,P4]: 0.8 + 1.6 + 3.2 + 
6.4 = 12 mm 

 
     Уплотнение по глубине скин-слоя сначала выполняется до удовлетворения 
по критерию длин  сторон треугольников, а затем вводится ряд точек к каждо-
му дополнительному уровню.  Если задан предел в виде количества ячеек, 
происходит один из следующих случаев: 
• предел устанавливается достаточно высокий, чтобы завершить уплотнение 
по глубине скин- слоя. 
• предел установлен достаточно высоким, чтобы удовлетворить поверхност-
ному критерию длины ребра треугольника, но не достаточно высоким, чтобы 
завершить подсев по толщине.  
• предел не установлен достаточно высоким, чтобы удовлетворить даже по-
верхностному критерию длины ребра треугольника.  
    Из-за того, что уплотнение по глубине скин-слоя может прибавлять много 
точек, Вы должны сначала улучшить разбиение на сетку на поверхности 
объекта, используя уплотнение сетки, основанное на длине, чтобы получить 
точное количество точек, которое HFSS добавит при уплотнении на основа-
нии скин-слоя. Это позволяет достичь поверхностного критерия длины края и 
аппроксимировать число элементов и число точек на поверхностях перед 
переходом к разбиению по глубине поверхностного слоя. 
     Критерии уплотнения используются, чтобы улучшить текущее разбиение 
на ячейки. 
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Рис.12.26. Установки разбиения на ячейки по глубине скин-слоя, включая 
раздел расчета глубины скин-слоя 

 
Аппроксимация поверхностей 

 
     Поверхности объектов в HFSS могут быть плоскими, цилиндрическими или 
коническими, тороидальными, сферическими или сплайнами. Сами поверх-
ности модели называются реальными поверхностями (true surfaces). Чтобы 
создать на разбиение на конечные элементы, HFSS вначале делит все реаль-
ные поверхности на треугольники.   
    Эти поверхности, покрытые треугольниками, называются фасеточными 
поверхностями, потому что каждая искривленная или планарная поверхность 
заполняется рядом сегментов прямых линий. 
     Для плоских поверхностей, треугольник лежит точно на поверхностях мо-
дели; нет разницы между расположением или нормали верной поверхности и 
поверхности разбиения.  
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Рис. 12.27. Вид сверху на квадрифилярную антенну совместно со схемой 
деления мощности  

  Когда поверхности объектов скругленные, то плоские стороны тетраэдра ле-
жат на небольшом расстоянии от реальной поверхности объекта. Это рассто-
яние называется  surface deviation, и оно измеряется в единицах длины моде-
ли. Девиация поверхности больше вблизи центра треугольника и меньше 
вблизи углов вертикали.  
  Нормаль к кривой поверхности меняется в зависимости от места приложе-
ния, но она постоянна для каждого треугольника. В этом контексте, «нор-
маль» определяется как линия, перпендикулярная поверхности, а разность 
углов между нормалью кривой поверхности и соответствующей поверхности 
ячейки называется отклонением нормали normal deviation и измеряется в 
градусах.  
      Аспект отношения aspect ratio треугольников, используемых в плоских 
поверхностях, равен отношения радиуса, описывающего треугольник сна-
ружи к радиусу вписанной окружности. Она равна единице для равносто-
роннего треугольника и приближается к бесконечности, когда треугольник 
становится более тонким. 
     Вы можете модифицировать девиацию поверхности, максимальное разре-
шенное отклонение нормали, и максимальный формат изображения устанав-
ливая этот параметр к треугольникам на одном или большем количестве 
поверхностей одновременно в диалоговом окне Surface Approximation. 
(Кликните HFSS>Mesh Operations>Assign>Surface Approximation.)  
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Рис. 12.28. Установки для аппроксимации поверхности 

      Аппроксимация поверхности применяется к начальной сетке разбиения. 

Замечание. В начальном разбиении на ячейки, все вертикали треугольников 
лежат на реальной поверхности. Во время адаптивного меширования, верти-
кали добавляются к поверхности меширования, но не к реальным поверх-
ностям. 
 

Область разбиение на ячейки относительно области задачи 
 
     HFSS различает области между областью задачи и областью разбиения на 
ячейки. Область задачи – это область, в которой решение генерируется, и 
разбиение на ячейки уплотняются. Область разбиения на ячейки, которая 
включает область решения задачи, является площадью, в которой сгенери-
рована начальное разбиение. После того, как начальное разбиение получено, 
сетка уплотняется только в области задачи. 
     Область решения задачи относится к площади, которая является доста-
точно большой, чтобы включить весь проект, но не больше. HFSS автома-
тически определяет область задачи во время решения. Если Вы заинтересо-
ваны результатами вне структуры, типа эффектов излучения, то Вы можете 
создавать виртуальный предмет, чтобы расширить размер области задачи, 
чтобы включить эти площадки. 
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     Область разбиения на ячейки, как и область решения задачи, является 
боксом, который закрывает структуру. Однако область разбиения на ячейки 
должна быть по крайней мере в 10 раз больше, чем область модели. Часть 
области объединения, не заполненной предметами, является объектом земля-
ной платы. Земляная экранная плата простирается на границы области 
разбиения на ячейки и заполняет все лакуны, не заполненные предметами. Так 
как земляная плата определена как идеальный проводник, никакое решение не 
сгенерировано внутри земляной платы, даже если начальное разбиение на 
ячейки было сгенерировано. HFSS автоматически определяет область 
разбиения на ячейки во время процесса решения. 
      Область задачи и область разбиения показаны ниже. 
 

 
Рис. 12.29. Соотношение между размерами анализируемого прибора и всей 

области разбиения на ячейки 
 

 
Рис. 12.30. Соотношения между областями 
Разрешение модели (Model Resolution) 
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    Разрешение модели – это опция, которая определяет самые маленькие дета-
ли модели, которую программа разбиения должна фиксировать и связывать 
сеткой. 
     Много раз анализ начинается с уже начерченной геометрией, с помощью 
различных инструментов для различных целей. Некоторые инструменты раз-
работаны для производства, и результирующие модели содержат большое 
количество дополнительных деталей, не необходимых для электромагнитного 
анализа. Если пользователь удаляет такие детали в первоначальном инст-
рументе, результаты будут лучше. Но если пользователь не имеет доступа к 
оригинальному средству черчения, или перечерчивание модели без этих де-
талей не возможно, опция Model Resolution - другой способ удалить детали из 
анализа. 
      Когда пользователь устанавливает длину разрешения модели, равной L, 
Мешер начинает с поверхностного представления модели с точностью до 
предела допуска разработчика модели. Затем это прогрессивно удалит грани, 
переместит точки, соединит точки и т.д., внутри допустимого предела разре-
шения модели и упростит поверхностную ячейку. Во время  этого процесса, 
удаляются крошечных лент, прутковая сталь, и выступы желобка удалена.  
     Другие общие аномалии модели также улучшаются, используя параметр 
Model Resolution. Например, некоторые геометрические машины вслепую 
экспортируют все поверхности как сплайны. Когда пользователь импортирует 
такую модель, это может привести к большому количеству треугольников. 
Процедура Model Resolution уменьшает число треугольников на сетке 
разбиения. 
       
    Пользователь может начинать с длины разрешения модели около  0. 1* λ. 
Если длина Model Resolution выбрана пользователем слишком большой, 
программа обнаружит это и сообщит об ошибке. Длина разрешения модели 
задается в единицах модели. Она может быть установлена только на выбран-
ных объектах. Значение по умолчанию Model Resolution = 100* предел 
допуска ACIS.  
 

Разбиение на основании длины сторон объектов 
 

1. Выберите фаски, на которых нужно задать более плотное разбиение. Или 
выберите объект, у которого вы хотите уплотнить каждую сторону объекта. 

2. Кликните HFSS>Mesh Operations>Assign>On Selection>Length-Based. 

      Появляется диалог Element Length-Based Refinement. 

3.  Выберите имя операции разбиения в боксе Name или оставьте имя по 
умолчанию. 

4. Чтобы ограничить длину ребра тетраэдра, касающегося со стороной: 
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    a. Выберите команду Restrict Length of Elements. 

     b. Напечатайте максимальную длину ребер треугольников тетраэдра, 
     касающего фасок в боксе Maximum Length of Elements. 

    HFSS будет делить ребра элементов, касающихся выбранных фасок, пока их 
длины не будут равны или меньше этой величины. 
  Величина по умолчанию устанавливается равной 20% длины максимального 
ребра связанных боксов каждой выбранной фаски. Максимальная длина эле-
мента устанавливается на граничные поверхности излучения. 
 
5. Чтобы ограничить число элементов, добавленных во время уплотнения 
поверхностей: 
      a. Выберите Restrict the Number of Elements. 

     b. Введите Maximum Number of Elements которое вы хотите добавить. 

     c. Кликните OK. 

     Когда разбиение выполняется, используются установки на разбиения, кото-
рые вы задали. Когда достигается максимальное число элементов, некоторые 
элементы могут стать с максимально возможной длиной.  

 
Задание уплотнения на основании длины внутри объектов 

    Чтобы HFSS уплотнял каждую фаску объекта и его внутреннее заполнение: 

1. Выберите объект, который вы хотите разбить более плотно. 

2. Кликните HFSS>Mesh Operations>Assign>Inside Selection>Length-Based. 

Появляется диалог Element Length-Based Refinement. 



 241

 

Рис. 12.31. Диалог задания опции уплотнения по длине 

3. Напечатайте имя для операции разбиения на ячейки в боксе Name или ос-
тавьте имя по умолчанию. 

4. Чтобы ограничить длину ребер элементов тетраэдров внутри объекта: 

a. Отметьте режим  Restrict Length of Elements. 

b. Напечатайте максимальную длину ребер внутри объекта в текстовом 
              блоке Maximum Length of Elements. 

     По умолчанию величина устанавливается на 20% от максимальной длины 
ребра связанных боксов каждых выбранных поверхностей объектов. 

    HFSS будет более плотно разбивать ребра элементов внутри объекта, пока 
они не будут равны или меньше чем эта величина. 

5. Чтобы ограничить число элементов, добавляемых во время уплотнения 
внутри объекта: 

a. Выберите Restrict the Number of Elements. 

b. Введите Maximum Number of Elements. 

c. Кликните OK. 
      Когда разбиение выполнено, используются критерии уплотнения, которые 
Вы задали. Когда максимальное число элементов достигнуто, это может при-
водить к некоторым элементам, превышающим запрошенную максимальную 
длину элемента.  
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Задание уплотнения на поверхностях сторон объекта 

 на основании глубины скин-слоя 
1. Выберите стороны, которые вы хотите уплотнить. Или выберите объект, 
если вы хотите уплотнить все стороны этого объекта. 

2. Кликните HFSS>Mesh Operations>Assign>On Selection>Skin-Depth-Based. 

Появляется диалог Skin Depth-Based Refinement. 

 

Рис. 12.32. Диалоги в которых устанавливаются опции разбиения по 
критерию глубины скин-слоя 

3. Напечатайте имя для операции меширования в боксе Name или оставьте 
имя по умолчанию. 
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4. Введите глубину скин-слоя, которая будет использоваться для уплотнения 
разбиения на ячейки в текстовом боксе Skin Depth.  

   Альтернативно, рассчитайте глубину скин-слоя на основании диэлектри-
ческой проницаемости материала и его проводимости и частоты, на которой 
будет выполняться разбиении на ячейки, для чего: 

a. Кликните Calculate Skin Depth. Появляется диалог Calculate Skin 
              Depth.  

b. Введите относительную диэлектрическую проницаемость материала 
              Relative Permeability и проводимость Conductivity. 

c. Задайте частоту Frequency на которой нужно разбивать на ячейки  
              структуру. 

d. Кликните OK. HFSS рассчитает глубину скин-слоя и введет эту вели- 
             чину в текстовый блок Skin Depth. 

5. В текстовом боксе Number of Layers of Elements напечатайте число слоев, 
которые нужно добавить.  HFSS будет добавлять эквивалентное число точек 
сетки на каждый слой. Например, если HFSS добавляет 10 точек для удовлет-
ворения Surface Triangle Length, он добавит 10 точек на каждый слой.  

6. Напечатайте максимальную длину ребра разбиения на ячейки поверхности в 
боксе Surface Triangle Length. 

    Величина по умолчанию устанавливается равной 20% от максимальной 
длины ребер связанных боксов каждой выбранной фаски. 

     HFSS будет улучшать разбиение на треугольники на поверхности (сторо-
ны тетраэдров, касающихся поверхности) пока их длины ребер не станут рав-
ны или больше заданного значения. 

7. Чтобы ограничить число элементов, добавленных во время улучшения раз-
биения поверхностей: 

a. Выберите Restrict the Number of Surface Elements. 
b. Введите значение Maximum Number of Surface Elements. 
c. Кликните OK. 

  Теперь, когда будут выполняться разбиение на тетраэдры, будет использо-
ваться этот критерий уплотнения. 
 

Аппроксимация искривленной поверхности 
   HFSS использует установки на аппроксимацию поверхности, когда гене-
рирует начальное разбиение на ячейки. Если вы модифицируете установки по 
умолчанию HFSS после того, как была сгенерировано начальное разбиение,  
они не будут влиять на разбиение при вариации проекта. Тогда:  
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1. Выберите стороны, для которых вы хотите модифицировать установки 
аппроксимации поверхностей. Альтернативно, выберите объект, у которого вы 
хотите модифицировать установки аппроксимации поверхности, устанавливая 
каждую фаску на объекте. 

2. Кликните HFSS>Mesh Operations>Assign>Surface Approximation. 
Появляется диалог Surface Approximation (рис. 12.33). 

 

Рис. 12.33. Опции аппроксимации поверхности 

3. Напечатайте имя для группы установок в боксе Name или оставьте имя по 
умолчанию. 

4. В разделе Surface Deviation, сделайте следующее: 

• Выберите Ignore если вы не хотите использовать установки отклонения 
поверхности для выбранных фасок. 

• Выберите  Set maximum surface deviation (length), и затем напечатайте 
расстояние между  действительной поверхностями выбранных фасок и фасок, 
разбитых на ячейки в текстовом боксе. 

5. В разделе Normal Deviation, выберите опцию: 

• Ignore если вы не хотите использовать значения нормальные по 
умолчанию, которые используются девиацию нормали для выбранных фасок. 
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• Use defaults если вы хотите использовать установку по девиации 
нормали для выбранных фасок, например, равную 22.5º. 

• Set maximum normal deviation (angle), и затем напечатайте расстояние 
(угол) между нормали и действительной поверхностью и соответствующей 
поверхности разбиения в текстовом боксе. 

6. В разделе Aspect Ratio, выберите одну из следующих опций: 

• Ignore если вы не хотите использовать значение по умолчанию  aspect 
ratio для выбранных поверхностей. 

• Use defaults, если вы хотите использовать установку по умолчанию 
для выбранных фасок, которые равны 10 для искривленных поверхностей и 
200 для плоских поверхностей. 

• Set aspect ratio, и затем напечатайте величину в текстовом боксе. Эта 
величина ограничивает форму треугольников. Чем выше это значение, тем 
тоньше будут треугольники. Величины, близкие к 1, будут давать в результате 
хорошей формы, широкие треугольники. 

7. Кликните OK. Эти установки будут применены к начальной сгенерирован-
ной сетке разбиении на выбранной поверхности. Установки групп перечисля-
ются в дереве проекта под разделом Mesh Operations. 
 

Выбор параметров размеров тетраэдров 
       Вы можете установить разрешение модели (Model Resolution) на один или 
большее количество объектов, чтобы удалить излишние детали из представ-
ления разбиения на ячейки. Это можно использовать для уменьшения слож-
ности разбиения на ячейки выбранных объектов. Для чего: 

1. Выберите объект или объекты, на которых нужно специфицировать длину 
разрешения модели (Model Resolution length).  

2. Кликните на HFSS>Mesh Operations>Assign>Model Resolution. 

3. Появится диалог Model Resolution Mesh Operation (рис. 12.34). 

 

Рис. 12.34. Диалог задания параметра «Разрешение модели» 
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     Альтернативно, вы можете вызвать тот же самый диалог, если: 

a. Кликните правой кнопкой мыши чтобы ввести Mesh Operations в 
дереве проекта, или кликните правой кнопкой мыши в окне 3D Modeler чтобы 
вызвать выплывающее меню. 

b. Кликните на  Assign>Model Resolution в меню Project Tree или 
кликните на Assign Mesh Operation>Model Resolution в выплывающем меню. 

4. Диалог Model Resolution Mesh Operation содержит поля для имени и 
длины разрешения модели (Model Resolution length), и меню для выбора 
единиц. Задайте имя, величину и единицы. 

5. Кликните OK. Этим добавляется Model Resolution в разделе Mesh 
Operations в дереве проекта. Отметим, что установка Model Resolution 
приведет к удалению существующего решения.  

    Когда два соприкасающихся объекта  имеют различные длины разрешения, 
для общих областей будет применяться меньшая длина.  

Возвращение к исходному разбиению на ячейки 
      Начальная сетка – это разбиение, которое генерируется на первом шаге 
решения. Она использует параметры  surface approximation, но не включает  
lambda refinement или другое разбиение на ячейки. Если вы хотите модифи-
цировать установки проекта, и не хотите использовать существующее разби-
ение на ячейки, вернитесь к начальному разбиению на ячейки, для чего в 
меню HFSS укажите на  Analysis Setup, и затем кликните Revert to Initial 
Mesh.  Возвращение к начальному разбиению на ячейки полезно, когда вы 
хотите оценить влияние разных частот решения на сгенерированную сетку во 
время адаптивного анализа. 
 

Применение операции разбиения без решения 
     

    Если вы хотите уплотнить разбиение на какой либо фаске или в объеме, но 
не хотите запускать на решение,  то в  меню  HFSS, укажите на Analysis 
Setup, и затем кликните Apply Mesh Operations.    Когда текущее разбиение 
на ячейки будет сгенерировано, HFSS будет выполнять уплотнение на ячейки, 
используя начальное разбиение. 
    Если выбранную плоскость или объект изменить, например увеличить 
длину, то параметры разбиения не изменяются.  Рекомендуется задавать  
новое разбиение на ячейки, а не модифицировать  существующее разбиение.  
      Применение разбиения на ячейки без выполнения решения позволяет  
экспериментировать с уплотнением разбиения в отдельных областях без 
проигрыша в точности решения.  
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Заключение 
 
 
   Программа HFSS версии 10, разработанная американской фирмой Ansoft, 
освоению которой в учебном процессе посвящена данная книга – не един-
ственная, которая нашла широкое применение в России в научно-исследо-
вательских учреждениях и учебных заведениях.  Поэтому комплекс задач, 
рассмотренных в предлагаемом пособии, можно с таким же успехом решать и 
на других программных комплексах.   
     Часто выбор программного обеспечения диктуется традицией, или скоро-
стью обучения на программном продукте. HFSS, начиная с версий, разрабо-
танных компаниями Hewlett Packard  и Agilent, оказался наиболее популяр-
ным в России среди программ  электромагнитного моделирования трехмер-
ных конструкций, и уже оставил свой след в учебном процессе в ряде ВУЗов 
России. Часто проектировщики остаются верными старым продуктам и не 
имеют времени переучиваться, а компании, использующие их - приобретать 
новые продукты.  
    Структура радиосистем в настоящее время решительно поделена на циф-
ровую часть и радиочасть – радиоприемники и радиопередатчики, причем 
чаще всего радиотехническая часть - это антенны и самые первые каскады, 
следующие за ними. Цифровая обработка наступает и отвоевывает все боль-
шую часть радиосистемы. Больше того, в управлении антенной решетки 
большую роль выполняет цифровая часть. Поэтому можно сказать, что для 
радиоинженера освоение HFSS – только часть пути, и, по крайней мере, нуж-
но знать программу HFSS Designer или ADS.    
    Выбор программного обеспечения фактически сводится к нахождения 
компромисса между скоростью расчета, имеющимися вычислительными 
ресурсами и объемом задачи (размер в единицах длин волны). Все это 
сводится к  решению задачи оптимизации процесса проектирования совре-
менных СВЧ устройств, выработке соотношения между аналитическими и 
численными методами, решению актуальных задач, стоящих как перед 
организаторами научной работы, так и перед исполнителями от научных 
сотрудников до инженеров  (как пример одной из частных задач: какой метод, 
какую программу – SCT, HFSS или FEKO нужно использовать для решения 
такой-то задачи). 
     Процесс освоения современного программного обеспечения на студен-
ческой скамье, доведенный до понимания тонкостей процесса проектиро-
вания, это новый и спасительный шаг обучения и подготовки радиоспе-
циалистов высокой квалификации.  
  Надеемся, что метод анализа задач, использованный в учебнике – пошаговое 
построение и анализ результатов – поможет разработчикам СВЧ устройств 
освоить программу HFSS и широко использовать её в своей работе. 
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